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About this topic collection

This PDF has been created from the WebSphere Message Broker Version 6.1
(November 2008) information center topics. Always refer to the WebSphere
Message Broker online information center to access the most current information.
The information center is periodically updated on the [document update]site and
this PDF and others that you can download from that Web site might not contain
the most current information.

The topic content included in the PDF does not include the "Related Links”
sections provided in the online topics. Links within the topic content itself are
included, but are active only if they link to another topic in the same PDF
collection. Links to topics outside this topic collection are also shown, but these
attempt to link to a PDF that is called after the topic identifier (for example,
ac12340_.pdf) and therefore fail. Use the online information to navigate freely
between topics.

Feedback: do not provide feedback on this PDF. Refer to the online information to
ensure that you have access to the most current information, and use the Feedback
link that appears at the end of each topic to report any errors or suggestions for
improvement. Using the Feedback link provides precise information about the
location of your comment.

The content of these topics is created for viewing online; you might find that the
formatting and presentation of some figures, tables, examples, and so on are not
optimized for the printed page. Text highlighting might also have a different
appearance.
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Developing user-defined extensions

A user-defined extension is a component that you design and implement to extend
the function of WebSphere® Message Broker.

You can create and implement the following types of user-defined extension:
* User-defined nodes

* User-defined parsers

¢ User-defined exits

The user-defined nodes, parsers, and exits that you create can be used in
conjunction with the nodes and parsers that are supplied with the product, and
with nodes and parsers that are supplied by other software vendors.

User-defined extensions overview

A user-defined extension is an optional component that you design and create to
extend the functionality of WebSphere Message Broker. A user-defined extension
can be either a node or a parser.

You can create the following types of user-defined extension:
* Input nodes

* Message processing nodes

* Output nodes

* Parsers

¢ User exits

The user-defined nodes and parsers that you create can be used with the nodes
and parsers supplied with the product, and with nodes and parsers that are
supplied by other vendors. You can configure a user-defined node to use a
user-defined parser.

You can write user-defined exits and parsers only in the C programming language.
You can write user-defined nodes in the C or the Java" programming languages.
You must compile user-defined nodes and parsers that are written in C into a
loadable implementation library (LIL), and user exits that are written in C into a
loadable exit library (LEL): that is, a shared library on Linux® and UNIX® systems,
or a dynamic link library (DLL) on Windows® systems. You must package
user-defined nodes that are written in Java as a JAR file. You must import any
user-defined nodes that you create into the workbench before you can use them.

The samples gallery on the start screen of the workbench has examples of
user-defined nodes and parsers. Look at the following sample for an example of
how a node is created and used.

» |User-defined Extension sample|

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

To achieve platform independence, use the ANSI standard C or Java programming
languages, and avoid platform-specific code in your user-defined extension.

© Copyright IBM Corp. 2000, 2008 3


/help/livehelp/?pluginID=com.ibm.samplegallery&class=com.ibm.samplegallery.SampleGalleryAction&arg=com.ibm.etools.mft.samples.ude.doc/doc/overview.htm

Why use a user-defined extension?

Use a user-defined node or parser when the built-in resources do not provide the
required functions.

Before you start to create your user-defined extension, be clear about what you
want it for. Most tasks can be performed using the functions already provided with
WebSphere Message Broker, so you might need a user-defined extension for your
particular task.

To write user-defined extensions you need to be a skilled programmer, with some
knowledge of WebSphere Message Broker and its architecture, therefore make sure
that you have the skills and knowledge required. You also need the time to test

and debug your user-defined node or parser, and a safe environment in which to
do this.

Also bear in mind that the maintenance and servicing of your own user-defined
extensions is your responsibility. You should ensure that there will be someone
available who can perform future updates or fixes.

A user-defined extension might be appropriate in the following situations:

* When you cannot manipulate the supplied nodes or parsers to perform the
function you require. For example, you might want to connect to another
software component in your message flow outside of WebSphere MQ. If there is
no supplied node for doing this, you must create your own.

* When you can improve performance, ease of use, or reliability by using your
own user-defined extensions in place of the supplied nodes or parsers.

* If the available choices are not appropriate for your requirement. You can create
user-defined extensions to handle internal, customer-specific, or generic
commercial messages formats.

Consider the following design factors when you are planning or writing a
user-defined node or parser. You should be familiar with the concepts covered in
the topics below before designing a user-defined extension.

* |“Errors and exception handling”|

+ [“Storage management in user-defined nodes” on page 7|

+ |“String handling in user-defined nodes” on page 7]

* |“Threading considerations for user-defined extensions” on page §|

+ [“ODBC restrictions for user-defined nodes” on page §|

+ [“User-defined extensions in the runtime environment” on page §|

* |"Node and parser factory behavior” on page 10|

Errors and exception handling

This topic deals with issues relating to errors and exception handling that you
need to consider when developing user-defined extensions for WebSphere Message
Broker in the C programming language. If you are developing user-defined
extensions using the Java programming language, you can use standard Java error
and exception handling methods. If, for example, WebSphere Message Broker
throws an exception internally, a Java exception of class MbException is made
available.

Correct handling of errors and exceptions is important for correct broker operation.
You should be aware of this, and understand how and when your user-defined

extension needs to handle errors and exceptions.
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The message broker generates C++ exceptions to handle error conditions. These
exceptions are caught in the relevant software layers in the broker and handled
accordingly. However, programs written in C cannot catch C++ exceptions, and
any exceptions thrown, by default, bypass any C user-defined extension code and
be caught in a higher layer of the message broker.

Utility functions, by convention, normally use the return value to pass back
requested data; for example, the address or handle of a broker object. The return
value sometimes indicates that a failure has occurred. For example, if the address
or handle of a broker object could not be retrieved, then zero (CCI_NULL_ADDR)
is returned. Additionally, the reason for an error condition is stored in the return
code output parameter, which is, by convention, part of the function prototype of
all utility functions. If the utility function completed successfully and returnCode
was not null, returnCode contains CCI_SUCCESS. Otherwise, it contains one of the
return codes described below. The value of returnCode can always be tested safely
to determine whether a utility function was successful.

If the invocation of a utility function causes the broker to generate an exception,
this is visible to the user-defined extension only if it specified a value for the
returnCode parameter to that utility function. If a null value was specified for
returnCode, and an exception occurs:

* The user-defined extension is not be aware of that exception
* The utility function does not return to the user-defined extension

* Execution control passes to higher layers in the broker stack to process the
exception

This means that a user-defined extension would be unable to perform any of its
own error recovery. If, however, the returnCode parameter is specified, and an
exception occurs, a return code of CCI_EXCEPTION is returned. In this case,
cciGetLastExceptionData or cciGetLastExceptionDataW (the difference being that
cciGetLastExceptionDataW returns a CCI_EXCEPTION_WIDE_ST which can
contain Unicode trace text) can be used to obtain diagnostic information on the
type of exception that occurred. The data is returned in the CCI_EXCEPTION_ST
or CCI_EXCEPTION_WIDE_ST structure.

If there are no resources to be released, you should not set the returnCode
argument in your user-defined extension. Not setting this argument allows
exceptions to bypass your user-defined extensions. These exceptions can then be
handled higher up the WebSphere Message Broker stack, by the broker.

Message inserts can be returned in the CCI_STRING_ST members of the
CCI_EXCEPTION_ST structure. The CCI_STRING_ST allows the user-defined
extension to provide a buffer to receive any required inserts. The broker copies the
data into this buffer and returns the number of bytes output and the actual length
of the data. If the buffer is not large enough, no data is copied and the
"dataLength” member can be used to increase the size of the buffer, if needed.

The user-defined extension can perform its own error recovery, if required, by
setting a non-null value for returnCode. The utility function calls return to the
user-defined extension and pass their status through returnCode. All exceptions
occurring in any utility function must be passed back to the message broker for
additional error recovery to be performed, that is, when CCI_EXCEPTION is
returned in returnCode. You do this by invoking cciRethrowLastException, after the
user-defined extension has completed its own error processing. Calling
cciRethrowLastException causes the C interface to re-throw the last exception so
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that it can be handled by other layers in the message broker. Note that, similar to a
C exit call, cciRethrowLastException does not return in this case.

If an exception occurs and is caught by a user-defined extension, the extension
must not call any utility functions except cciGetLastExceptionData,
cciGetLastExceptionDataW, or cciRethrowLastException. An attempt to call other
utility functions results in unpredictable behavior that can compromise the
integrity of the broker.

If a user-defined extension encounters a serious error, cciThrowException or
cciThrowExceptionW can be used to generate an exception that is processed by the
message broker in the correct manner. The generation of such an exception causes
the supplied information to be written to the system log (syslog or Eventviewer) if
the exception is not handled. The information is also written to Broker trace if trace
is active.

Types of exception and broker behavior: The broker generates a set of exceptions
that can be passed to a user-defined extension. These exceptions can also be
generated by a user-defined extension when an error condition is encountered. The
exception classes are:

Fatal Fatal exceptions are generated when a condition occurs that prevents the
broker process from continuing execution safely, or where it is broker
policy to terminate the process. Examples of fatal exceptions are a failure
to acquire a critical system resource, or an internally-caught severe
software error. The broker process terminates following the throwing of a
fatal exception.

Recoverable
These are generated for errors which, although not terminal in nature,
mean that the processing of the current message flow has to be ended.
Examples of recoverable exceptions are invalid data in the content of a
message, or a failure to write a message to an output node. When a
recoverable exception is thrown, the processing of the current message is
aborted on that thread, but the thread recommences execution at its input
node.

Configuration
Configuration exceptions are generated when a configuration request fails.
This can be because of an error in the format of the configuration request,
or an error in the data. When a configuration exception is thrown, the
request is rejected and an error response message is returned.

Parser These are generated by message parsers for errors which prevent the
parsing of the message content or creating a bit stream. A parser exception
is treated as a recoverable exception by the broker.

Conversion
These are generated by the broker character conversion functions if invalid
data is found when trying to convert to another data type. A conversion
exception is treated as a recoverable exception by the broker.

User These are generated when a Throw node throws a user-defined exception.

Database
These are generated when a database management system reports an error
during broker operation. A database exception is treated as a recoverable
exception by the broker.
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Storage management in user-defined nodes
Consider issues that relate to storage management when you develop user-defined
extensions in the C programming language.

If you are developing user-defined extensions using the Java programming
language, you can use standard Java string handling methods.

All memory that is allocated by a user-defined extension must be released by the
user-defined extension. The construction of a node at run time causes the
cniCreateNodeContext function to be invoked, which allows the user-defined
extension to allocate node instance specific data areas to store a context. The
address of the context is returned to the broker, and is passed back from the broker
when an internal method causes a user-defined extension function to be invoked;
thus, the C user-defined extension can locate and use the correct context for the
function processing.

The broker passes addresses of C++ objects to the user-defined extension, which
are used as handles to be passed back on subsequent function calls. Your C
user-defined extension must not manipulate or use these pointers in any way, for
example, by trying to release storage using the free function. Such actions cause
unpredictable behavior in the broker.

The cniCreateNodeContext implementation function is invoked whenever the
underlying node object has been constructed internally. It is called when a broker
is defined with a message flow that uses a user-defined node. This activity is not
necessarily the same as creating (or reusing) a thread to execute a message flow
instance that contains the node. The cniCreateNodeContext function is called only
once, during the configuration of the message flow, regardless of how many
threads are executing the message flow.

Similar considerations apply to user-defined parsers, and the corresponding
implementation function cpiCreateContext.

String handling in user-defined nodes
Consider issues that relate to string handling when you develop user-defined
extensions in the C programming language.

If you are developing user-defined extensions using the Java programming
language, you can use standard Java string handling methods.

To enable a broker to handle messages in all languages at the same time, text
processing within the broker is done in UCS-2 Unicode. UCS-2 Unicode character
strings are also used across the Java and C language user-defined extension APIs
to pass and return character data. Attributes are received in XML configuration
messages as character strings, regardless of data type. If the true data type of an
attribute is not a string, the cniSetAttribute function must perform the necessary
verification and conversion before storing the attribute value. Similarly, when an
attribute value is retrieved using cniGetAttribute2, conversion must be performed
to a UCS-2 Unicode character string before returning the result.

CciChar defines a 16-bit character with UCS-2 Unicode representation. A CciChar*
is a string of such characters terminated with a CciChar of 0. By default, a CciChar
is represented by type wchar_t. However, some platforms do not have a convenient
way of representing UCS-2 constants in source code, typically because of 4-byte
wchar_t or EBCDIC representation. For example, a source-code constant such as
L"ABC" expands to 12 bytes on Solaris.
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For this reason, WebSphere Message Broker provides the utility functions
cciMbsToUcs and cciUcsToMbs. Use these functions, where appropriate, to ensure
portability of your user-defined nodes.

Threading considerations for user-defined extensions

Message processing nodes and parsers must work in a multi-instance,
multithreaded environment. Many node objects or parser objects are available, each
with several syntax elements, and many threads can be executing methods on
these objects.

An instance of a message flow processing node is shared and used by all the
threads that service the message flow in which the node is defined. Parsers are
invoked on the same thread as the nodes, therefore, if the flow is using multiple
threads then the parsers are as well.

A user-defined extension must use this model. If a user-defined node requires
global data or resources, then you must protect the global data or resources by
using semaphores to serialize access across threads. However, such serialization
can result in performance bottlenecks. Avoid using global data and resources to
create a more scalable solution.

The functions implemented by user-defined extensions must be reentrant, and any
functions that they invoke must also be reentrant. All user-defined extension utility
functions are fully reentrant.

Although a user-defined extension can create additional threads if required, all C
utility functions and Java methods must be invoked on the same thread that called
the cniEvaluate function in C or the evaluate method in Java, as appropriate for
the language in which the node is written. If the same thread is not used, your
code might compromise the integrity of the broker and cause unpredictable
behavior. Any additional threads must not call the user-defined extension API. The
API must only be used from the main thread that is invoked by the Broker.

For information about the cniEvaluate function see [“cniEvaluate” on page 157

ODBC restrictions for user-defined nodes
The ODBC environment cannot be accessed using the Java or C language
user-defined extension APIL.

Database access must be performed using the supplied processing nodes, or by
using the following implementation functions supplied for that purpose:

+ [“cniSqlCreateStatement” on page 188

+ |“cniSqlExecute” on page 191]

* |“cniSqlSelect” on page 193

+ [“cniSqlDeleteStatement” on page 190|

Java Database Connectivity

Types 2 and 4 JDBC drivers are supported, but are not provided with the broker.

User-defined extensions in the runtime environment

Before you design and implement user-defined extensions, familiarize yourself
with the core components, and ensure that you understand the basic WebSphere
Message Broker runtime architecture.
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Ensure that you are familiar with the following runtime components and concepts:

* [Runtime environment|

* [Broker domains|

* |Configuration Manager|

e [Brokers|

+ [Execution groups|

* [“User-defined extensions execution model”|

Also make sure you understand the following concepts:

+ [Message flows overview|

When you have gained an understanding of the runtime environment, read the
following topics to help you understand how your user-defined extension interacts
with the runtime components.

* |“C user-defined input node life cycle” on page 13|

+ [“Java user-defined input node life cycle” on page 14

+ |“C user-defined message processing nodes life cycle” on page 18|

+ [“Java user-defined message processing nodes life cycle” on page 20|

+ [“User-defined output node life cycle” on page 25|

[“User-defined parser life cycle” on page 25|

User-defined extensions execution model:

The execution model is the system used to start message flows through a series of
nodes.

When an execution group is initialized, the appropriate loadable implementation
library (LIL) files and Plug-in Archive (PAR) files are made available to the
runtime environment. The execution group runtime process starts, and creates a
dedicated configuration thread. You are responsible for ensuring that a
user-defined node is thread-safe. If a node updates a variable across multiple
threads then appropriate locking must be in place. Do not compromise this
threading model in your implementation of user-defined nodes. Consider the
following points:

* An input message sent to a message flow is processed only by the thread that
received it.

* A single instance of a user-defined extension might be invoked on several
threads concurrently.

¢ The message flow execution environment is conceptually similar to procedural
programming. Nodes that you insert into a message flow are similar to
subroutines called using a function call interface. However, rather than a
call-return interface, in which parameters are passed in the form of input
message data, the execution model is referred to as a propagation-and-return
model.

As an example, consider a message flow in which you use both user-defined nodes
and parsers. You use a user-defined node to process messages, and a user-defined
parser to parse messages; both the node and parser contain implementation
functions. The broker calls the implementation functions, or callback functions,
when certain events occur:

* When an input message is received by the message flow and is propagated to
the user-defined node:
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— For C nodes, the broker calls the cniEvaluate function for the user-defined
node. See [“cniEvaluate” on page 157

— For Java nodes, the broker calls the evaluate method that is implemented by
the user-defined node.

* If the user-defined node wants to query the message to decide what to do with
it, the node calls a C utility function or a Java method, as appropriate for the
language in which the node is written.

The broker invokes the user-defined parser on one of its implementation functions,
for example cpiParseFirstChild. This function instructs the parser to build the parse
tree. The parser builds the tree by invoking utility functions that create elements in
the parse tree, for example cpiCreateElement. The parser can be called many times
by the broker.

Node and parser factory behavior
The node factory and the parser factory assume roles in declaring a node to the
broker or defining a parser.

Each loadable implementation library (LIL) has one node factory, or one parser
factory, or has both. A node factory can identify many nodes, and a parser factory
can identify many parsers.

When the broker loads the LIL, it calls the following functions:
* bipGetMessageflowNodeFactory

After the operating system has loaded and initialized the LIL, the broker calls
initialization function bipGetMessageflowNodeFactory. The
bipGetMessageflowNodeFactory function calls the utility function
cniCreateNodeFactory, which passes back a factory name (or group name) for all
the nodes that your LIL supports.

* bipgetparserfactory

After the operating system has loaded and initialized the LIL, the broker calls
initialization function bipgetparserfactory. The bipgetparserfactory function
defines the name of the factory that the user-defined parser supports, and the
classes of objects, or shared object, that the factory supports. The initialization
function bipgetparserfactory calls the utility function cpiCreateParserFactory,
which passes back a factory name (or group name) for all the parsers that your
LIL supports.

Before the node factory is returned, the broker calls the following functions:
1. cniCreateNodeFactory

This function creates a single instance of the node factory in the broker.
2. cndDefineNodeClass

This function defines the name of a node class that a node factory supports,
and identifies the nodes that the node factory can create.

Before the parser factory is returned, the broker calls the following functions:
1. cpiCreateParserFactory

This function creates a single instance of the named parser factory in the
message broker.

2. cpiDefineParserClass

This function defines the name of a parser class that a parser factory supports,
and identifies the parsers that the factory can create.
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See the following topics for information on these functions:

* |“cniCreateNodeFactory” on page 141]

* [“cpiCreateParserFactory” on page 207|

* [“cniDefineNodeClass” on page 142|

* |“cpiDefineParserClass” on page 209

Why use a user exit?

Use a user exit when you want to intercept the progress of messages through
message flows without needing to redesign the message flow.

User exits provide a mechanism to apply actions (such as monitoring, message
tracking, and auditing) operationally to deployed message flows at run time.

You can use user exits to invoke, via callbacks, your custom C code, which is
provided in a loadable exit library (LEL), at key points in message transactions in
deployed message flows. These user exits can use utility functions from the
user-defined extensions” APIs to extract details of the broker, execution group,
message flow, node, and message assembly. In addition, the user exits can use
utility functions from the user-defined extensions’” APIs to modify parts of the
message assembly.

To write user exits, you must be a skilled programmer with an understanding of
WebSphere Message Broker and its architecture. Testing and debugging user exits
can be time-consuming, and must be done in a safe environment. You must also
maintain and service your own user exit.

Consider the following design factors when you plan and write a user exit:
* The impact on performance

User exit callbacks are run in-line with the current message transaction; that is,
progress of the transaction is blocked until the return from the callback is
received. Updating the message in a user exit callback can affect performance,
particularly if the input message would not otherwise be changed in the
message flow.

* Message parse timing
On demand parsing, referred to as partial parsing, is used to parse a message bit
stream only as far as is necessary to satisfy the current reference in the message
assembly. A user exit can navigate the message at each of its callback points,
which can mean that the parse timing of the message flow is changed when you
enable the user exit.

* Error handling

To ensure that the error handling that is provided by the designer of a message
flow that is being intercepted by a user exit continues to operate as designed,
you must programme the user exit in the following way:

— Any internal errors must be handled within the user exit, and the normal
return from the callback must enable the message flow transaction to
complete as normal.

— Any exception condition that is encountered when the user exit calls utility
functions in the user-defined extensions” APIs must be returned to the flow
for normal error processing. This behavior is achieved by calling
cciRethrowLastException() to cut short the callback processing.
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Which type of user-defined extension to use

The types of user-defined extension that you can write include user-defined nodes,
user-defined parsers, and user-defined exits.

The following topics describe the different types of user-defined extension in more
details:

* [“User-defined node”)
* [“User-defined parsers” on page 25|
» |User-defined exits|

User-defined node
User-defined nodes are the main mechanism for extending the functionality of
WebSphere Message Broker.

The most common uses for a user-defined node are:

* Calling an external system for which WebSphere Message Broker does not
provide nodes

* Calling already defined program libraries that perform a transformation or
calculation that is required in the design of a message flow

Before you consider constructing a user-defined node, make sure that no built-in
node is available to perform the required actions. For example, you might have
considered creating a user-defined node to perform the following tasks, but you
can use a JavaCompute node instead:

* Allowing programming languages other than ESQL to be used for coding
message flow functions

* Performance advantages in performing some actions in compiled code

* Complex functions that are not available in ESQL, such as the large number of
classes provided in JS2E

The following topics describe the different types of user-defined node in more
detail:

* [“User-defined input nodes”]

+ [“User-defined message processing nodes” on page 17

+ [“User-defined output nodes” on page 24|

User-defined input nodes:

A user-defined input node is an extension to the broker that provides a new input
node in addition to those supplied with the product.

You create user-defined input nodes using either the C or Java programming
language, to provide message input to a message flow from a message queue
when you want your broker to accept messages from a transport protocol other
than WebSphere MQ.

You can use a user-defined input node to receive data from an external data source
and to allow that data to be processed in a broker. In this way, you can
complement the primitive input node types provided by WebSphere Message
Broker.
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You cannot use a user-defined input node to provide the in terminal to a message
subflow. If you want to provide the in terminal to a subflow, you must use the
supplied Input node.

Before writing a user-defined node, make sure that you are familiar with the
concepts that are introduced in [“Why use a user-defined extension?” on page 4|
and [“User-defined extensions in the runtime environment” on page 8

C user-defined input node life cycle:

A user-defined input node that is written in the C programming language
progresses through several stages during its lifetime.

The stages of the life cycle are:
* Registration

¢ Instantiation

* Processing

¢ Destruction

Registration: During the registration phase, the broker discovers which resources
are available and which LILs can provide them. In this instance, the resources
available are nodes. The phase starts when an execution group starts. The LILs are
loaded on the startup of an execution group, and the broker queries them to find
out what resources they can provide.

A CciFactory structure is created during the registration phase, when the
user-defined node calls cniCreateNodeFactory.

The following APIs are called by the broker during this stage:
* biGetMessageflowNodeFactory
* bipGetParserFactory

The following API is called by the user-defined node during this stage:
* cniCreateNodeFactory

Instantiation: An instance of a user-defined input node is created when the
mgsistart command starts or restarts the execution group process, or when a
message flow that is associated with the node is deployed.

The following APIs are called during this phase:

* cniCreateNodeContext. This API allocates memory for the instantiation of the
user-defined node to hold the values for configured attributes. This API is called
once for each message flow that is using the user-defined Input node.

* cniCreateInputTerminal. This API is invoked within the cniCreateNodeContext
API, and is used to tell the broker what input terminals, if any, your
user-defined input node has.

Your user-defined input node only has input terminals if it is also acting as a
message processing node. If this is the case, it is typically better to use a
separate user-defined message processing node to perform the message
processing, rather than combine both operations in one, more complex, node.

* cniCreateOutputTerminal. This API is invoked within the cniCreateNodeContext
API, and is used to tell the broker what output terminals your user-defined
input node has.
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* cniSetAttribute. This API is called by the broker to establish the values for the
configured attributes of the user-defined node.

During this phase, a CciTerminal structure is created when cniCreateTerminal is
called.

Processing: The processing phase begins when the cniRun function is called by the
broker. The broker uses the cniRun function to determine how to process a
message, including determining the domain in which a message is defined, and
invoking the relevant parser for that domain.

A thread is demanded from the message flow’s thread pool, and is started in the
run method of the input node. The thread connects to the broker’s queue manager,
and retains this connection for its lifetime. When a thread has been allocated, the
node enters a message processing loop while it waits to receive a message. It
remains in the loop until a message is received. If the message flow is configured
to use multiple threads, thread dispatching is activated.

The message data can now be propagated downstream.

The following APlIs are called by the broker during this phase:

 cniRun. This function is called by the broker to determine how to process the
input message.

¢ cniSetInputBuffer. This function provides an input buffer, or tells the broker
where the input buffer is, and associates it with a message object.

Destruction: A user-defined input node is destroyed when the message flow is
redeployed, or when the mqgsistop command is used to stop the execution group
process. You can destroy the node by implementing the cniDeleteNodeContext
function.

When a user-defined input node is destroyed in one of these ways, you should free
any memory used by the node, and release any held resources, such as sockets.

The following APlIs are called by the broker during this phase:

* cniDeleteNodeContext. This function is called by the broker to destroy the
instance of the input node.

Java user-defined input node life cycle:

A user-defined input node that is written in the Java programming language
progresses through several stages during its lifetime.

The stages of the life cycle are:
* Registration

¢ Instantiation

* Processing

* Destruction

Registration: During the registration phase a user-defined input node written in
Java makes itself known to the broker. The node is registered with the broker
through the static getNodeName method. Whenever a broker starts, it loads all the
relevant Java classes. The static method getNodeName is called at this point, and
the broker registers the input node with the node name specified in the
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getNodeName method. If you do not specify a node name, the broker
automatically creates a name for the node based on the package in which it is
contained.

Using a static method here means that the method can be called by the broker
before the node itself is instantiated.

Instantiation: A Java user-defined input node is instantiated when a broker
deploys a message flow containing the user-defined input node. When the node is
instantiated, the broker calls the constructor of the input node’s class.

When a node is instantiated, any terminals that you have specified are created. A
message processing node can have any number of input and output terminals
associated with it. You must include the createInputTerminal and
createOutputTerminal methods in your node constructor to declare these terminals.

To handle exceptions that are passed back to your input node, use
createOutputTerminal to create a catch terminal for your input node. When the
input node catches an error, the catch terminal processes it in the same way as an
MQInput node would. You can allow most exceptions, such as exceptions that are
caused by deployment problems, to pass back to the broker, and the broker will
warn the user of any possible configuration errors.

As a minimum, your constructor class needs only to create these output terminals
on your input node. However, if you need to initialize attribute values, such as
defining the parser that will initially parse a message passed from the input node,
you should also include that code at this point in your input node.

Processing: Message processing for an input node begins when the broker calls the
run method. The run method creates the input message, and should contain the
processing function for the input node.

The run method is defined in MbInputNodelnterface, which is the interface used
in a user-defined node that defines it as an input node. You must include a run
method in your node. If you do not include a run method in your user-defined
input node, the node source code will not compile.

When a message flow containing a user-defined input node is deployed
successfully, the broker calls the node’s run implementation method, and continues
to call this method while it waits for messages to process.

When a message flow starts, a single thread is dispatched by the broker, and is
called into the input node’s run method. If the dispatchThread() method is called,
further threads can also be created in the same run method. These new threads
immediately call into the input node’s run method, and can be treated the same as
the original thread. The number of new threads that can be created is defined by
the additionallnstances property. Make sure that threads are dispatched after a
message has been created, and before it is propagated, to ensure that only one
thread at a time is waiting for a new message.

The user-defined input node can choose a different threading model and is
responsible for implementing the chosen model. If the input node supports the
additionallnstances property, and dispatchThread() is called, the code must be fully
re-entrant, and any functions that are invoked by the node should also be
re-entrant. If the input node forces single threading, that is, it does not call
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dispatchThread(), the node documentation must state that setting the
additionallnstances property has no effect on the input node.

For more information on the threading model for user-defined input nodes, see
[‘Threading considerations for user-defined extensions” on page 8|

Destruction: A Java user-defined input node is destroyed when the node is deleted
or the broker is shut down. You do not need to include anything in your code that
specifies the node should be physically deleted, because this can be handled by the
garbage collector.

However, if you want notification that a node is about to be deleted, you can use
the onDelete method. You might want to do this if there are resources that you
want to delete, other than those that will be garbage collected. For example, if you
have opened a socket, this will not be properly closed when the node is
automatically deleted. You can include this instruction in your onDelete method to
ensure that the socket is closed properly.

Planning user-defined input nodes:

Before you develop a user-defined input node, plan and design its content and
purpose.

Analysis: Before you develop a user-defined input node, ask yourself the following
questions:

* Do you need to create a custom input node?

You must include at least one input node in a message flow. Which one you
choose depends on the source of the input messages:

— If the messages arrive at the broker on a WebSphere MQ queue, use the
MQInput or MQOptimizedFlow node.

— If SOAP messages are received over HTTP, use the SOAPInput node.
— If other messages are received over HTTP, use the HTTPInput node.

— If the messages are received from a multicast application, use the
Real-timeInput node.

— If the messages are received from a JMS source, use either the Real-timelnput
node or the JMSInput node.

— If the messages are sent by telemetry (SCADA) devices, use the SCADAInput
node.

— If the messages are received from an EIS, use the PeopleSoftInput, SAPInput,
or Siebellnput node.

— If the messages are retrieved from files, use the FileInput node.
— If the message source is any other, you must use a user-defined input node.

For information about using more than one input node in a message flow, see
[Using more than one input node}

* To successfully input the data concerned, does the input node have to interface
with vendor software? If so, does the API that enables access to this software
break your threading model?

* Do you need a new user-defined parser to interpret the body (payload) of the
message generated by this input node, or can it be parsed by a standard built-in
parser?
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* Do you need the user-defined input node to operate the message flow instance
in which it resides under transactional control as a globally-coordinated
transaction?

* Do you need the new user-defined input node to offer configuration options?

* Do you need messages propagated by this input node to be processed by the
following primitives?

— All primitive output nodes
— ResetContentDescriptor nodes

Design considerations: Before developing and implementing your input node,
decide on the following factors:

* Which message parser will initially parse the input message.

* Whether to override the default message parser attribute values for this input
node.

* Which threading model is appropriate for the input node.
* What kind of message processing and transaction support will the node support.

* Which configuration attributes required by the input node should be
externalized for alteration by the message flow designer.

* What optional node APIs will the user-defined node provide.
* How you will handle general development issues:

— [“Threading considerations for user-defined extensions” on page §

- [“Storage management in user-defined nodes” on page 7|

[“String handling in user-defined nodes” on page 7|

[“Errors and exception handling” on page 4|

Expected message formats for primitive nodes that expect specific header
folders.

When you design nodes to be used as extensions to WebSphere Event Broker, the

following restrictions apply:

* User-defined input nodes can support only XML, BLOB, and the WebSphere MQ
parsers, because the MRM parser is not shipped with WebSphere Event Broker
and user-defined parsers are not supported.

* User-defined nodes must not allow users to evaluate user ESQL code, because
the use of ESQL in WebSphere Event Broker is not supported. For example,
nodes that expose the input to MbSQLStatement as a node attribute are
effectively emulating a Compute node.

User-defined message processing nodes:

A user-defined message processing node is a node that you can create to
complement the supplied built-in node types.

You might consider the use of a user-defined message processing node in the
following situations:

* Your messages need transformations that the built-in nodes do not provide. For
example, you might need a currency converter node.

* You want to write messages into a flat file on the local system for later
processing by another application or utility program.

Combine your user-defined nodes with the built-in nodes to create message flows
that meet your exact business requirements.
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C user-defined message processing nodes life cycle: This topic guides you through the
various stages in the life of a user-defined message processing node for the C
programming language. It covers the objects that are created and destroyed, and
the implementation functions and classes that are called in the following stages:

* Registration
* Instantiation
* Processing
* Destruction

The information in this topic applies to both output nodes and message processing
nodes. Both of these node types can be considered together, because although a
message processing node is typically used to process a message, and an output
node is used to provide an output in the form of a bit stream, you can use either
type of node to perform either of these functions.

Registration: A user-defined message processing node is registered with the broker
when the LIL that contains the node has been loaded and initialized by the
operating system.

The broker calls bipGetMessageflowNodeFactory to establish the function of the
LIL, and how the LIL should be called.

The bipGetMessageflowNodeFactory function in turn calls the
cniCreateNodeFactory function, which returns a factory or group name for all of
the nodes that are supported by your LIL.

The LIL should then call the utility function cniDefineNodeClass to pass both the
name of each node and a virtual function table of the function pointers of the
implementation functions.

Instantiation: During the instantiation phase, an instance of a user-defined message
processing node is created. The phase starts when the broker creates a message
flow and calls the cniCreateNodeContext function for each instantiation of the
user-defined node in that message flow. The cniCreateNodeContext function is that
which is specified in the iFpCreateNodeContext field of the CNI_VFT struct passed
to cniDefineNodeClass for that node type. This function should allocate the
resources required for that node, including memory such that the instantiation of
the user-defined node can hold the values for the configured attributes.

The broker will create a node instance and call cniCreateNodeContext on the
following occasions:

* Message flow is created:

— Broker is being started (user has run mgsistart). Any message flows
previously deployed are recreated when the broker starts.

— Execution group is being reloaded (user has run mgsireload). Any message
flows that have been deployed previously are recreated when the execution
group reloads.

— A severe error has occurred within the execution group which results in the
execution group being restarted.

* Message flow is redeployed. When a message flow is changed and redeployed,
the broker processes redeploy by deleting all nodes in the flow and then
recreating them with the new configuration.

18  User-defined Extensions



Note: A message flow is not created when starting an execution group. Stopping
an execution group simply stops all flows and does not delete the flow or
bring the process down. Restarting an execution group, starts the message
flows but does not recreate the message flows.

Within cniCreateContext, the user-defined extension calls the two functions
cniCreatelnputTerminal and cniCreateOutputTerminal in order to establish what
input and output terminals the message processing node has.

Processing: During the processing phase of the life cycle of a user-defined message
processing node, the message is transformed in some way, when some processing
operation takes place on the input message.

When the broker retrieves a message from the queue and that message arrives at
the input terminal of your user-defined node, the broker calls the implementation
function cniEvaluate. This function is used to decide what to do with the message.

You can use a range of node utility functions in your user-defined message
processing node to perform a range of message processing functions, such as
accessing the message data, accessing ESQL, transforming a message object, and
propagating a message. You should include the node utility functions you are
going to use to process the message within the cniEvaluate function.

This interface does not automatically generate a properties subtree for a message. It
is not a requirement for a message to have a properties subtree, although you
might find it useful to create one to provide a consistent message tree structure
regardless of input node. If you want a properties subtree to be created in a
message, and you are also using a user-defined input node, you must do this
yourself

Destruction: When a user-defined message processing node has processed a
message, you should ensure that it is destroyed, to release any system resources
that it used, and to release any data areas specific to the node instance, such as
context, that were acquired when the message was constructed or processed.

An instance of a user-defined message processing node is destroyed when the
broker calls the cniDeleteNodeContext function.

The broker calls cniDeleteNodeContext when the instance of the node is deleted.
The following events can cause a node to be deleted:

* Controlled termination of the execution group process:
— Broker is being stopped (user has run mgsistop)
— Execution group is being reloaded (user has run mgsireload)

— A severe error has occurred within the execution group, which results in the
execution group being restarted.

Note: This does NOT include stopping an execution group. Stopping an
execution group simply stops all flows, and does not delete the flow or
bring the process down.

* Message flow is deleted. For example, a message flow is deleted from the
tooling’s Broker Administration perspective.

* Message flow is redeployed. When a message flow is changed and redeployed,
the broker processes redeploy by deleting all nodes in the flow and then
recreating them with the new configuration.
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Java user-defined message processing nodes life cycle: This topic guides you through
the various stages in the life of a user-defined message processing node for the
Java programming language. It covers the objects that are created and destroyed,
and the methods and classes that are called in the following stages:

* Registration
* Instantiation
* Processing
* Destruction

The information in this topic applies to both output nodes and message processing
nodes. Both of these node types can be considered together, because although a
message processing node is typically used to process a message, and an output
node is used to provide an output, in the form of a bit stream, from a message,
you can use either type of node to perform either of these functions.

Registration: The registration phase occurs when a user-defined message
processing node that is written in Java makes itself known to the broker, or
registers with the broker.

Whenever a broker starts, it loads all relevant LILs and Java classes. To ensure that
a message processing node is registered with the broker, you must provide the
broker with a class that implements the MbNodelnterface interface and is
contained in the broker’s classpath.

Instantiation: A Java user-defined message processing node is instantiated when a
broker deploys a message flow that contains the user-defined message processing
node. When the node is instantiated, the constructor of the message processing
node’s class is called.

When a node is instantiated, any terminals that you have specified are created. A
message processing node can have any number of input and output terminals
associated with it. You must include the createInputTerminal and
createOutputTerminal methods in your node constructor in order to declare these
terminals.

Output terminals include out, failure, and catch terminals. Use the
createOutputTerminal class within the node class constructor in order to create as
many output terminals as you require.

As a minimum, you need only to create these output terminals by using your
constructor class. However, if you need to initialize attribute values, you should
also include that code at this point in your message processing node.

If you want to handle exceptions that are passed back to your message processing
node, it is good practice to do this by creating a failure terminal for your
user-defined message processing node, by using the createOutputTerminal method.
It is sensible to use the failure terminal for this process because that is to where
WebSphere Message Broker errors are propagated.

Make sure that any exceptions that are caught by the message processing node are
dealt with properly. If you do not include a failure terminal, the message
processing node will not attempt to handle the exception. If your message flow
does not contain any method of exception handling, any exceptions thrown are
passed back to the input node, where the input node deals with the exceptions.
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If you do catch exceptions, make sure that you re-throw any exceptions that the
message processing node cannot deal with. This will cause the exception to be
passed back to the input node for handling, for example, when you want to
rollback a transaction.

Processing: During the processing phase of the life cycle of a user-defined message
processing node, the message processing node takes the logical hierarchy of the
message and processes it in some way.

Destruction: A Java user-defined message processing node is destroyed when the
node is deleted or the broker is shut down. You do not need to include anything in
your code to specify that the node should be physically deleted because this can be
handled by the garbage collector.

However, if you want notification that a node is about to be deleted, you can use
the onDelete method. You might want to do this if there are resources that you
want to delete, other than those that will be garbage collected. For example, if you
have opened a socket, this will not be properly closed when the node is
automatically deleted. You can include this instruction in your onDelete method to
ensure that the socket is closed properly.

Planning user-defined message processing nodes:

Plan how to write your message processing node or output node, and how to
navigate the message within the node.

Design factors: Before developing and implementing your message processing
node, consider the following points:

* Which parser will parse messages.

* Whether to override the default message parser attribute values for this message
processing node.

* What is the appropriate threading model for the message processing node.

* How to implement the end of message processing and transaction support that
the node must support.

* What configuration properties required by the message processing node should
be externalized for alteration by the message flow designer.

¢ What optional node APIs will the user-defined node provide.
* General development issues:

- [“Threading considerations for user-defined extensions” on page §

- [“Storage management in user-defined nodes” on page 7|

- [“String handling in user-defined nodes” on page 7|

— |“Errors and exception handling” on page 4|

Expected message formats for built-in nodes that expect specific header
folders (see [Element definitions for message parsers)

Syntax element navigation: The broker provides functions that your node can call to
traverse the tree representation of the message, as well as functions and methods
that support navigation from the current element to other elements:

* Parent
e First child
e Last child

* Previous (or left) sibling

Developing user-defined extensions 21



* Next (or right) sibling

These relationships are shown in the following figure.

parent
previous 1 Syntax | next
sibling element sibling
first  last
child  child
Other functions and methods support the manipulation of the elements
themselves, with functions and methods to create elements, to set or query their
values, to insert new elements into the tree, and to remove elements from the tree.
See [“C node utility functions” on page 123 and |“C parser utility functions” on|
|Eage 196,| or the Javadoc information for more details.
The next figure describes a simple syntax element tree that shows a full range of
interconnections between the elements.
C . D . E
] ]

The element A is the root element of the tree. It has no parent because it is the
root. It has a first child of element B. Because A has no other children, element B is
also the last child of A.

Element B has three children: elements C, D, and E. Element C is the first child of
B; element E is the last child of B.
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Element C has two siblings: elements D and E. The next sibling of element C is
element D. The next sibling of element D is element E. The previous sibling of
element E is element D. The previous sibling of element D is element C.

The following figure shows the first generation of syntax elements of a typical
WebSphere MQ message received by a broker. (Not all messages have an MQRFH2
header.)

Root

Properties MQMD MQRFH2 XML

These elements at the first generation are often referred to as folders, in which
syntax elements that represent message headers and message content data are

stored. In this example, the first child of root is the Properties folder. The next

sibling of Properties is the folder for the MQMD header. The next sibling is the
folder for the MQRFH2 header. The last folder represents the message content,
which (in this example) is an XML message.

The previous figure includes an MQMD and an MQRFH2 header. All messages
that are received by a processing node that handles WebSphere MQ include an
MQMD header; a number of other headers can also be included.

Navigating an XML message: Consider the following XML message:

<Business>
<Product type='messaging'></Product>
<Company>
<Title>IBM</Title>
<Location>Hursley</Location>
<Department>WebSphere MQ</Department>
</Company>
</Business>

In this example, the elements are of the following types:

Name element
Business, Product, Company, Title, Location, Department

Value element
IBM®, Hursley, WebSphere MQ

Name-value element
type="messaging’

Use supplied node utility functions and methods (or the similar parser utility
functions) to navigate through a message. Using the XML message shown, you
must call cniRootElement first, with the message received by the node as input to
this function. In Java, you must call getRootElement on the incoming MbMessage
object. This call returns an MbElement that represents the root of the element. Do
not modify this root element in the user-defined node.
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The figure of the first generation of the syntax elements of a typical message that is
received by the broker, shows that the last child of the root element is the folder
containing the XML parse tree. Navigate to this folder by calling cniLastChild
(with the output of the previous call as input to this function) in a C node, or by
calling the method getLastChild on the root element, in a Java node.

Only one element (<Business>) is at the top level of the message, therefore call
cniFirstChild (in C) or getFirstChild (in Java) to move to this point in the tree. Use
cniElementType or getType to get its type (which is name), followed by
cniElementName or getName to return the name itself (Business).

The element <Business> has two children, <Product> and <Company>. Use
cniFirstChild or getFirstChild followed by cniNextSibling or getNextSibling to
navigate to each child in turn.

The element <Product> has an attribute (type="messaging'), which is a child
element. Use cniFirstChild or getFirstChild to navigate to this element, and
cniElementType or getType to return its type (which is name-value). Use
cniElementName or getName to get the name. To get the value, call
cniElementValueType to return the type, followed by the appropriate function in
the cniElementValue group: in this example it is cniElementCharacterValue. In Java
use the method getValue, which returns a Java object representing the element
value.

The element <Company> has three children, each one having a child that is a value
element (IBM, Hursley, and WebSphere MQ). Use the functions already described to
navigate to them and access their values.

Other functions are available to copy the element tree (or part of it). The copy can
then be modified by adding or removing elements, and changing their names and
values, to create an output message. See [“C node utility functions” on page 123|
and [“C parser utility functions” on page 196 or the Java user-defined node API,
for more information.

User-defined output nodes:

A user-defined output node is an extension to the broker that provides a new
message flow output node in addition to those supplied with the product.

If you want your message flow to send messages using a protocol that is not
supported by WebSphere Message Broker you can create your own output node to
do this.

WebSphere Message Broker provides the following output nodes:

* MQOutput - delivers an output message from a message flow to a WebSphere
MQ queue

* MQReply - sends a response to the originator of the input message.

* SCADAOutput - sends a message to a client connecting using the MQIsdp
protocol

* DPublication - filters output messages from a message flow and transmit them to
subscribers who have registered an interest in a particular set of topics.

* JMSOutput - sends a message to a JMS destination
* EmailOutput - sends an e-mail message to one or more recipients
* FileOutput - writes a message to a file
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If the target application expects to receive message in any other way, you must use
a user-defined output node.

User-defined output nodes can be considered together with user-defined message
processing nodes. Conceptually, these two kinds of user-defined nodes are the
same. Although a message processing node is typically used to process a message,
and an output node is used to provide an output, in the form of a bit stream, from
a message, you construct output nodes and message processing nodes in a similar
way, and you can use either type of node to perform either function.

For more information on user-defined output nodes, read the topics that cover
user-defined message processing nodes.

User-defined output node life cycle: For information on the life cycle of a
user-defined output node, you should read the corresponding topics for
user-defined message processing nodes.

The information in these topics applies to both output nodes and message
processing nodes. Both of these node types can be considered together, because
although a message processing node is typically used to process a message, and an
output node is used to provide an output in the form of a bit stream, you can use
either type of node to perform either of these functions.

Planning user-defined output nodes:

A user-defined output node generates an output bit stream from a message tree.
Optionally, you can connect the node to another node and propagate the message
tree for further processing. User-defined output nodes and message processing

nodes are, therefore, structured in the same way. All relevant information for
output nodes is included in [“Planning user-defined message processing nodes” on|
ﬁa ge 21.

User-defined parsers

A user-defined parser is a program that interprets the bit stream of an incoming
message and creates an internal representation of the message in a tree structure. A
user-defined parser can also regenerate a bit stream for an outgoing message from
the internal message tree representation

Create a user-defined parser when the WebSphere Message Broker parsers are not
sufficient to parse user-defined messages.

Do not use user-defined parsers to provide connectivity or transformation
functions. In most cases, the MRM or other IBM-supplied parsers are capable of
passing most standard type of format. You can also parse a message and construct
a message tree in a user-defined node without the need to write a parser. For
example, a user-defined node that reads e-mails from a POP3 server can parse the
e-mail and construct a message tree without the need to write a user-defined
parser.

If the parser is going to be used only in a user-defined node, you do not need to
use a user-defined parser. However, consider a user-defined parser if the parser

will be called from other message flow nodes.

User-defined parser life cycle:
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Various stages exist in the life of a user-defined message flow parser.

These stages are involved:
* Registration

* Instantiation

* Processing

* Destruction

This topic describes the interactions that take place between WebSphere Message
Broker components when you run a user-defined parser. It explains each stage in
terms of the events that start each stage, and the events that occur during and after
each stage, and the APIs that are called. Understanding the concepts here help you
to design and develop your parser more effectively.

Registration: The first phase in the user-defined parser’s life cycle is the
registration phase. The purpose of the registration phase is to register the
user-defined parser with the broker. This phase starts when the execution group
starts.

Instantiation: The parser is created during the instantiation phase of the parser life
cycle. When an input message is received, or an output message is built in a
Compute node, the relevant parser is identified, and parser requirements are taken
from the message header, such as the MQMD. The broker starts and loads the
Loadable Implementation Library (LIL) and the parser factory. Before the
cpiCreateContext function is called, the broker creates a name element as the
effective root element for the parser. However, this element is not named. The
parser should name this element in the cpiSetElementName function. The
execution group process creates an instance of the parser, and the broker makes a
call to cpiCreateContext to allow the parser object to acquire the appropriate
section of the message.

The broker then makes a call to cpiParseBuffer. cpiParseBuffer performs any
necessary initialization, and returns the length of the message content that the
parser is taking ownership of. The parser assesses how much of the message data
to parse, and claims the appropriate number of bytes.

Whenever an instance of a user-defined parser object is created, the context
creation implementation function cpiCreateContext is also invoked by the broker.
This call allows the parser to allocate instance data associated with the parser. A
cpiDeleteContext function to delete the context of the parser object is also required.

Processing: During the processing phase, the parser manipulates, alters, and
references elements within the message object. The message flow processing phase
begins when any message processing activity occurs, such as navigation, that
requires access to an element within a message that does not exist in the broker’s
internal model representation of the message concerned.

During the message flow processing phase, the parser is invoked in response to
attempts to navigate into the message tree. The parser examines the buffer that
was allocated when cpiParseBuffer was called, and creates any necessary message
elements.

The parser can then navigate through the message elements, using any or all of the
following parser implementation functions:

* cpiParseFirstChild
* cpiParseLastChild
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* cpiParsePreviousSibling
* cpiParseNextSibling

These functions are invoked when any form of navigation is made (such as a filter
expression that specifies a message field) into the part of the syntax element tree
that logically represents the data for a message format supported by a user-defined
parser. This navigation occurs when an operation within the broker requires a
syntax element tree to be built or extended.

Consider the following points when deciding how best to navigate the syntax
element tree:

* A Syntax element has five pointers to its parents, siblings, and first and last
children, so that a finite set of navigations is available.

¢ The same internal classes are used to perform all of these navigations.

* The parser does not control the navigation. The ESQL or a user-defined node
makes the decision about the direction in which to navigate, and the order in
which the navigational parser implementation functions are invoked. The
user-defined parser has no control over the direction and order, and needs to
respond correctly to the chosen navigation scheme; for example, parsing right to
left, as well as left to right.

* When writing a user-defined parser, place the parser code in a parseNextltem
function. This function should build the syntax element tree one element at a
time, setting names, values and complete flags appropriately. How you
implement this function depends on the nature of the bit stream to be parsed.
The supplied sample parser demonstrates this behavior.

When the parser has finished parsing the relevant parts of the syntax element tree,
it calls cpiWriteBuffer. This function appends its portion of the syntax element tree
to the bit stream in the message buffer that is associated with the parser object,
and creates the output message.

Destruction: The Destruction phase is the final phase in the user-defined parser life
cycle. When the parser has written its portion of the syntax element tree to the bit
stream and created the output message, the system resources that were created by
the broker for the parser to use need to be released.

The destruction phase begins when the mgsistop command is used to stop the
execution process.

Planning user-defined parsers:

Read about the concepts that you should consider before you develop a
user-defined parser.

When you have considered the information provided here, and are ready to
develop your own parser, use the instructions in [‘Creating a user-defined parser”]
to construct your parser.

Analysis: Before you start to create your own parser, be clear about its purpose.
You can perform most tasks using the functions that are provided with WebSphere
Message Broker, so you might not need to create a user-defined parser for your
particular task.

Before you construct and implement a user-defined parser, consider the following
questions:
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* Do you need to create a user-defined parser?

If the available parsers in WebSphere Message Broker are not appropriate for
your needs, define your own parser to parse internal, customer-specific, or
generic commercial message formats.

* Does WebSphere Message Broker already provide a parser for the domain or
message header?

See for details of message domains for which the supplied parsers can
accept input messages, and message headers with which the supplied parsers
can work.

* Does the syntax of the in-house or commercial message dictate a format that can
be parsed?

* To parse the message successfully, does the parser need to interact with vendor
software? If so, does the API that enables access to this software break your
threading model?

* Do you need to process multi-part, multi-format messages?

WebSphere Message Broker does not support multi-part, multi-format messages.
A multi-part MRM message must consist of messages that are all in the same
format.

* What type of parsing strategy will provide best performance?

WebSphere Message Broker supports partial parsing, which allows your parser
to parse only relevant fields in a message. Using partial parsing can save system
resources.

Partial and full parsing: WebSphere Message Broker supports partial parsing. If an
individual message contains hundreds or even thousands of individual fields, the
parsing operation requires considerable memory and processor resources to
complete. An individual message flow might reference only a few of these fields,
or none at all, so it is inefficient to parse every input message completely. For this
reason, WebSphere Message Broker allows parsing of messages on an as-needed
basis. (This ability does not prevent a parser from processing the entire message in
one step, and some parsers are written to process the entire message in this way.)

Each syntax element in a logical message has two bits that indicate whether all the
elements on either side of an element are complete, and whether its children are
complete. Parsing is typically completed in a bottom-to-top, left-to-right manner.
When a parser has parsed the siblings of a particular element that precede the
given element and the first child, it sets the first completion bit to one. Similarly,
when the pointer to the next sibling of an element is complete, as well as its last
child pointer, the other completion bit is set to one.

In partial parsing, the broker waits until a part of the message is referenced, and
invokes the parser to parse that part of the message. Message processing nodes
refer to fields within a message using hierarchical names. The name begins at the
root of the message and proceeds down the message tree until the particular
element is located. If an element is encountered without its completion bits set,
and further navigation from this element is required, the appropriate parser entry
point is called to parse the necessary part of the message. The relevant part of the
message is parsed, appropriate elements are added to the logical message tree, and
the element in question is marked as complete.

If you do not need to parse the full bit stream, you can use partial parsing. During
partial parsing, a parser is called recursively until the requested element is
returned, or until the message tree has been marked as complete, and the
requested element is known not to exist.
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Whether you choose to perform a full or partial parse depends on how the
message will be processed. If most field elements within the message are likely to
be accessed during processing, performing a full parse of the message when an
attempt is made to access it is typically more efficient, particularly for smaller
messages.

However, if most field elements within the message are not likely to be accessed
during processing, performing a partial parse of the message when an attempt is
made to access a specific field is typically more efficient, particularly when the
message size grows.

Specific types used by parsers: Specific types are used when a parser needs
additional information that is associated with some or all of the elements in a tree
in order to generate the bit stream.

For the XML parser, the specific type information is used to mark special elements
such as components, processing instructions, and CDATA sections. The methods
getSpecificType and setSpecificType are used by user-defined nodes to query this
information and to generate message trees that use these special types.

Developers of user-defined parsers can generate their own specific type values to
control special handling characteristics in their parser code using the existing C
user-defined parser interface. The getSpecificType and setSpecificType methods
enable Java user-defined nodes to fully exploit this parser capability.

User exits
A user exit is user-provided custom software, written in C, to track data passing
through message flows.

User-provided functions can be invoked at specific points during the life cycle of a
message while it passes through the message flow, and can invoke utility functions
to query information about the point in the flow, and the contents of the message
assembly. The utility function can also modify certain parts of the message

assembly. For more information about using user exits, see ["Why use a user exit?”|
on page 11.

The user exits can be invoked when one or more of the following events occur:

* The end of a unit-of-work (UOW) or transaction (COMMIT or ROLLBACK).

* A message passes between two nodes.

* A message is successfully enqueued or sent to a transport in an output, reply, or
request node.

* A message is dequeued or received in an input, response, or TimeoutNotification
node.

M —_— H
Compute MQOutput

In the basic message flow shown here, you can track messages at three levels:
¢ Transaction level
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* Node level
* Input or output level

At the transaction level, you can track the following events:
* Messages being read into the flow
* Completion of the transaction

At the node level, you can track the following events:
* A message passing from one node to another
* Completion of processing for one node

At the message input or output level, you can track the following events:
* Messages being read into the flow
* Messages being written from the flow

Therefore, you can track five different types of event, which occur in the following
sequence:

1. A message is dequeued from the input source (read into the flow).
2. A message is propagated to the node for processing.

3. A request message is sent to the output node’s transport, and transport-specific
destination information is written to "WrittenDestination” in the
LocalEnvironment.

4. Node processing is completed.
5. The transaction ends.

Which language to use to implement a user-defined extension

You can use Java or C to implement a user-defined extension.

You can use C to implement all types of user-defined extension, but you can use
Java to implement only user-defined nodes.

If you can, use Java for user-defined nodes, and use C for everything else.

You must compile user-defined nodes, parsers, and exits that are written in C into
a loadable implementation library (LIL): that is, a shared library on Linux and
UNIX systems, or a dynamic link library (DLL) on Windows systems. You must
package user-defined nodes that are written in Java as a JAR file.

To achieve platform independence, use the ANSI standard C or Java programming
languages, and avoid platform-specific code in your user-defined extension.

Implementing the supplied user-defined extension samples

WebSphere Message Broker provides some sample code to help you understand
how to write user-defined nodes and parsers.

The samples consist of a sample parser, and the following sample nodes:

Switch A node, implemented in both C and Java versions, that propagates an
input message to one of several output terminals depending on the
message content.

Transform A node, implemented in both C and Java versions, that performs a
simple message transformation.
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Each sample node consists of the source files and some files that you can use to
test each node. For the sample parser there are only source files. See
[files” on page 119|and [‘Sample parser files” on page 121| for details of the sample
files and where to find them.

To implement the supplied samples:

1. Compile the samples. For information on how to compile a Java node, see
[‘Compiling a Java user-defined node” on page 73] For information on how to

compile a C node or parser, see|’Compiling a C user-defined extension” on|

2. Install the user-defined extension in a broker domain. For instructions on
completing this step, see [“Installing user-defined extension runtime files on a
[proker” on page 104

3. On the computer that hosts the workbench, extract the SampleNodesProject.zip
file, which is located in the samples subdirectory and copy the files to a
directory from which the workbench can access them. For example, on
Windows, the location is install_dir\sample\extensions\com.ibm.samples.nodes
directory. For further information about where to copy the files, see |”Insta11in§|
a user-defined extension to current and past versions of the broker” on page|

7]

4. Open the workbench and switch to the Broker Application Development
perspective. The category called "Sample nodes” is now visible in the palette,
and the sample nodes are shown below it. Documentation about the sample
nodes is also visible in the help system under "Samples”.

5. Include the sample nodes in a message flow (see [Adding a message flow node).

6. Deploy the message flow; see

7. For the Switch and Transform nodes, you can put a message to the input queue
of the message flow and observe the results, as follows:

a. Make sure that the message flow containing the sample node is deployed
successfully; see [Checking the results of deployment}

b. Use the Enqueue message function to put the sample input messages (the
xml files listed above) to the input queue named on the input node of the
message flow; see |Debug: putting a test message on an input queuel

You can also use a Trace node or the Flow debugger to see what is happening
in your message flow.

Implementing user-defined extensions

Create the resources for your user-defined extension. You can write user-defined
nodes in C or Java. You can write user-defined parsers and exits only in C.

Before you start:

* For a general introduction to user-defined extensions, read |“User-defined

[extensions overview” on page 3/

* [Decide which type of user-defined extension to usel

To create a user-defined extension, follow the instructions in the appropriate topic:

* |“Implementing a user-defined node” on page 33|

+ [Implementing a user-defined parser]

+ [Implementing a user-defined exit|
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For user-defined nodes only, you must create a workbench Eclipse plug-in as well
as the runtime .1il or jar file. The workbench plug-in adds the user-defined node to
the node palette in the Message Flow editor, so that you can include the new node
in message flows. This additional task is described in [“Creating the user interface]
[representation of a user-defined node in the workbench” on page 75/ This step is
not required for user-defined parsers or exits.

The following table shows the tasks that are involved in creating the different
types of user-defined extension.

Action Topics to view

To use one of the Java 1. |“Compiling a Java user-defined node” on page 73|
sample nodes

2. |[“Installing user-defined extension runtime files on al
broker” on page 104|

3. [‘Creating the user interface representation of al
user-defined node in the workbench” on page 75|

4. |“Testing a user-defined node” on page 83

Toclllse one of the C sample |1 [“Compiling a C user-defined extension” on page 51|
nodes

2. |[“Installing user-defined extension runtime files on al
broker” on page 104|

3. [‘Creating the user interface representation of al
user-defined node in the workbench” on page 75|

4. |“Testing a user-defined node” on page 83

To use the sample parser 1. |“Compiling a C user-defined extension” on page 51

2. |[“Installing user-defined extension runtime files on al
broker” on page 104|

To create.e your own Java 1. |“Creating an input node in Java” on page 59| or [“Creating]
node using the workbench la message processing or output node in Java” on page 64|

2. [“Using event logging from a user-defined extension” on|
page 113

3. [“Compiling a Java user-defined node” on page 73|

4. |“Testing a user-defined node” on page 83

5. [“Packaging a user-defined node workbench project” on|

page 106|

6. |“Installing a user-defined extension to current and past]
versions of the broker” on page 107

To create your own C node |4 “Creating an input node in C” on page 35| or [“Creating al
Imessage processing or output node in C” on page 43|

2. [“Using event logging from a user-defined extension” on|

[page 113|

3. ["Compiling a C user-defined extension” on page 51|

4. [“Installing user-defined extension runtime files on al
broker” on page 104|

5. [‘Creating the user interface representation of al
user-defined node in the workbench” on page 75|

6. [‘Testing a user-defined node” on page 83

7. [“Packaging a user-defined node workbench project” on|

page 106|

8. [‘Installing a user-defined extension to current and past]
versions of the broker” on page 107
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Action Topics to view

To create your own parser | {

. |“Creating a user-defined parser” on page 85|

2. [“Using event logging from a user-defined extension” on|
page 113
3. ["Compiling a C user-defined extension” on page 51|

4. |[“Installing user-defined extension runtime files on al
broker” on page 104|

To create a user exit

1. |“Developing a user exit” on page 98|
2. [“Compiling a C user-defined extension” on page 51|
3. |"“Deploying a user exit” on page 99|

Implementing a user-defined node

You can implement a user-defined node to extend the function of WebSphere
Message Broker.

Before you start:

Read the following topics:

[“User-defined extensions overview” on page 3|

[“Why use a user-defined extension?” on page 4|

[“User-defined node” on page 12|

[Decide which type of user-defined extension to use}

Consider the following restrictions and factors when developing user-defined
nodes:

Interfacing a C user-defined node to Java and providing a JNI wrapper is not
supported. This restriction exists because the broker internally initializes a JVM,
which is not available through the user-defined extension interface. The JVM
initializes with various parameters that are specific to the broker’s requirements.
Because only one JVM exists in a process, whoever initializes it first specifies
these parameters. If a user-defined node uses Java, and the broker is initialized
first, these parameters might not be suitable for the user-defined node. If the
user-defined node creates the JVM before the broker starts, the broker might not
function correctly.

User-defined input nodes can support only XML, BLOB, and the WebSphere MQ
parsers.

Avoid using functions that are specific to an operating system. If you code in

this way, your user-defined extensions can work on a variety of operating
systems without requiring changes to the source code.

To implement a user-defined node, complete the following tasks in the specified
order:

1.

2
3
4.
5

[‘Designing a user-defined node” on page 34|

. [’Creating a user-defined node” on page 34|

. ["Packaging and distributing user-defined extensions” on page 100

[‘Testing a user-defined node” on page 83|

. ["Packaging a user-defined node workbench project” on page 106|
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Designing a user-defined node
Decide what type of node you need to implement the functions that are required
by your application.

Before you start:

Read [Deciding which nodes to use|to understand the different types of node. You
might need more than one node to implement all the functions that you require.

The functions that you require might not be satisfied by a template that already
exists for several reasons:

* The functions that you require do not relate to interacting with external systems.
Most of the node design pattern concentrates on communication with external
systems, which is the most likely requirement for a user-defined node.

* The functions that are required are not well suited to the WebSphere Message
Broker architecture, so you should implement them in an end application, or an
application server.

* The functions require complex control and state information, which you should
not implement as a plug-in.

Creating a user-defined node

Before you start:

Read [“Designing a user-defined node.”]

You can write user-defined nodes in C or Java. When you have created a
user-defined node, you can test it, as described in [“Testing a user-defined node” on|
If you want to test or use user-defined nodes or parsers on multiple
computers, follow the instructions given in [“Packaging and distributing]
[user-defined extensions” on page 100|

Decide whether you want to create a user-defined node in C or in Java, then
follow the instructions in the appropriate topic.

+ |“Creating a user-defined extension in C” on page 35|

+ [“Creating a user-defined extension in Java” on page 58|

+ [“Creating the user interface representation of a user-defined node in the|
workbench” on page 75|

The following table shows the tasks that are involved in creating the different
types of user-defined node.

Objective Tasks to complete

To use one of the Java 1

. ["Compiling a Java user-defined node” on page 73|
sample nodes

2. |[“Installing user-defined extension runtime files on al
broker” on page 104|

3. [‘Creating the user interface representation of al
user-defined node in the workbench” on page 75|

4. |“Testing a user-defined node” on page 83
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Objective Tasks to complete

To use one of the C sample |4 [“Compiling a C user-defined extension” on page 51|

nodes 2. [“Installing user-defined extension runtime files on al
broker” on page 104|
3. |“Creating the user interface representation of a|
user-defined node in the workbench” on page 75|
4. [“Testing a user-defined node” on page 83|
To create'e your own Java 1. |“Creating an input node in Java” on page 59 or [“Creating|
node using the workbench la message processing or output node in Java” on page 64|
2. [“Using event logging from a user-defined extension” on|
page 113

3. [“Compiling a Java user-defined node” on page 73|

4. |“Testing a user-defined node” on page 83

5. |“Packaging a user-defined node workbench project” on|
page 106|

6. |“Installing a user-defined extension to current and past]
versions of the broker” on page 107

To create your own C node: |4 “Creating an input node in C”| or|“Creating a message|

[processing or output node in C” on page 43|

2. [“Using event logging from a user-defined extension” on|
page 113

3. [“Compiling a C user-defined extension” on page 51|

4. [“Installing user-defined extension runtime files on a
broker” on page 104

5. [‘Creating the user interface representation of al
user-defined node in the workbench” on page 75|

6. [‘Testing a user-defined node” on page 83

7. [“Packaging a user-defined node workbench project” on|
page 106|

8. |“Installing a user-defined extension to current and past|
versions of the broker” on page 107

Creating a user-defined extension in C:
You can write user-defined nodes and user-defined parsers in C.
Complete one or more of the following steps to create user-defined extensions in

C:

* [“Creating an input node in C”}

+ [“Creating a message processing or output node in C” on page 43|

+ |“Creating a user-defined parser” on page 85|

+ [“Compiling a C user-defined extension” on page 51|

When you have completed this set of tasks, continue with the following tasks:

* If you have compiled a user-defined node, [“Creating the user interface|
[representation of a user-defined node in the workbench” on page 75|

* [“Testing a user-defined node” on page 83
g

+ [“Packaging and distributing user-defined extensions” on page 100|
g

Creating an input node in C:
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Create a user-defined input node in C to receive messages into a message flow.
Before you start

Read the following topics:

* [“Why use a user-defined extension?” on page 4|

* |“User-defined input nodes” on page 12|

A loadable implementation library, or LIL, is the implementation module for a C
node. A LIL is implemented as a shared or dynamic link library (DLL), but has the
file extension .lil not .dll.

The implementation functions that you write for the node are listed in
[implementation functions” on page 122, You can call utility functions, implemented
in the runtime broker, to help with the node operation; these functions are listed in
[‘C node utility functions” on page 123

WebSphere Message Broker provides the source for two sample user-defined nodes
called SwitchNode and TransformNode. You can use these nodes in their current
state, or you can modify them.

To create an input node in C:

. |"Declaring and defining the node”]

. [/Creating an instance of the node” on page 37]

. [“Setting attributes” on page 38|

[‘Implementing the node functionality” on page 39|

. [“Overriding the default message parser attributes (optional)” on page 39

o g N =

. |"Deleting an instance of the node” on page 41|

Declaring and defining the node:

To declare and define a user-defined node to the broker, include an initialization
function, bipGetMessageflowNodeFactory, in your LIL. The following steps outline
how the broker calls your initialization function, and how your initialization
function declares and defines the user-defined node:

1. The initialization function, bipGetMessageflowNodeFactory, is called by the
broker after the operating system has loaded and initialized the LIL. The broker
calls this function to understand what your LIL can do and how the broker
should call the LIL. For example:

CciFactory LilFactoryExportPrefix * LilFactoryExportSuffix
bipGetMessageflowNodeFactory()

2. The bipGetMessageflowNodeFactory function must call the utility function
cniCreateNodeFactory. This function passes back a unique factory name (or
group name) for all the nodes that your LIL supports. Every factory name (or
group name) that is passed back must be unique throughout all the LILs in a
single runtime broker.

3. The LIL must call the utility function cniDefineNodeClass to pass the unique
name of each node, and a virtual function table of the addresses of the
implementation functions.

For example, the following code declares and defines a single node called
InputxNode:
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CciFactory* factoryObject;

int rc = 0;

CciChar factoryName[] = L"MyNodeFactory";
CCI_EXCEPTION_ST exception_st;

/* Create the Node Factory for this node */
factoryObject = cniCreateNodeFactory(0, factoryName);
if (factoryObject == CCI_NULL_ADDR) {

/* Any local error handling can go here x/

}

else {

/* Define the nodes supported by this factory */
static CNI_VFT vftable = {CNI_VFT DEFAULT};

/* Setup function table with pointers to node implementation functions */

vftable.iFpCreateNodeContext = _createNodeContext;
vftable.iFpDeleteNodeContext = _deleteNodeContext;
vftable.iFpGetAttributeName2 = _getAttributeName2;
vftable.iFpSetAttribute = _setAttribute;
vftable.iFpGetAttribute2 = _getAttribute2;
vftable.iFpRun = _run;

cniDefineNodeClass (0, factoryObject, L"InputxNode", &vftable);
}

/* Return address of this factory object to the broker */
return(factoryObject);
1
A user-defined node identifies itself as providing the features of an input node
by implementing the cniRun implementation function.

User-defined nodes have to implement either a cniRun or a cniEvaluate
implementation function. If they do not, the broker does not load the
user-defined node, and the cniDefineNodeClass utility function fails, returning
CCI_MISSING_IMPL_FUNCTION.

For example:

int cniRun(
CciContext* context,
CciMessage* localEnvironment,
CciMessage* exceptionlist,
CciMessage* message

)

/* Get data from external source */
return CCI_SUCCESS_CONTINUE;
1

Use the return value periodically to return control to the broker.

When a message flow that contains a user-defined input node is deployed
successfully, the node’s cniRun function is called for each message that is
propagated to the node. For the minimum code required to compile a C
user-defined node, see the [“C skeleton code” on page 300.|

Creating an instance of the node:

To instantiate your node:

1.

When the broker has received the table of function pointers, it calls the function
cniCreateNodeContext for each instantiation of the user-defined node. For
example, if three message flows are using your user-defined node, your
cniCreateNodeContext function is called for each of them. This function should

Developing user-defined extensions 37



allocate memory for that instantiation of the user-defined node to hold the
values for the configured attributes. For example:

a. Call the cniCreateNodeContext function:

CciContext* _createNodeContext (
CciFactoryx factoryObject,
CciChar= nodeName,
CciNodex* nodeObject

)

static char* functionName = (char *)" _createNodeContext()";
NODE_CONTEXT_ST* p;
CciChar buffer[256];

b. Allocate a pointer to the local context and clear the context area:
p = (NODE_CONTEXT_ST *)malloc(sizeof(NODE_CONTEXT_ST));

if (p) {
memset (p, 0, sizeof(NODE_CONTEXT_ST));

C. Save the node object pointer in the context:
p->nodeObject = nodeObject;
d. Save the node name:
CciCharNCpy ((CciCharx)&p->nodeName, nodeName, MAX NODE_NAME LEN);
€. Return the node context:
return (CciContextx) p;

2. An input node has a number of output terminals associated with it, but
typically does not have any input terminals. Use the utility function
cniCreateOutputTerminal to add output terminals to an input node when the
node is instantiated. These functions must be invoked within the
cniCreateNodeContext implementation function. For example, to define an
input node with three output terminals:

{
const CciChar* ucsOut = CciString("out", BIP_DEF_COMP_CCSID) ;

insOQutputTerminalListEntry(p, (CciCharx)ucsOut);
free((void *)ucsOut) ;

const CciChar* ucsFailure = CciString("failure", BIP_DEF_COMP_CCSID) ;
insQutputTerminalListEntry(p, (CciChar*)ucsFailure);
free((void *)ucsFailure) ;

const CciChar* ucsCatch = CciString("catch", BIP_DEF_COMP_CCSID) ;
insOutputTerminallListEntry(p, (CciChar*)ucsCatch);
free((void *)ucsCatch) ; }

For the minimum code required to compile a C user-defined node, see
[skeleton code” on page 300,

Setting attributes:

Attributes are set whenever you start the broker, or when you redeploy the
message flow with new values.

Following the creation of output terminals, the broker calls the cniSetAttribute
function to pass the values for the configured attributes of the user-defined node.
For example:

{
const CciChar* ucsAttr = CciString("nodeTraceSetting", BIP_DEF_COMP_CCSID) ;

insAttrTbl1Entry(p, (CciChar*)ucsAttr, CNI_TYPE INTEGER);
_setAttribute(p, (CciChar*)ucsAttr, (CciCharx)constZero);
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free((void *)ucsAttr) ;

}

{
const CciChar* ucsAttr = CciString("nodeTraceOutfile", BIP_DEF_COMP_CCSID) ;
insAttrTb1Entry(p, (CciChar*)ucsAttr, CNI_TYPE_STRING);
_setAttribute(p, (CciCharx)ucsAttr, (CciCharx)constSwitchTracelocation);
free((void *)ucsAttr) ;

The number of configuration attributes that a node can have is unlimited.
However, a user-defined node must not implement an attribute that is already
implemented as a base configuration attribute. The base attributes are listed below:

* label

» userTraceLevel
* tracelLevel

» userTraceFilter
* traceFilter

Implementing the node functionality:

When the broker knows that it has an input node, it calls the cniRun function of
this node at regular intervals. The cniRun function must then decide what course
of action it should take. If data is available for processing, the cniRun function
should attempt to propagate the message. If no data is available for processing, the
cniRun function should return with CCI_TIMEOUT so that the broker can continue
configuration changes.

For example, to configure the node to call cniDispatchThread and process the
message, or return with CCI_TIMEOUT:

If ( anything to do )
CniDispatchThread;

/* do the work */

If ( work done 0.K.)

Return CCI_SUCCESS_CONTINUE;
Else

Return CCI_FAILURE_CONTINUE;
Else

Return CCI_TIMEOUT;

Overriding the default message parser attributes (optional):

An input node implementation typically determines what message parser initially
parses an input message. For example, the primitive MQInput node dictates that
an MQMD parser is required to parse the MQMD header. A user-defined input
node can select an appropriate header or message parser, and the mode in which
the parsing is controlled, by using or overriding the following attributes that are
included as default:

rootParserClassName
Defines the name of the root parser that parses message formats that are
supported by the user-defined input node. It defaults to GenericRoot, a
supplied root parser that causes the broker to allocate and chain parsers
together. It is unlikely that a node would need to modify this attribute
value.
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firstParserClassName
Defines the name of the first parser, in what might be a chain of parsers
that are responsible for parsing the bit stream. It defaults to XML.

messageDomainProperty
An optional attribute that defines the name of the message parser that is
required to parse the input message. The supported values are the same as
those supported by the MQInput node. (See for more
information.)

messageSetProperty
An optional attribute that defines the message set identifier, or the message
set name, in the Message Set field, only if the MRM parser was specified
by the messageDomainProperty attribute.

messageTypeProperty
An optional attribute that defines the identifier of the message in the
MessageType field, only if the MRM parser was specified by the
messageDomainProperty attribute.

messageFormatProperty
An optional attribute that defines the format of the message in the Message
Format field, only if the MRM parser was specified by the
messageDomainProperty attribute.

If you have written a user-defined input node that always begins with data of a
known structure, you can ensure that a certain parser deals with the start of the
data. For example, the MQInput node only reads data from WebSphere MQ
queues, so this data always has an MQMD at the beginning, and the MQInput
node sets firstParserClassName to MQHMD. If your user-defined node always
deals with data that begins with a structure that can be parsed by a certain parser,
for example "MYPARSER", set firstParserClassName to MYPARSER as follows:

1. Declare the implementation functions:
CciFactory LilFactoryExportPrefix * LilFactoryExportSuffix bipGetMessageflowNodeFactory()
{

CciFactory* factoryObject;
factoryObject = cniCreateNodeFactory(0, (unsigned short *)constPTuginNodeFactory);

vftable.iFpCreateNodeContext = _createNodeContext;
vftable.iFpSetAttribute = _setAttribute;
vftable.iFpGetAttribute = _getAttribute;

cniDefineNodeClass(&rc, factoryObject, (CciCharx)constSwitchNode, &vftable);

return(factoryObject);

2. Set the attribute in the cniCreateNodeContext implementation function:

CciContext* _createNodeContext (
CciFactory* factoryObject,
CciCharx* nodeName,
CciNode= nodeObject

)M
NODE_CONTEXT_ST* p;

/* Allocate a pointer to the local context */

p = (NODE_CONTEXT_ST *)malloc(sizeof(NODE_CONTEXT ST));

/* Create attributes and set default values */

{
const CciChar* ucsAttrName CciString("firstParserClassName", BIP_DEF_COMP_CCSID);
const CciChar* ucsAttrValue = CciString("MYPARSER", BIP_DEF_COMP_CCSID) ;
insAttrTb1Entry(p, (CciChar*)ucsAttrName, CNI TYPE INTEGER);
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/*see sample BipSampPluginNode.c for implementation of insAttrTblEntry=/

_setAttribute(p, (CciChar*)ucsAttrName, (CciCharx)ucsAttrValue);
free((void *)ucsAttrName) ;
free((void *)ucsAttrValue) ;

}

In the code example above, the insAttrTblEntry method is called. This method
is declared in the SwitchNode and TransformNode sample user-defined nodes.

Deleting an instance of the node:

Nodes are destroyed when a message flow is redeployed, or when the execution
group process is stopped (using the mgsistop command). When a node is
destroyed, you should call the cniDeleteNodeContext function to free any used
memory and release any held resources. For example:

void _deleteNodeContext (
CciContext* context
)

static char* functionName = (char *)"_deleteNodeContext()";

return;

}

Extending the capability of a C input node:
When you have created a user-defined node, you can extend its capability.

Before you start

Read [“Creating an input node in C” on page 35|

After you have created a user-defined node, the following options are available:

1. ['Receiving external data into a buffer”|

2. |“Controlling threading and transactions” on page 42|

3. [“Propagating the message” on page 43|

Receiving external data into a buffer:

An input node can receive data from any type of external source, such as a file
system or FTP connection, provided that the output from the node is in the correct
format. For connections to queues or databases, use the built-in nodes and the API
calls supplied, principally because the built-in nodes are already set up for error
handling. Do not use the MQGET or MQPUT calls for direct access to WebSphere
MQ queues.

You must provide an input buffer (or bit stream) to contain input data, and
associate it with a message object. In the C API, the buffer is attached to the
CciMessage object that represents the input message by using the cniSetInputBuffer
utility function. For example:

{

static char* functionName = (char *)" Input_run()";

void* buffer;

CciTerminal* terminalObject;

int buflen = 4096;

int rc = CCI_SUCCESS;

int rcDispatch = CCI_SUCCESS;
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buffer = readFromDevice(&buflen);
cniSetInputBuffer(&rc, message, buffer, buflen);

}
/*propagate etcx/

Controlling threading and transactions:

An input node must perform appropriate end-of-message processing when a
message has been propagated through a message flow. Specifically, the input node
needs to cause any transactions to be committed or rolled back, and return threads
to the thread pool.

Each message flow thread is allocated from a pool of threads that is maintained for
each message flow, and starts execution in the cniRun function. You determine the
behavior of a thread using the cniDispatchThread utility function, together with
the appropriate return value.

From the cniRun function, you can call the cniDispatchThread utility function to
cause another thread to start executing the cniRun function. The most appropriate
time to execute another thread is directly after you have established that data
could be available for the function to process on the new thread.

The term transaction is used generically to describe either a globally coordinated
transaction, or a broker-controlled transaction. Globally coordinated transactions
are coordinated by either WebSphere MQ as an XA-compliant Transaction
Manager, or Resource Recovery Service (RRS) on z/OS®. WebSphere Message
Broker controls transactions by committing (or rolling back) any database
resources, and then committing any WebSphere MQ units of work. However, if a
user-defined node is used, the broker cannot automatically commit any resource
updates. The user-defined node uses return values to indicate whether a
transaction has been successful, and to control whether transactions are committed
or rolled-back. The broker infrastructure catches any unhandled exceptions, and
rolls back the transaction.

The following table describes each of the supported return values, the effect that
each one has on any transactions, and what the broker does with the current

thread.
Return value Affect on transaction Broker action on the thread
CCI_SUCCESS_CONTINUE |Committed Calls the same thread again
in the cniRun function.
CCI_SUCCESS_RETURN Committed Returns the thread to the
thread pool.
CCI_FAILURE_CONTINUE | Rolled back Calls the same thread again
in the cniRun function.
CCI_FAILURE_RETURN Rolled back Returns the thread to the
thread pool.
CCI_TIMEOUT Not applicable. The function |Calls the same thread again
periodically times out while |in the cniRun function.
it is waiting for an input
message.

The following code is an example of using the SUCCESS_RETURN return code
with the cniDispatchThread function:
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cniDispatchThread (&rcDispatch, ((NODE_CONTEXT ST =*)context)->nodeObject);

if (rcDispatch == CCI_NO_THREADS_AVAILABLE) return CCI_SUCCESS_CONTINUE;
else return CCI_SUCCESS_RETURN;
}

Propagating the message:

Before you propagate a message, decide what message flow data you want to
propagate, and which terminal is to receive the data.

The terminalObject is derived from a list that the user-defined node maintains.

For example, to propagate the message to the output terminal, use the
cniPropagate function:
if (terminalObject) {
if (cnilsTerminalAttached(&rc, terminalObject)) {
if (rc == CCI_SUCCESS) {
cniPropagate(&rc, terminalObject, TocalEnvironment, exceptionList, message);

}
}

In the above example, the cnilsTerminalAttached function is used to test whether
the message can be propagated to the specified terminal. If you do not use the
cnilsTerminal Attached function, and the terminal is not attached to another node
by a connector, the message is not propagated and no warning message is
returned. Use the cnilsTerminalAttached function to prevent this error occurring.

Creating a message processing or output node in C:

A message processing node is used to process a message in some way, and an
output node is used to output a message as a bit stream.

Before you start

Read the following topics:

+ ["'Why use a user-defined extension?” on page 4|

+ [“User-defined message processing nodes” on page 17

» [“User-defined output nodes” on page 24|

When you code a message processing node or an output node, the nodes provide
essentially the same services. You can perform message processing within an
output node, and you can output a message to a bit stream using a message
processing node. For simplicity, this topic refers mainly to the node as a message
processing node but it does also discuss the functionality of both types of node.

A loadable implementation library (LIL), is the implementation module for a C
node. A LIL is implemented as a shared or dynamic link library (DLL), but has the
file extension .1il not .dll.

For more information about the C node implementation functions that you write
for the node, see [‘C node implementation functions” on page 122 You can call C
node utility functions, implemented in the runtime broker, to help with the node
operation; for more information, see [“C node utility functions” on page 123
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WebSphere Message Broker provides the source for two sample user-defined nodes
called SwitchNode and TransformNode. You can use these nodes in their current
state, or you can modify them. In addition, you can view the following sample
which demonstrates the use of user-defined nodes, including a message processing
node written in C.

+ |User-defined Extension sample

You can view samples only when you use the information center that is integrated
with the Message Broker Toolkit.

To create either type of node:

1. [“Declaring and defining your node”]

2. ['Creating an instance of the node” on page 45|

3. [‘Setting attributes” on page 47|

4. ["Implementing the node functionality” on page 48|
5. [“Deleting an instance of the node” on page 48]

Declaring and defining your node:

To declare and define a user-defined node to the broker, include an initialization
function, bipGetMessageflowNodeFactory, in your LIL. The following steps take
place on the configuration thread and outline how the broker calls your
initialization function and how your initialization function declares and defines the
user-defined node:

1. The broker calls the initialization function bipGetMessageflowNodeFactory after
the operating system has loaded and initialized the LIL. The broker calls this
function to understand what your LIL can do and how the broker can call the
LIL. For example:

CciFactory LilFactoryExportPrefix * LilFactoryExportSuffix
bipGetMessageflowNodeFactory ()

2. The bipGetMessageflowNodeFactory function must call the utility function
cniCreateNodeFactory. This function passes back a factory name (or group
name) for all the nodes that your LIL supports. The factory name (or group
name) must be unique throughout all the LILs in a single runtime broker.

3. The LIL must call the utility function cniDefineNodeClass to pass the unique
name of each node and a virtual function table of the addresses of the
implementation functions.

For example, the following code declares and defines a single node called
MessageProcessingxNode:

{

CciFactoryx factoryObject;

int rc = 0;

CciChar factoryName[] = L"MyNodeFactory";
CCI_EXCEPTION_ST exception_st;

/* Create the Node Factory for this node */
factoryObject = cniCreateNodeFactory(0, factoryName);
if (factoryObject == CCI_NULL_ADDR) {

/* Any local error handling can go here x/

}

else {

/* Define the nodes supported by this factory =/
static CNI_VFT vftable = {CNI_VFT_DEFAULT};

/* Setup function table with pointers to node implementation functions =*/
vftable.iFpCreateNodeContext = _createNodeContext;
vftable.iFpDeleteNodeContext = _deleteNodeContext;
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vftable.iFpGetAttributeName2 = _getAttributeName2;
vftable.iFpSetAttribute = _setAttribute;
vftable.iFpGetAttribute2 = _getAttribute2;
vftable.iFpEvaluate = _evaluate;

cniDefineNodeClass (0, factoryObject, L"MessageProcessingxNode", &vftable);

}

/* Return address of this factory object to the broker x/

}return (factoryObject);
A user-defined node identifies itself as a message processing or output node by
implementing the cniEvaluate function. User-defined nodes must implement
either a cniEvaluate or a cniRun implementation function, otherwise the broker
does not load the user-defined node, and the cniDefineNodeClass utility
function fails, returning CCI_MISSING_IMPL_FUNCTION.

When a message flow containing a user-defined message processing node is
deployed successfully, the node’s cniEvaluate function is called for each
message propagated to the node.

Message flow data is received at the input terminal of the node, that is, the
message, Environment, LocalEnvironment, and ExceptionList.

For example:

void cniEvaluate(
CciContext* context,
CciMessage* localEnvironment,
CciMessagex exceptionlList,
CciMessage* message

)
.

For the minimum code required to compile a C user-defined node, see
[skeleton code” on page 300

Creating an instance of the node:

To instantiate your node:

1.

When the broker has received the table of function pointers, it calls the function
cniCreateNodeContext for each instantiation of the user-defined node. For
example, if three message flows are using your user-defined node, your
cniCreateNodeContext function is called for each of them. This function
allocates memory for that instantiation of the user-defined node to hold the
values for the configured attributes. For example:

a. The user function cniCreateNodeContext is called:

CciContext* _Switch_createNodeContext (
CciFactory* factoryObject,
CciChar= nodeName,
CciNode= nodeObject
)
static char* functionName = (char *)" Switch_createNodeContext()";
NODE_CONTEXT_ST* p;
CciChar buffer[256];

b. Allocate a pointer to the local context and clear the context area:
p = (NODE_CONTEXT_ST *)malloc(sizeof(NODE_CONTEXT_ST));

if (p) {
memset (p, 0, sizeof(NODE_CONTEXT_ST));
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C. Save the node object pointer in the context:
p->nodeObject = nodeObject;
d. Save the node name:
CciCharNCpy((CciChar*)&p->nodeName, nodeName, MAX_NODE_NAME_LEN);
€. Return the node context:
return (CciContext*) p;

2. The broker calls the appropriate utility functions to find out about the node’s
input terminals and output terminals. A node has a number of input terminals
and output terminals associated with it. Within the user function
cniCreateNodeContext, calls must be made to cniCreateInputTerminal and
cniCreateOutputTerminal to define the user node’s terminals. These functions
must be started within the cniCreateNodeContext implementation function. For
example, to define a node with one input terminal and two output terminals:

{ const CciChar* ucsIn = CciString("in", BIP_DEF_COMP_CCSID) ;

insInputTerminallListEntry(p, (CciChar*)ucsIn);
free((void *)ucsIn) ;

const CciChar* ucsOut = CciString("out", BIP_DEF_COMP_CCSID) ;
insQutputTerminalListEntry(p, (CciChar*)ucsOut);
free((void *)ucsOut) ;

const CciChar* ucsFailure = CciString("failure", BIP_DEF_COMP_CCSID) ;

insQutputTerminallListEntry(p, (CciChar*)ucsFailure);

free((void *)ucsFailure) ;

}

The previous code starts the insInputTerminalListEntry and
insOutputTerminalListEntry functions. You can find these functions in the
sample code Common.c; see [‘Sample node files” on page 119, These functions
define the terminals to the broker and store handles to the terminals. Handles
are stored in the structure referenced by the value returned in CciContext*. The
node can then access the terminal handles from within the other
implementation functions (for example CciEvaluate) because CciContext is
passed to those implementation functions.

The following code shows the definition of insInputTerminalListEntry:

TERMINAL_LIST_ENTRY *insInputTerminallListEntry(
NODE_CONTEXT_ST=* context,
CciChar= terminalName
)
static char* functionName = (char *)"insInputTerminalListEntry()";
TERMINAL_LIST_ENTRY=* entry;
int rcs

entry = (TERMINAL_LIST ENTRY *)malloc(sizeof(TERMINAL LIST ENTRY));
if (entry) {

/* This entry is the current end of the Tist */
entry->next = 0;

/% Store the terminal name */
CciCharCpy(entry->name, terminalName);

/* Create terminal and save its handle */
entry->handle = cniCreatelnputTerminal(&rc, context->nodeObject, (CciChar*)terminalName);

/* Link an existing previous element to this one */

if (context->inputTerminalListPrevious) context->inputTerminallListPrevious->next = entry;
else if ((context->inputTerminallListHead) == 0) context->inputTerminallListHead = entry;

46  User-defined Extensions



/* Save the pointer to the previous element */
context->inputTerminalListPrevious = entry;

}
else {
/* Error: Unable to allocate memory =*/

}

return(entry);

}
The following shows the code for insOutputTerminalListEntry:

TERMINAL_LIST_ENTRY *insQutputTerminalListEntry(
NODE_CONTEXT_ST=* context,
CciCharx terminalName

)
static char* functionName = (char *)"insOutputTerminalListEntry()";
TERMINAL_LIST_ENTRY=* entry;
int rc;

entry = (TERMINAL_LIST_ENTRY *)ma]]OC(S'iZeof(TERMINAL_LIST_ENTRY));
if (entry) {

/* This entry is the current end of the list */
entry->next = 0;

/* Store the terminal name =/
CciCharCpy(entry->name, terminalName);

/* Create terminal and save its handle =*/
entry->handle = cniCreateOutputTerminal (&rc, context->nodeObject, (CciChar*)terminalName);

/* Link an existing previous element to this one */
if (context->outputTerminallListPrevious) context->outputTerminallListPrevious->next = entry;
else if ((context->outputTerminallListHead) == 0) context->outputTerminallListHead = entry;

/* Save the pointer to the previous element */
context->outputTerminallListPrevious = entry;

}
else {
/* Error: Unable to allocate memory =*/

}

return(entry);

For the minimum code required to compile a C user-defined node, see
[skeleton code” on page 300

Setting attributes:

Attributes are set whenever you start the broker, or when you redeploy a message
flow with new values. Attributes are set by the broker calling user code on the
configuration thread. Your code needs to store these attributes in its node context
area, for later use when processing messages.

Following the creation of input and output terminals, the broker calls the
cniSetAttribute function to pass the values for the configured attributes for this
instantiation of the user-defined node. For example:

{
const CciChar* ucsAttr = CciString("nodeTraceSetting", BIP_DEF_COMP_CCSID) ;

insAttrTb1Entry(p, (CciChar*)ucsAttr, CNI_TYPE_INTEGER);
_setAttribute(p, (CciChar*)ucsAttr, (CciCharx)constZero);
free((void *)ucsAttr) ;
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const CciChar* ucsAttr = CciString("nodeTraceOutfile", BIP_DEF_COMP_CCSID) ;
insAttrTb1Entry(p, (CciChar*)ucsAttr, CNI_TYPE_STRING);
_setAttribute(p, (CciChar*)ucsAttr, (CciCharx)constSwitchTracelLocation);
free((void *)ucsAttr) ;

1

The number of configuration attributes that a node can have is unlimited.
However, a node must not implement an attribute that is already implemented as
a base configuration attribute. The following list shows base attributes:

* label

» userTraceLevel
* traceLevel

» userTraceFilter

e traceFilter
Implementing the node functionality:

When the broker retrieves a message from the queue, and that message arrives at
the input terminal of your user-defined message processing or output node, the
broker calls the implementation function cniEvaluate. This function is called on the
message processing thread and it must decide what to do with the message. This
function might be called on multiple threads, especially if additional instances are
used.

Deleting an instance of the node:

If a node is deleted, the broker calls the cniDeleteNodeContext function. This
function is started on the same thread as cniCreateNodeContext. Use this function
to release resources used by your user-defined node. For example:

void _deleteNodeContext (
CciContext* context

)
static char* functionName = (char *)"_deleteNodeContext()";
free ((void*) context);
return;

}

Extending the capability of a C message processing or output node:

When you have created a user-defined message processing or output node in C,
you can extend its capability.

Before you start

Read the topic [‘Creating a message processing or output node in C” on page 43

After you have created a user-defined node, the following options are available:

1. [“Accessing message data”]

2. [“Transforming a message object” on page 49|
3. ["Accessing ESQL” on page 50|

4. [“Propagating a message” on page 50|

5. [“Writing to an output device” on page 51|

Accessing message data:
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In many cases, the user-defined node must access the contents of the message that
is received on its input terminal. The message is represented as a tree of syntax
elements. Groups of utility functions are provided for message management,
message buffer access, syntax element navigation, and syntax element access. (See
[“C node utility functions” on page 123|for details of the utility functions.)

The types of query that you are likely to want to perform include:

* Obtaining the root element of the required message object

* Accessing the bit stream representation of an element tree

* Navigating or querying the tree by asking for child or sibling elements by name
* Getting the type of the element

* Getting the value of the element

For example, to query the name and type of the first child of body:
void cniEvaluate( ...

)

/* Navigate to the target element =*/
rootElement = cniRootElement(&rc, message);
bodyElement = cnilastChild(&rc, rootElement);
bodyFirstChild = cniFirstChild(&rc, bodyElement);

/* Query the name and value of the target element x/
cniElementName (&rc, bodyFirstChild, (CciChar*)&elementname, sizeof(elementName));
bytes = cniElementCharacterValue(
&rc, bodyfirstChild, (CciChar=)&eValue, sizeof(eValue));

.

To access the bit stream representation of an element tree you can use the
cniElementAsBitstream function. Using this function, you can obtain the bit stream
representation of any element in a message. See [“cniElementAsBitstream” on page]
for details of how to use this function, and sample code.

Transforming a message object:

The received input message is read-only, therefore before a message can be
transformed, you must write it to a new output message using the
cniCreateMessage function. You can copy elements from the input message, or you
can create new elements and attach them to the message. New elements are
typically in a parser’s domain.

For example:
1. To write the incoming message to a new message:

{

context = cniGetMessageContext(&rc, message));
outMsg = cniCreateMessage(&rc, context));

1
2. To make a copy of the new message:
cniCopyElementTree(&rc, sourceElement, targetElement);
3. To modify the value of a target element:
cniSetElementIntegerValue(&rc, targetElement, L"newValue", 8);

4. After finalizing and propagating the message, you must delete the output
message using the cniDeleteMessage function:
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cniDeleteMessage(&rc, outMsg);

As part of the transformation, you might want to create a new message body. To
create a new message body, use one of the following functions, which assign a
parser to a message tree folder:

cniCreateElementAsFirstChildUsingParser

cniCreateElementAsLastChildUsingParser

cniCreateElementAfterUsingParser
cniCreateElementBeforeUsingParser

When creating a message body, do not use the following functions because they do
not associate an owning parser with the folder:

cniCreateElementAsFirstChild
cniCreateElementAsLastChild
cniCreateElementAfter
cniCreateElementBefore

Accessing ESQL:

Nodes can invoke ESQL expressions using Compute node ESQL syntax. You can
create and modify the components of the message using ESQL expressions, and
you can refer to elements of both the input message and data from an external
database using the cniSqlCreateStatement, cniSqlSelect, cniSqlDeleteStatement, and
cniSqlExecute functions.

For example, to populate the Result element from the contents of a column in a
database table:

{
sqlExpr = cniSqlCreateStatement (&rc,
(NODE_CONTEXT_ST *)context->nodeObject,

L"DB", CCI_SQL_TRANSACTION_AUTO,
L"SET OutputRoot.XMLNS.Result[] = (SELECT T.C1 AS Coll FROM Database.TABLE AS T;");

cniSqlSelect (&rc, sqlExpr, localEnvironment, exceptionList, message, outMsg);
cniSqlDeleteStatement (&rc, sqlExpr);

}
For more information about ESQL, see
If your user-defined node primarily uses ESQL, consider using a

Propagating a message:

Before you propagate a message, decide what message flow data you want to
propagate, and which terminal is to receive the data.

1. If the message has changed, finalize the message before you propagate it using
the cniFinalize function. For example:
cniFinalize(&rc, outMsg, CCI_FINALIZE_NONE);
2. The terminalObject is derived from a list that the user-defined node maintains
itself. To propagate the message to the output terminal, use the cniPropagate
function:
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if (terminalObject) {
if (cnilsTerminalAttached(&rc, terminalObject)) {
if (rc == CCI_SUCCESS) {
cniPropagate(&rc, terminalObject, localEnvironment, exceptionList, outMsg);
}
}
In the above example, the cnilsTerminalAttached function is used to test
whether the message can be propagated to the specified terminal. If you do not
use the cnilsTerminalAttached function and the terminal is not attached to
another node by a connector, the message is not propagated and no warning
message is returned. Use the cnilsTerminalAttached function to prevent this
error occurring.

3. If you created a new output message using cniCreateMessage, after
propagating the message, delete the output message using the
cniDeleteMessage function:

cniDeleteMessage(&rc, outMsg);
Writing to an output device:

A transformed message must be serialized to a bit stream; a message can be
serialized only once.

The bit stream can then be accessed and written to an output device. Write the
message to a bit stream using the cniWriteBuffer function. For example:

{

cnilriteBuffer(&rc, message);
writeToDevice(cniBufferPointer(&rc, message), cniBufferSize(&rc, message));

.

In this example, the method writeToDevice is a user-written method which writes
a bit stream to an output device.

Do not write a user-defined output node to write messages to WebSphere MQ
queues; use the supplied MQOutput node in this scenario. The broker internally
maintains a WebSphere MQ connection and open queue handles on a
thread-by-thread basis, and these are cached to optimize performance. In addition,
the broker handles recovery scenarios when certain WebSphere MQ events occur;
this recovery would be adversely affected if WebSphere MQ MQI calls are used in
a user-defined output node.

Compiling a C user-defined extension:
Compile user-defined extensions in C for all supported operating systems.
Before you start

If you create your own user-defined nodes, parsers, and user exits in C, compile
them on the operating system on which the target broker is running. Samples are
provided for both nodes and parsers, and are described in [“Sample node files” on|
[page 119|and [‘Sample parser files” on page 121.|Use the instructions here to
compile the samples. If you want to create your own extensions, see the following
topics:

+ [“Creating a user-defined extension in C” on page 35|

+ |“Creating a user-defined parser” on page 85|
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+ |“Creating a user-defined exit” on page 98|

These instructions use the file names of the supplied samples. If you are compiling
your own user-defined extensions, substitute your own file names.

When you compile a user-defined extension that is written in C, you need a
compatible compiler. For details of supported compilers, see [Optional software|
‘

Header files:

The following header files define the C interfaces:

BipCni.h
Message processing nodes

BipCpi.h
Message parsers

BipCci.h
Interfaces common to both nodes and parsers

BipCos.h
Platform-specific definitions

Compiling:

Compile the source for your user-defined extension on each of the supported
operating systems to create the executable file that the broker calls to implement
your user-defined extension. On Linux, UNIX, and z/OS systems, this file is a
loadable implementation library file (LIL); on Windows systems, it is a dynamic
load library (DLL).

The libraries that you build to contain user-defined nodes or parsers must have the
extension .lil on all operating systems so that the broker can load them. Libraries
that contain user exits must have the extension .lel on all operating systems. The
examples in this topic show libraries with the extension .lil.

Refer to the documentation for the compiler that you are using for full details of
available compile and link options that might be required for your programs.

Navigate to the directory where your user-defined extension source code is located,
ane—felfow the instructions for your operating system:

* JAIXY
+ [HP-UX on PA-RISC]
* [HP-UX on Itanium|
+ [Linux|

. Solaris|
¢ [Windows
e |z/ OS|

Compiling on AIX:

When you compile a user-defined extension that is written in C, use a supported
compiler.
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The following instructions are for compiling an extension for a default 64-bit
execution group. If the extension will be called from a 32-bit execution group,
make the following substitutions in the compile and link examples:

* Replace x1c_r -q64 -qwarn64 with x1c_r -q32
* Replace -1 imbdfp1g64 with -1 imbdfplg

xlc_r -q64 -qwarn64 \
-1\
-1/install_dir/include/plugin \
-c SwitchNode.c \
-0 SwitchNode.o

xlc_r -q64 -qwarn64 \
-1\
-I/install_dir/include/plugin \
-c BipSampPluginUtil.c \
-0 BipSampPluginUtil.o

xlc_r -q64 -gqwarn64 \
-1\
-1/install_dir/include/plugin \
-c Common.c \
-0 Common.o

xTc_r -q64 -qwarn64 \
-1\
-I/install_dir/include/plugin \
-c NodeFactory.c \
-0 NodeFactory.o

xlc_r -g64 -qwarn64 \
-gmkshrobj \
-bM:SRE \
-bexpall \
-bnoentry \
-0 SwitchNode.1i1 SwitchNode.o \
BipSampPluginUtil.o Common.o NodeFactory.o \
-L /install_dir/1ib \
-1 imbdfplg64

chmod a+r SwitchNode.li1

Compiling on HP-UX on PA-RISC:

When you compile a user-defined extension that is written in C, use a supported

compiler.

The following instructions are for compiling an extension for a default 64-bit
execution group. If the extension will be called from a 32-bit execution group,
make the following substitutions in the compile and link examples:
* Replace +DD64 with +DD32
e Replace -1 imbdfp1g64 with -1 imbdfplg
cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT \

-1\

-I/install_dir/include \

-I/install_dir/include/plugin \

-c BipSampPluginUtil.c \

-0 output_dir/BipSampPTuginUtil.o \

-Ae

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT \

-1\
-I/install_dir/include \
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-I/install_dir/include/plugin \
-c Common.c \

-0 output_dir/Common.o \

-Ae

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT \
-1.\
-I/install_dir/include \
-I/install_dir/include/plugin \
-c NodeFactory.c \
-0 output_dir/NodeFactory.o \
-Ae

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT \
-1\
-1/install_dir/include \
-I/install_dir/include/plugin \
-c SwitchNode.c \
-0 output_dir/SwitchNode.o \
-Ae

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT\
-1\
-1/install _dir/include \
-1/install_dir/include/plugin \
-c TransformNode.c \
-0 output_dir/TransformNode.o \
-Ae

1d -b \
-0 output_dir/SwitchNode.1i1 \
output_dir/BipSampPluginUtil.o \
output_dir/Common.o \
output_dir/NodeFactory.o \
output_dir/SwitchNode.o \
output_dir/TransformNode.o \
-L install_dir/1ib \
-L install _dir/xml4c/1ib \
-L install_dir/merant/1ib \
-L install_dir/jre/1ib/PA_RISC2.0 \
-L install _dir/jre/1ib/PA_RISC2.0/server \
-1 imbdfplg64

chmod at+r output_dir/SwitchNode.1i1

Compiling on HP-UX on Itanium:

When you compile a user-defined extension that is written in C, use a supported
compiler.

The following instructions are for compiling an extension for a 64-bit execution
group; 32-bit execution groups are not supported.

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT -Ae \
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
-c BipSampPluginUtil.c \
-0 output_dir/BipSampPTuginUtil.o

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT -Ae \
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
-c Common.c \
-0 output_dir/Common.o
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cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT -Ae \
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
-c NodeFactory.c \
-0 output_dir/NodeFactory.o

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT -Ae \
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
-c SwitchNode.c \
-0 output_dir/SwitchNode.o

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT -Ae \
-1 A
-I/install_dir/include \
-I/install_dir/include/plugin \
-c TransformNode.c \
-0 output_dir/TransformNode.o

1d -b \
-0 output_dir/SwitchNode.1i1 \
output_dir/BipSampPluginUtil.o \
output_dir/Common.o \
output_dir/NodeFactory.o \
output_dir/SwitchNode.o \
output_dir/TransformNode.o \
-L install_dir/1ib \
-L install_dir/xml4c/1ib \
-L install_dir/merant/1ib \
-L install_dir/jre/1ib/IA64N\
-L install_dir/jre/1ib/IA64N/server \
-1 imbdfplg

chmod a+r output dir/SwitchNode.111
Compiling on Linux:

When you compile a user-defined extension that is written in C, use a supported
compiler.

To determine the 32-bit or 64-bit linkage that is required for an execution group
created in a broker on your specific operating system, see [Support for 32-bit and|
[64-bit platforms|

When you compile programs on Linux on POWER", replace the option -fpic with
-fPIC if you want to use dynamic linking and avoid any limit on the size of the
global offset table.

The following instructions are for compiling an extension for a 64-bit execution

group on Linux on POWER and Linux on System z°.

* To compile the extension for a 64-bit execution group on Linux on x86-64,
replace -Timbdfplg with -1imbdfp1g64 in the link example.

* To compile the extension for a 32-bit execution group on Linux on x86, replace
-m64 with -m32 in the compile and link examples.

gcc -c -m64 -ansi -Wall -Wno-format-y2k -fpic \
-1\
-1/install _dir/include \
-1/install_dir/include/plugin \
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- DLINUX -D_THREADS -D_POSIX PTHREAD SEMANTICS -D_REENTRANT \
TransformNode.c

gcc -c -m64 -ansi -Wall -Wno-format-y2k -fpic \
-1\
-1/install_dir/include \
-I/install_dir/include/plugin \
- DLINUX -D_THREADS -D_POSIX PTHREAD SEMANTICS -D_REENTRANT \
SwitchNode.c

gcc -c -m64 -ansi -Wall -Wno-format-y2k -fpic \
-1\
-1/install_dir/include \
-I/install_dir/include/plugin \
- DLINUX -D_THREADS -D_POSIX PTHREAD SEMANTICS -D_REENTRANT \
BipSampPluginUtil.c

gcc -c -m64 -ansi -Wall -Wno-format-y2k -fpic \
-1\
-1/install_dir/include \
-I/install_dir/include/plugin \
- DLINUX -D_THREADS -D_POSIX PTHREAD SEMANTICS -D_REENTRANT \
Common.c

gcc -c -m64 -ansi -Wall -Wno-format-y2k -fpic \
-1.0\
-I/install_dir/include \
-I/install_dir/include/plugin \
- DLINUX -D_THREADS -D_POSIX PTHREAD SEMANTICS -D_REENTRANT \
NodeFactory.c

gcc -m64 -o samples.lil \
TransformNode.o \
SwitchNode.o \
BipSampPluginUtil.o \
Common.o NodeFactory.o \
-shared -1c -Ins1 -1d1 \
-L/install_dir/1ib -Timbdfplg

These commands create the file samples.lil that provides TransformNode and
SwitchNode objects.

Compiling on Solaris:

When you compile a user-defined extension that is written in C, use a supported
compiler.

To determine the 32-bit or 64-bit linkage that is required for an execution group
created in a broker on your Solaris operating system, see [Support for 32-bit and]
[64-bit platforms|

The following instructions are for compiling an extension for a 64-bit execution
group on Solaris on SPARC.

* To compile the extension for a default 64-bit execution group on Solaris on
x86-64, replace -xarch=v9 with -xarch=amd64 in the compile examples.

* To compile the extension for a 32-bit execution group on Solaris on SPARC:
— Replace -xarch=v9 with -xarch=v8plus in the compile examples.
— Replace -1 imddfp1g64 with -1 imddfplg in the link example.

cc -xarch=v9 -mt \
-1\
-I/install_dir/include \
-1/install_dir/include/plugin \
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-c SwitchNode.c \
-0 output_dir/SwitchNode.o

cc -xarch=v9 -mt \
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
-c BipSampPluginUtil.c \
-0 output_dir/BipSampPTuginUtil.o

cc -xarch=v9 -mt \
-1.\
-1/install_dir/include \
-I/install_dir/include/plugin \
-c NodeFactory.c \
-0 output_dir/NodeFactory.o

cc -xarch=v9 -mt \
-1\
-1/install_dir/include \
-I/install_dir/include/plugin \
-c Common.c \
-0 output_dir/Common.o

cc -xarch=v9 -xcode=pic32 -mt -G \

-0 output_dir/SwitchNode.1i1 \
output_dir/SwitchNode.o \
output_dir/BipSampPluginUtil.o \
output_dir/NodeFactory.o \
output_dir/Common.o \

-L /install dir/1ib \

-1 imbdfplg64

chmod a+r output_dir/SwitchNode.111
Compiling on Windows:

When you compile a user-defined extension that is written in C, use a supported
compiler.

Ensure that you include a space between SwitchNode.c and BipSampPTluginUtil.c,
and also between -Tink and /DLL.

Enter the command as a single line of input; in the following example the lines
have been split to improve readability.
cl /VERBOSE /LD /MD /Zi /GX /I.

/linstall_dir\include\plugin

SwitchNode.c BipSampPTuginUtil.c Common.c

NodeFactory.c TransformNode.c

-link /DLL install_dir\1ib\imbdfplg.lib

/O0UT:SwitchNode.11i1

If you have correctly set the LIB environment variable, you do not have to specify
the full paths to the LIB files.

Compiling on z/OS:

When you compile a user-defined extension that is written in C, use a supported
compiler.

Force your link to use prelinker or linker by setting the _CC_STEPS variable to -1:
export _CC_STEPS=-1
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Alternatively, add these two lines to your makefile to export it:

_CC_STEPS=-1
.EXPORT : _CC_STEPS

To create optimized builds, use -2 in place of -g in the following commands:

cc -c \

-Wc,DLL -g -WO,Tong,langlv1\(extended\),EXPORTALL,float\(ieee\) \
-We,xplink \

-WO,LIST\(./SwitchNode.Tst\) \

-1. -I${install_dir}/include \

-1${install_dir}/include/plugin \

-I${install dir}/sample/include \

-1${install_dir}/sample/plugin \

-0 ./SwitchNode.o ./SwitchNode.c

cc -c \
-Wc,DLL -g -WO,long,langlv1\(extended\),EXPORTALL,float\ (ieee\) \
-Wc,xplink \
-WO,LIST\(./SwitchNode.Tst\) \
-1. -I${install_dir}/include \
-1${install_dir}/include/plugin \
-1${install _dir}/sample/include \
-1${install_dir}/sample/plugin \
-0 ./BipSampPluginUtil.o ./BipSampPluginUtil.c

cc -c \
-Wc,DLL -g -WO,long,langlv1\(extended\),EXPORTALL,float\ (ieee\) \
-Wc,xplink \
-WO,LIST\(./SwitchNode.1st\) \
-1. -I${install_dir}/include \
-I${install_dir}/include/plugin \
-1${install dir}/sample/include \
-1${install_dir}/sample/plugin \
-0 ./Common.o ./Common.c

cc -c \

-Wc,DLL -g -WO,long,Tanglv1\(extended\),EXPORTALL, float\(ieee\) \
-Wc,xplink \

-WO,LIST\(./SwitchNode.1st\) \

-1. -1${install_dir}/include \

-1${install _dir}/include/plugin \

-1${install dir}/sample/include \

-1${install_dir}/sample/plugin \

-0 ./NodeFactory.o ./NodeFactory.c

cc \
-W1,DLL -g -W1,p,map -W1,LIST=ALL,MAP,XREF,REUS=RENT \
-W1,xplink \
-0 ./SwitchNode.1i1 ./SwitchNode.o ./BipSampPluginUtil.o \
./Common.o ./NodeFactory.o \
${install dir}/1ib/1ibimbdfplg.x

Issue the following command to set the file permissions of the user-defined
extension to group read and to be executable:

chmod a+rx {output_dir}/SwitchNode.111
Creating a user-defined extension in Java:

Complete one or more of the following steps to create user-defined nodes in Java:

s |“Creating an input node in Java” on page 59|

+ [“Creating a message processing or output node in Java” on page 64|

* |“Compiling a Java user-defined node” on page 73|

+ [“Packaging a Java user-defined node” on page 101|
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You can write only user-defined nodes in Java: user-defined parsers must be
written in C.

When you have completed this set of tasks, continue with the following tasks:

+ [“Creating the user interface representation of a user-defined node in thel
workbench” on page 75|

+ [“Testing a user-defined node” on page 83|

» |“Packaging and distributing user-defined extensions” on page 100

Restrictions when creating Java nodes:

In Java user-defined nodes and the JavaCompute node, calling the System.exit(...)
method is not supported. Calling this method results in a SecurityException.

Creating an input node in Java:

An input node is used to receive a message into a message flow, typically from a
source that is not supported by the built-in input nodes.

Before you start

Read the following topics:

* [“'Why use a user-defined extension?” on page 4|

+ [“User-defined input nodes” on page 12|

To create an input node in the Java language:

1. [“Creating a new Java project’]

2. [“Declaring the input node class” on page 60|

[‘Defining the node constructor” on page 60|

[‘Receiving external data into a buffer” on page 60|

[‘Propagating the message” on page 61|

[Controlling threading and transactionality” on page 61

[‘Declaring the node name” on page 62|

[‘Declaring attributes” on page 63|

[‘Implementing the node functionality” on page 63|

[‘Overriding default message parser attributes (optional)” on page 63|
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[‘Deleting an instance of the node” on page 64|

A Java user-defined node is distributed as a jar file.
Creating a new Java project:
Before you can create Java nodes in the workbench, you must create a new Java

project:
1. Switch to the Java perspective.

2. Click File » New > Project. Select Java from the left menu, and then select Java

Project from the right menu.

Give the project a name. The Java Settings panel is displayed.
Select the Libraries tab, and click Add External JARs.

Select install_dir\classes\jplugin2.jar

oo bk~ w

Follow the prompts on the other tabs to define any other build settings.
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7. Click Finish.

You can now develop the source for your Java node in this project.

Declaring the input node class:

Any class that implements MbInputNodelnterface and is contained in the broker’s
LIL path is registered with the broker as an input node. When you implement
MbInputNodelnterface, you also need to implement a run method for this class.
The run method represents the start of the message flow, contains the data that
formulates the message, and propagates it down the flow. The broker calls the run
method when threads become available in accordance with your specified
threading model.

For example, to declare the input node class:
package com.ibm.jplugins;

import com.ibm.broker.plugin.=*;

public class BasicInputNode extends MbInputNode implements MbInputNodeInterface

{

Follow these steps to complete this action in the workbench:

1. Click File > New » Class.

Set the package and class name fields to appropriate values.

Delete the text in the Superclass text field and click the Browse button.
Select MbInputNode.

Click the Add button next to Interfaces text field, and select
MbInputNodelnterface.

6. Click Finish.

o k0N

Defining the node constructor:

When the node is instantiated, the constructor of the user’s node class is called.
This class is where you create the terminals of the node, and initialize any default
values for the attributes.

An input node has a number of output terminals associated with it, but does not
typically have any input terminals. Use the createOutputTerminal method to add
output terminals to a node when the node is instantiated. For example, to create a
node with three output terminals:

public BasicInputNode() throws MbException

{

createQutputTerminal ("out");
createQutputTerminal ("failure");
createQutputTerminal ("catch");

setAttribute ("firstParserClassName","myParser");
attributeVariable = "none";

}

Receiving external data into a buffer:
An input node can receive data from any type of external source, such as a file

system, a queue, or a database, in the same way as any other Java program,
provided that the output from the node is in the correct format.
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Provide an input buffer (or bit stream) to contain input data, and associate it with
a message object. Create a message from a byte array using the createMessage
method of the MbInputNode class, and then generate a valid message assembly
from this message. For example, to read the input from a file:

1. Create an input stream to read from the file:
FileInputStream inputStream = new FilelnputStream("myfile.msg");
2. Create a byte array the size of the input file:
byte[] buffer = new byte[inputStream.available()];
3. Read from the file into the byte array:
inputStream.read(buffer);
4. Close the input stream:
inputStream.close();
5. Create a message to put on the queue:
MbMessage msg = createMessage(buffer);
6. Create a new message assembly to hold this message:

msg.finalizeMessage (MbMessage.FINALIZE VALIDATE);
MbMessageAssembly newAssembly =
new MbMessageAssembly(assembly, msg);

Propagating the message:

When you have created a message assembly, you can propagate it to one of the
node’s output terminals.

For example, to propagate the message assembly to the terminal named out:

MbOutputTerminal out = getOutputTerminal("out");
out.propagate(newAssembly);

To delete the message:

msg.clearMessage();

To clear the memory that is allocated for the message tree, call the clearMessage()
function within the finally block oftry/catch.

Controlling threading and transactionality:

The broker infrastructure handles transaction issues such as controlling the commit
of any WebSphere MQ or database unit of work when message processing has
completed. However, resources modified from within a user-defined node are not
necessarily under the transactional control of the broker.

Each message flow thread is allocated from a pool of threads maintained for each
message flow, and starts in the run method.

The user-defined node uses return values to indicate whether a transaction has
been successful, to control whether transactions are committed or rolled back, and
to control when the thread is returned to the pool. The broker infrastructure
catches any unhandled exceptions, and rolls back the transaction.

You determine the behavior of transactions and threads using the appropriate
return value:
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MbInputNode.SUCCESS_CONTINUE
The transaction is committed and the broker calls the run method again
using the same thread.

MbInputNode.SUCCESS_RETURN
The transaction is committed and the thread is returned to the thread pool,
assuming that it is not the only thread for this message flow.

MbInputNode.FAILURE_CONTINUE
The transaction is rolled back and the broker calls the run method again
using the same thread.

MbInputNode.FAILURE_RETURN
The transaction is rolled back and the thread is returned to the thread pool,
assuming that it is not the only thread for this message flow.

MbInputNode. TIMEOUT
The run method must not block indefinitely while waiting for input data to
arrive. While the flow is blocked by user code, you cannot shutdown or
reconfigure the broker. The run method must yield control to the broker
periodically by returning from the run method. If input data has not been
received after a certain period (for example, 5 seconds), the method should
return with the TIMEOUT return code. Assuming that the broker does not
need to reconfigure or shutdown, the input node’s run method gets called
again straight away.

To create multithreaded message flows, you call the dispatchThread method after a
message has been created, but before the message is propagated to an output
terminal. This action ensures that only one thread is waiting for data while other
threads are processing the message. New threads are obtained from the thread
pool up to the maximum limit specified by the Additional Instances property of
the message flow. For example:

public int run( MbMessageAssembly assembly ) throws MbException

{
byte[] data = getDataWithTimeout(); // user supplied method
// returns null if timeout
if( data == null )
return TIMEOUT;

MbMessage msg = createMessage( data );
msg.finalizeMessage( MbMessage.FINALIZE VALIDATE );
MbMessageAssembly newAssembly =

new MbMessageAssembly( assembly, msg );

dispatchThread();
getOutputTerminal( "out" ).propagate( newAssembly );

return SUCCESS_RETURN;

Declaring the node name:

You must declare the name of the node for use and identification by the
workbench. All node names must end with the characters "Node". Declare the
name using the following method:

public static String getNodeName()
{

return "BasicInputNode";

}
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If this method is not declared, the Java API framework creates a default node
name using the following rules:

* The class name is appended to the package name.

* The periods are removed, and the first letter of each part of the package and
class name is capitalized.

For example, by default, the following class is assigned the node name
"ComIbmPluginsamplesBasicInputNode":
package com.ibm.pluginsamples;

public class BasicInputNode extends MbInputNode implements MbInputNodeInterface
{

Declaring attributes:

Declare node attributes using the same method that you use for Java bean
properties. You are responsible for writing get and set methods for the attributes;
the API framework infers the attribute names using the Java bean introspection
rules. For example, if you declare the following two methods:

private String attributeVariable;

public String getFirstAttribute()
{

return attributeVariable;

}

publc void setFirstAttribute(String value)
{

attributeVariable = value;

}

The broker infers that this node has an attribute called firstAttribute. This name is
derived from the names of the get or set methods, not from the variable names of
any internal class members. Attributes can be exposed only as strings, so convert
any numeric types to and from strings in the get or set methods. For example, the
following method defines an attribute called timeInSeconds:

int seconds;

public String getTimeInSeconds()
{

return Integer.toString(seconds);

}

public void setTimeInSeconds(String value)

{

seconds = Integer.parselnt(value);

}

Implementing the node functionality:

As already described, the run method is called by the broker to create the input
message. This method should provide all the processing function for the input
node.

Overriding default message parser attributes (optional):

An input node implementation normally determines which message parser initially

parses an input message. For example, the built-in MQInput node dictates that an
MQMD parser is required to parse the MQMD header. A user-defined input node
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can select an appropriate header or message parser, and the mode in which the
parsing is controlled, by using the following default attributes that are included,
which you can override:

rootParserClassName
Defines the name of the root parser that parses message formats supported
by the user-defined input node. It defaults to GenericRoot, a supplied root
parser that causes the broker to allocate and chain parsers together. It is
unlikely that a node would need to modify this attribute value.

firstParserClassName
Defines the name of the first parser, in what might be a chain of parsers
that are responsible for parsing the bitstream. It defaults to XML.

messageDomainProperty
An optional attribute that defines the name of the message parser required
to parse the input message. The supported values are the same as those
supported by the MQInput node.

messageSetProperty
An optional attribute that defines the message set identifier, or the message
set name, in the Message Set field, only if the MRM parser was specified
by the messageDomainProperty attribute.

messageTypeProperty
An optional attribute that defines the identifier of the message in the
MessageType field, only if the MRM parser was specified by the
messageDomainProperty attribute.

messageFormatProperty
An optional attribute that defines the format of the message in the Message
Format field, only if the MRM parser was specified by the
messageDomainProperty attribute.

Deleting an instance of the node:

An instance of the node is deleted when either:

* You shut down the broker.

* You remove the node or the message flow containing the node, and redeploy the
configuration.

When the node is deleted, it can perform any cleanup operations, such as closing
sockets, if it implements the optional onDelete method. This method, if present, is
called by the broker just before the node is deleted.

Implement the onDelete method as follows:

public void onDelete()
{

// perform node cleanup if necessary

}

Creating a message processing or output node in Java:

A message processing node is used to process a message, and an output node is
used to output a message as a bit stream.

Before you start

Read the following topics:
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+ [“Why use a user-defined extension?” on page 4|

[“User-defined message processing nodes” on page 17|

[“User-defined output nodes” on page 24|

* [“Restrictions when creating Java nodes” on page 59|

WebSphere Message Broker provides the source for two sample user-defined nodes
called SwitchNode and TransformNode. You can use these nodes in their current
state, or you can modify them.

When you code a message processing node or an output node, the two types
provide essentially the same functions. You can perform message processing within
an output node, and likewise you can propagate an output message to a bit stream
from a message processing node. For simplicity, this topic refers mainly to the
node as a message processing node, but it does discuss the functionality of both
types of node.

Complete the following steps:

1. [“Creating a new Java project”|

2. ['Declaring the message processing node class’|

[‘Defining the node constructor” on page 66|

[“Accessing message data” on page 66|

[“Transforming a message object” on page 67]

[“Propagating the message” on page 68|

[‘Declaring the node name” on page 68|

[‘Declaring attributes” on page 68|

[“Implementing the node functionality” on page 69|
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[‘Deleting an instance of the node” on page 70|

A Java user-defined node is distributed as a .jar file.
Creating a new Java project:

Before you can create Java nodes in the workbench, you must create a new Java
project:
1. Switch to the Java perspective.

2. Click File » New > Project. Select Java from the left menu, and then select Java
Project from the right menu.

3. Give the project a name.

The Java Settings panel is displayed.

Select the Libraries tab, and click Add External JARs.

Select install_dir\classes\jplugin2 jar.

Follow the prompts on the other tabs to define any other build settings.
Click Finish.

N o~

You can now develop the source for your Java node within this project.
Declaring the message processing node class:

Any class that implements MbNodelnterface, and is contained in the broker’s LIL
path, is registered with the broker as a message processing node. When you
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implement MbNodelnterface, you must also implement an evaluate method for
this class. The evaluate method is called by the broker for each message that passes
through the flow.

For example, to declare the message processing node class:
package com.ibm.jplugins;

import com.ibm.broker.plugin.*;

public class BasicNode extends MbNode implements MbNodeInterface

Declare the class in the workbench:

Click File » New - Class.

Set the package and class name fields to appropriate values.

Delete the text in the Superclass text field and click Browse.

Select MbNode and click OK.

Click the Add button next to Interfaces text field, and select MbNodelInterface.
Click Finish.

ook wNn =

Defining the node constructor:

When the node is instantiated, the constructor of the user’s node class is called.
Create the terminals of the node, and initialize any default values for attributes in
this constructor.

A message processing node has a number of input terminals and output terminals
that are associated with it. Use the methods createInputTerminal and
createOutputTerminal to add terminals to a node when the node is instantiated.

For example, to create a node with one input terminal and two output terminals:
public MyNode() throws MbException
{

// create terminals here
createlnputTerminal ("in");
createQutputTerminal ("out");
createQutputTerminal ("failure");

}

Accessing message data:

In many cases, the user-defined node needs to access the contents of the message
received on its input terminal. The message is represented as a tree of syntax
elements. Use the supplied utility function to evaluate methods for message
management, message buffer access, syntax element navigation, and syntax
element access.

The MbElement class provides the interface to the syntax elements.

For example:
1. To navigate to the relevant syntax element in the XML message:

MbElement rootElement = assembly.getMessage().getRootElement();
MbElement switchElement =
rootElement.getLastChild().getFirstChild().getFirstChild();

2. To select the terminal indicated by the value of this element:
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String terminalName;

String elementValue = (String)switchElement.getValue();

if(elementValue.equals("add"))
terminalName = "add";

else if(elementValue.equals("change"))
terminalName = "change";

else if(elementValue.equals("delete"))
terminalName = "delete";

else if(elementValue.equals("hold"))
terminalName = "hold";

else
terminalName = "failure";

MbOutputTerminal out = getOutputTerminal(terminalName);
Transforming a message object:

The received input message is read-only, so before you can transform a message,
you must write it to a new output message. You can copy elements from the input
message, or you can create new elements in the output message.

The MbMessage class provides the copy constructors, and the methods to get the
root element of the message. The MbElement class provides the interface to the
syntax elements.

For example, if you have an incoming message assembly with embedded
messages, you could have the following code in the evaluate method of your
user-defined node:

1. To create a new copy of the message assembly and its embedded messages:

MbMessage newMsg = new MbMessage(assembly.getMessage());
MbMessageAssembly newAssembly = new MbMessageAssembly(assembly, newMsg);

2. To navigate to the relevant syntax element in the XML message:

MbElement rootElement = newAssembly.getMessage().getRootElement();
MbElement switchElement =
rootElement.getFirstElementByPath("/XML/data/action");

3. To change the value of an existing element:

String elementValue = (String)switchElement.getValue();

if(elementValue.equals("add"))
switchElement.setValue("change");

else if(elementValue.equals("change"))
switchElement.setValue("delete");

else if(elementValue.equals("delete"))
switchElement.setValue("hold");

else
switchElement.setValue("failure");

4. To add a new tag as a child of the switch tag:

MbElement tag = switchElement.createElementAsLastChild(MbETement.TYPE_NAME,
"PreviousValue",
elementValue);

5. To add an attribute to this new tag:

tag.createElementAsFirstChild(MbETement .TYPE_NAME_VALUE,
"NewValue",
switchElement.getValue());

MbOutputTerminal out = getOutputTerminal("out");
As part of the transformation, you might need to create a new message body. To
create a new message body, use one of the following methods, which specifically

assigns a parser to a message tree folder:
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createElementAfter(String)

createElementAsFirstChild(String)

createElementAsLastChild(String)

createElementBefore(String)

createElementAsLastChildFromBitstream(byte[], String, String, String, String, int, int, int)

Do not use the following methods, which do not associate an owning parser with
the folder:

createElementAfter(int)
createElementAfter(int, String, Object)
createETementAsFirstChild(int)
createElementAsFirstChild(int, String, Object)
createElementAsLastChild(int)
createElementAsLastChild(int, String, Object)
createElementBefore(int)
createElementBefore(int, String, Object)

Propagating the message:

Before you propagate a message, decide what message flow data you want to
propagate, and whether to propagate to a node terminal, or to a Label node.

For example:
1. To propagate the message to the output terminal "out":

MbOutputTerminal out = getOutputTerminal("out");
out.propagate(newAssembly);

2. To propagate the message to a Label node:

MbRoute labell = getRoute ("Tabell");
Labell.propagate(newAssembly);

Call the clearMessage() function within the finally block of try/catch to clear the
memory that is allocated for the message tree.

Declaring the node name:

The name of the node must be the same as the one that is used in the workbench.
All node names must end with "Node”. Declare the name using the following
method:

public static String getNodeName()
{

}

return "BasicNode";

If this method is not declared, the Java API framework creates a default node
name using the following rules:

¢ The class name is appended to the package name.

* The dots are removed, and the first letter of each part of the package and class
name are capitalized.

For example, by default, the following class is assigned the node name

"ComIbmPluginsamplesBasicNode":

package com.ibm.pluginsamples;
public class BasicNode extends MbNode implements MbNodeInterface

{

Declaring attributes:
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Declare node attributes in the same way as Java Bean properties. You must write
getter and setter methods for the attributes. The API framework infers the attribute
names using the Java Bean introspection rules. For example, if you declare the
following two methods:

private String attributeVariable;

public String getFirstAttribute()
{

return attributeVariable;

}

publc void setFirstAttribute(String value)
{

attributeVariable = value;

}

the broker infers that this node has an attribute called firstAttribute. This name is
derived from the names of the get or set methods, not from any internal class
member variable names. Attributes can only be exposed as strings, therefore, you
must convert any numeric types to and from strings in the get or set methods. For
example, the following method defines an attribute called timeInSeconds:

int seconds;

public String getTimeInSeconds ()
{

return Integer.toString(seconds);

}

public void setTimeInSeconds(String value)

{

seconds = Integer.parselnt(value);

}

Implementing the node functionality:

The evaluate method, defined in MbNodelnterface, is called by the broker to
process the message. All the processing function for the node is included in this
method.

The evaluate method has two parameters that are passed in by the broker:

1. The MbMessageAssembly, which contains the following objects that are
accessed using the appropriate methods:

* The incoming message
¢ The LocalEnvironment
* The global Environment
* The ExceptionList
2. The input terminal on which the message has arrived.
For example, the following code extract shows how you might write the evaluate
method:
public void evaluate(MbMessageAssembly assembly, MbInputTerminal inTerm) throws MbException

// add message processing code here

getOutputTerminal ("out").propagate(assembly);
}

The message flow data, which consists of the message, Environment,
LocalEnvironment, and ExceptionList, is received at the input terminal of the node.
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Deleting an instance of the node:

An instance of the node is deleted when either:

* You shut down the broker.

* You remove the node or the message flow that contains the node, and redeploy
the configuration.

If you want the node to perform any clean up operations, for example closing

sockets, include an implementation of the onDelete method:

public void onDelete()
{

// perform node cleanup if necessary

}
This method is called by the broker immediately before it deletes the node.
Extending the capability of a Java message processing or output node:

Within a message processing or output node, you can add extended functions to
your Java node.

Before you start

Read [“Creating a message processing or output node in Java” on page 64

You can add one or more of the following functions:
* |“Accessing ESQL”]
* |“Interacting with databases” on page 71|

+ “Handling exceptions” on page 71|

+ [“Writing to an output device” on page 72|

Accessing ESQL:

Nodes can invoke ESQL expressions using Compute node ESQL syntax. You can
create and modify the components of the message using ESQL expressions, and
you can refer to elements of both the input message and data from an external
database.

The following procedure demonstrates how to use ESQL to control transactions
from the evaluate method in your user-defined node:
1. Set the name of the ODBC data source to use. For example:
String dataSourceName = "myDataSource";
2. Set the ESQL statement to run:

String statement =
"SET OQutputRoot.XMLNS.data =
(SELECT Field2 FROM Database.Tablel WHERE Fieldl = 1);";

Or, if you want to run a statement that returns no result:

String statement = "PASSTHRU(
"INSERT INTO Database.Tablel VALUES(
InputRoot.XMLNS.DataFieldl,
InputRoot.XMLNS.DataField2)');";

3. Select the type of transaction you want from the following:
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MbSQLStatement.SQL_TRANSACTION_COMMIT
Immediately commit the transaction after the ESQL statement has
completed.

MbSQLStatement.SQL_TRANSACTION_AUTO
Commit the transaction when the message flow has completed.
(Rollbacks are performed if necessary.)

For example:
int transactionType = MbSQLStatement.SQL_TRANSACTION_AUTO;
Get the ESQL statement. For example:

MbSQLStatement sql =
createSQLStatement (dataSourceName, statement, transactionType);

You can use the method createSQLStatement(dataSource, statement to default
the transaction type to MbSQLStatement. SQL_TRANSACTION_AUTO).

Create the new message assembly to be propagated:

MbMessageAssembly newAssembly =
new MbMessageAssembly(assembly, assembly.getMessage());

Run the ESQL statement:

sql.select(assembly, newAssembly);

Or, if you want to run an ESQL statement that returns no result:
sql.execute(assembly);

Interacting with databases:

You can interact with databases from the Java code in your message processing
node. The support that is provided is identical to the support for Java code that
you write for the JavaCompute node; for details of the available options, and the
advantages and restrictions that apply, see [[nteracting with databases using the|

avaCompute nod
p

Handling exceptions:

Use the MbException class to catch and access exceptions. The MbException class
returns an array of exception objects that represent the children of an exception in
the broker exception list. Each element returned specifies its exception type. An
empty array is returned if an exception has no children. The following code sample
shows an example of how you could use the MbException class in the evaluate
method of your user-defined node.

public void evaluate(MbMessageAssembly assembly, MbInputTerminal inTerm) throws MbException

{

}

try
{

catch(MbException ex)

{

}

// plug-in functionality

traverse(ex, 0);

throw ex; // if re-throwing, it must be the original exception that was caught

void traverse(MbException ex, int Tevel)

{
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if(ex !'= null)
{
// Do whatever action here
System.out.printin("Level: " + level);
System.out.printin(ex.toString());
System.out.printin("traceText: " + ex.getTraceText());

// traverse the hierarchy

MbException e[] = ex.getNestedExceptions();
int size = e.length;

for(int i = 0; i < size; i++)

traverse(e[i], Tevel + 1);

}

You can develop a user-defined message-processing or output node in such a way
that it can access all current exceptions. For example, to catch database exceptions
you can use the MbSQLStatement class. This class sets the value of the
‘throwExceptionOnDatabaseError” attribute, which determines broker behavior
when it encounters a database error. When it is set to true, if an exception is
thrown it can be caught and handled by the evaluate method in your user-defined
extension.

The following code sample shows an example of how to use the MbSQLStatement
class.

public void evaluate(MbMessageAssembly assembly, MbInputTerminal inTerm) throws MbException

{

}

72

MbMessage newMsg = new MbMessage(assembly.getMessage());
MbMessageAssembly newAssembly = new MbMessageAssembly(assembly, newMsg);

String table =
assembly.getMessage() .getRootETement () .getLastChild().getFirstChild().getName();

MbSQLStatement state = createSQLStatement( "dbName",
"SET OutputRoot.XMLNS.integer[] = PASSTHRU('SELECT % FROM " + table + "');" );

state.setThrowExceptionOnDatabaseError(false);
state.setTreatWarningsAsErrors(true);

state.select( assembly, newAssembly );

int sqlCode = state.getSQLCode();
if(sqlCode != 0)
{

// Do error handling here

System.out.printin("sqlCode = " + sqlCode);
System.out.printin("sqINativeError = " + state.getSQLNativeError());
System.out.printin("sqlState = " + state.getSQLState());
System.out.printIn("sqlErrorText = " + state.getSQLErrorText());

}

getOutputTerminal ("out").propagate(newAssembly);

Writing to an output device:
To write to an output device, the logical (hierarchical) message must be converted

back into a bit stream in your evaluate method. Use the getBuffer method in
MbMessage to perform this task:
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public void evaluate( MbMessageAssembly assembly, MbInputTerminal in)
throws MbException
{

MbMessage msg = assembly.getMessage();
byte[] bitstream = msg.getBuffer();

// write the bitstream out somewhere
writeBitstream( bitstream ); // user method

}

Typically, for an output node the message is not propagated to any output
terminal, therefore you can just return at this point.

You must use the supplied MQInput node when writing to WebSphere MQ
queues, because the broker internally maintains a WebSphere MQ connection and
the open queue handles on a thread-by-thread basis. These handles are cached to
optimize performance. In addition, the broker handles exception scenarios when
certain WebSphere MQ events occur, and this recovery is adversely affected if
WebSphere MQ MQI calls are used in a user-defined output node.

Getting and setting the specific type of an Mb element:

Two methods are provided for handling the specific type of an Mb syntax element:
* getSpecificType
* setSpecificType

Use these methods to access or set the specific type of an XML element. For
example, to update the current value:

1. Call getSpecificType on the syntax element.
The getSpecificType method does not take any parameters, but returns the
specific type of the element as an int value.

2. Call setSpecificType on the syntax element.

The setSpecificType method takes one parameter of the type int, which is the
specific type that you want the Mb element to be. This method has no return
value.

Specific type values for the XML and MRM parsers are listed in [ XML, MRM, and|
[XMLNSC parser constants” on page 306

Compiling a Java user-defined node:

When you have created the code for yourJava user-defined node, you must
compile it for your operating system.

Before you start

You must have a user-defined node written in Java. This node can be one of the
provided sample nodes that are described in [“Sample node files” on page 119 or a
node that you have created yourself using the instructions in either [“Creating al
message processing or output node in Java” on page 64 or [“Creating an input node
in Java” on page 59|

You can compile a Java user-defined node either from the command line, or from
within the project in the workbench. Both options are described below.
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When you compile a Java user-defined node from the command line on any
platform, you need a compatible IBM Software Developer Kit for Java. For details
of supported Java versions, see [Additional software requirements|

Compiling a Java user-defined node from the workbench:

Use the following procedure to compile your Java user-defined node from the

workbench:

1. Switch to the Java Development Perspective.

2. In the Package Explorer, select the /src directory inside your node project, and
click File » Export.

3. From the list displayed, select JAR file. Click Next. The resources that are
available for you to export as a JAR file are listed.

4. Verify that Export generated class files and resources is checked.

5. Specify a name and location for your JAR file. Place the file inside the root

directory of your node project, and give the file the same name as the name of
the project (with a jar extension). You can use the default values for the rest of
the options. Click Finish.

The created jar file appears in your node project, and is ready for you to install in
a broker domain (see [“Installing user-defined extension runtime files on a broker”]

on page 104) or to package for distribution (see [‘Packaging a user-defined node

workbench project” on page 106).

Compiling a Java user-defined node from the command line:

Use the following procedure to compile your Java user-defined node from the
command line:

1.

Add the location of jplugin2.jar to the CLASSPATH. The location of the
jplugin2 jar file for each platform is shown below:

WIITEN install_dir\classes\jplugin2.jar

install_dir / classes/jplugin2.jar

install_dir / classes/jplugin2.jar

install_dir/ classes /jplugin2.jar

Put your Java user-defined node class into the following directory:
WIS install_dir\sample\extensions\nodes

install_dir /sample/extensions/nodes

install_dir /sample/extensions/nodes

install_dir /sample/extensions/nodes
Change to the directory that now contains your user-defined node class.
Compile the java file using the javac command, for example:

javac nodename.java

Package the resulting .class file into a .par file. See [“Packaging a Javal
[user-defined node” on page 101

The .par file that you have created is ready for you to install on a broker domain
(see [“Installing user-defined extension runtime files on a broker” on page 104) or
to package for distribution (see ["Packaging a user-defined node workbench|

[project” on page 106).
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Creating the user interface representation of a user-defined node in the
workbench:

When you are developing a user-defined node, you must create the user interface
representation of the node in the workbench.

Before you start:

¢ Perform the steps in [“Developing user-defined extensions” on page 3|

The following topics describe the steps that you must complete:

1. [“Creating a user-defined node project’]

2. [“Creating a user-defined node in the workbench” on page 76|

For user-defined parsers, just install the compiled .lil file. You do not manipulate
parsers from within the workbench and therefore you do not create a user interface
representation of user-defined parsers.

When you have created the workbench representation, [test your user-defined node}

Creating a user-defined node project:

When you create user-defined nodes, you must first create a user-defined node
project to contain the nodes and their supporting files.

To create a new project for your user-defined node, perform the following steps:
1. Switch to the Broker Application Development perspective.

2. Click File » New » Project, then Message Flow Node Development » Message
Flow Plug-in Node Project. Click Next to start the Message Flow Plug-in Node
Project wizard. The New Message Flow Plug-in Node Project window is
displayed.

3. Specify the name of the category for the nodes that you are creating. The node
appears under this category in the message flow node palette. Either choose the
name of an existing category, or enter a name to create a new category. Click
Next. The New Plug-in Project window is displayed.

4. Specify a name for your project. To be consistent with the supplied nodes, and
to avoid conflict with the names of node projects that are supplied by other
independent software vendors, use your organization’s Internet domain name
as part of the name. For example, the name should be of the form
com. xyz .nodegroup, where com.xyz is the company Internet domain name.

Do not enter a blank space or an underscore character in your project name.
These characters are not valid. You can save any number of nodes in a single
project.

If the Message Broker Toolkit is at a previous version, set the Eclipse version to
3.0 before you deploy this node plug-in project. You have now created a name
for your project. Click Next.

The Plug-in content panel of the New Plug-in Project window is displayed.

Ensure that the Plug-in ID field does not contain an underscore character. This
character is not valid.

5. Accept all default values and click Next. The Templates panel of the New
Plug-in Project window is displayed.

6. Click Finish.

7. If any warnings are displayed in the Tasks view that are associated with the
newly created project, perform the following steps:
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Click Window - Preferences.
Expand Plug-In Development and click Target Platform.
Click Add required Plug-ins to select all loaded plug-ins and click OK.

oo op

Select your user-defined node project in the Package Explorer view, and
click Project » Clean . A new dialog box appears in which you can select:

* Clean all projects, or

* Clean projects selected below. If you choose this option check the boxes
next to the projects that you want to clean.

A project folder containing all the supporting files that are needed for your
user-defined node is displayed in the Package Explorer view. The project is stored
in the default workspace directory.

Creating a user-defined node in the workbench:

Follow these steps to create the representation of a user-defined node in the
workbench.

Before you start:

[Create a user-defined node project]

To create the visual representation of your user-defined node in the workbench,
complete the following tasks:

—_

. |“Creating the user-defined node plug-in files”|

[‘Defining the node properties” on page 77|

Optional: [“Adding help to the node” on page 80|

Optional: [“Creating node icons” on page 81

A A

Optional: [“Adding a property editor or compiler” on page 82|

When you have created the node’s representation, you cannot move it to another
folder.

Creating the user-defined node plug-in files:

Before you start:

Complete the task [“Creating a user-defined node project” on page 75|

1. Switch to the Broker Application Development perspective.
2. Launch the wizard: click File > New » Other.... The New window opens.

3. Expand Message Flow Node Development and select Message Flow Plug-in
Node. Click Next. The New Message Flow Plug-in Node window opens.

4. Select the parent folder for the node from the list of names that are displayed.
This folder is the project that you have created to contain this node.

5. Specify a file name for the node. The file name must be the name of the node,
excluding the Node at the end. For example, if you have created a node called
BasicNode, the file name must be Basic.

6. Click Finish. A .msgnode file for the new node is created and is added to the
project in the Broker Development view. The .msgnode file is opened in the
message node editor.

Next:

76  User-defined Extensions



When you have completed this task, [define the node properties}

Defining the node properties:

Define the properties for a user-defined node, and add input and output terminals
so that you can connect it to other nodes in a message flow.

Before you start:
Complete the following tasks:

1. [“Creating a user-defined node project” on page 75|
2. |“Creating the user-defined node plug-in files” on page 76|

When you complete the task described in [‘Creating the user-defined node plug-in|
[files” on page 76|a .msgnode file is created for the new node, and is opened in the
Message Node editor of the Broker Application Development perspective. You can
now add terminals and properties to the node.

Adding terminals to the node:
1. If the Terminals page is not already displayed, click the Terminals tab at the
bottom of the Message Node editor.

2. Click Add to the right of the In Terminals or Out Terminals fields to add an
input or output terminal.

You must define at least one input terminal, but output terminals are optional.

3. To rename a terminal, click the terminal name so that it is highlighted and
shows a flashing cursor after the name, and enter a new name.

4. If your node supports dynamic input or output terminals, select the
appropriate check box.

Dynamic terminals are terminals that you can add to certain nodes after you
have added them to a message flow in the Message Flow editor. For more
information, see [Message flow node terminals}

Defining properties for the node:
1. Click the Properties tab at the bottom of the Message Node editor.

On the Properties page, you can set the node’s properties: for example, a
database name, a host server name, or a password. The properties that you set
here must match the properties that you specified in the user-defined node
itself using the get and set methods.

2. If the node is an input node, click the node name in the hierarchy to highlight
it, and select Input node. Select Use broker default values if you want the
node to initialize with the broker’s default values.

3. By default, all properties are grouped under the Basic group. You can add new
groups in which to place properties. When your custom node is selected in the
Message Broker Toolkit, each group of properties is rendered as a separate tab
in the Properties view. To create additional groups of properties, click Add

Property Group

4. To add a simple property, click the name of a property group in the hierarchy

E

to highlight it, and click Add Simple Property

Developing user-defined extensions 77



78  User-defined Extensions

The new property is added to the hierarchy as a child of the property group.

Its name is highlighted so that you can change it. A number of fields are

displayed in the Details section, where you can configure the property.

a. Select the correct attribute type: one of the built-in types, or a type to match
the list of values that the property can have.

b. Enter any default values, which are shown in the Properties view when the
node is included in a message flow.

. Specify the location of these resources in the relevant field to generate a
property editor or a compiler. Use the IPropertyEditor interface for your
property editor; see the [Property editor API|for more details.

d. Use the [PropertyCompiler interface to create a custom compiler; see the
[Property editor API| for more details.

e. Specify the system property for each attribute that you define:

Hidden
The property is not displayed in the Properties view or the Promote
Property dialog box.

Read only
The property is displayed, but cannot be changed.

Mandatory
A value is required. The field cannot be left blank. Boolean and
enum properties are always mandatory.

Configurable
The property can be configured at deployment time

To add a table property, select the name of a property group in the Properties

o]

view and click Add Table Property

In addition to simple properties, a node can also have complex properties. A
table property represents a repeating property of a complex type. The new
property is added to the hierarchy as a child of the property group. A number
of fields are displayed in the Details section where you can configure the table
property.

To add a column to an existing table, select the name of the table property in
the hierarchy, and click Add Simple Property

2

For example, the following figure shows the Property Hierarchy of the
usernode, where Filter and Route columns have been added.
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A number of fields are displayed in the Details section where you can configure
the properties of the column. Define table columns, where each column is
assigned to a type.

a.

Select the correct attribute type in the Type field: one of the built-in types,
or enumeration.

Enter the default value, in the Default Value field. This value is shown in
the Properties view when the node is included in a message flow.

Specify a qualified class name in the Custom Compiler Class field for a
property compiler. To create a custom compiler, use the
IColumnPropertyCompiler interface. For more information about custom
property editors and property compilers, see [“Adding a property editor o1
[compiler” on page 82|

Specify a qualified class name in the Custom Editor Class field to generate
a custom property editor. The property editor specified in this field
implements the IColumnPropertyEditor interface responsible for cell editing
behavior. Leaving the Custom Editor Class field blank means that a
property editor matching-column type is used. Specify your own
IColumnPropertyEditor only if you need custom cell editing behavior.

Specify the following attributes for each column that you define:

Hidden
This is a hidden column in the table. Use a hidden column when
you want to store, for each row, meta-data that is not being
displayed.

Read only
The column is displayed, but cannot be changed.

Mandatory
A value is required. The field cannot be left blank. Boolean and
enum properties are always mandatory.
Leave the Custom Editor Class field of the Details section of a table
property blank, unless you want to overwrite the behavior of the entire
table. (For example, if the table becomes disabled in response to a change in
another property editor).
Table properties are rendered as a table in the Properties view, where you
can add, edit, and delete values, and change the order of the values in the
table.
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7. Optional: Drag the properties in the properties hierarchy to change the order in
which they are listed on the properties page.

8. Close the nodename.msgnode file.

9. Optional: You can customize the text that appears in the node properties view
for each property. To set the text, open the nodename.properties file and edit the
line:

Property.propertyName = your descriptive text

Next:

The following tasks are optional:
* |“Adding help to the node”]
+ [“Creating node icons” on page 81

+ “Adding a property editor or compiler” on page 82|

You can now [test your node]

Adding help to the node:

Add help information for the node that you have created as an HTML file.
Before you start:

Complete the following tasks:

1. [“Creating a user-defined node project” on page 75|

2. ['Creating the user-defined node plug-in files” on page 76|

3. [“Defining the node properties” on page 77

Add help information for the node that you have created to explain why and
when to use the node, and how it must be configured:

* Topic information that is displayed within the information center.
* Context sensitive help that is displayed when you press F1.
* Hover help that is displayed when you hover your mouse over the node.

All three forms of help are optional; you can create any one or more of the three
resources described below.
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1. Create a help.html file within the project to contain the online help that
explains what the node does and how you can use it. If you have several files,
create a separate doc subdirectory in the plug-in project, and store the online
help files in that directory.

You can make the node’s online help appear integrated with the
product-supplied information center, under the leaf node called "User-defined
nodes”, which you can find in Reference > Message flows. To make the online
help for your node appear at that point:

a. Modify the plugin.xml file to include the following extension point to the
information center:
<extension point="org.eclipse.help.toc">
<toc file="toc.xml"/>
</extension>

b. Create a toc.xml file in your user-defined node project, and modify the
Tink_to attribute to link to the "UDNodes” anchor that is already defined in
the information center table of contents:
<toc Tabel="My Plugin Node" topic="my_node.htm"

Tink_to="../com.ibm.etools.mft.doc/toc.xml#UDNodes">

<topic label="Mytopic 1" href="topicl.htm>
</toc>

Your help topic is now displayed in the table of contents under Reference
Message flows » User-defined nodes.

The sample nodes that are provided with the product demonstrate this
option.
For further explanation of extension points and how to use them, see the

2. Add context sensitive (F1) help to the node. Context sensitive help is displayed
when you click on a node in the Broker Application Development perspective
and press F1.

When a node is created, a HelpContexts.xml file is created. This file assigns a
context id based on the name of the node. Modify the HelpContexts.xml file for
your node by changing the text in the description field. The name of the
HelpContexts.xml file must be unique within the project, but can contain
multiple context entries; for example, if you have several nodes within a single
project, each node can have its context-sensitive help in the file.
Context-sensitive help is limited in length. A useful way of providing more
help to the user is to link from the F1 help to an HTML file that contains
further information; for example, to the node’s online help, described above.
Code the link as shown below:
<topic href"../plug-in directory/html file" label="Link title">

3. Add hover help (known as ToolTip help on Windows) to the node. When you
create a user-defined node, a palette.properties file is created. Modify this file to
contain your node’s hover help, which shows the node name when the palette
is not wide enough to display it all.

You can add another optional feature, [a node icon|or [a property editor or compilerf

Creating node icons:

Create the icons that are displayed in the workbench when your node is present.

Before you start:
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You must complete the following tasks:

1. [“Creating a user-defined node project” on page 75|

2. [“Creating the user-defined node plug-in files” on page 76|

3. [“Defining the node properties” on page 77

When you create a node, a set of default icons are created for you; files clc16.gif
and obj16.gif are used for the node in the palette on the Broker Application
Development perspective, and obj30.gif is used for the node in the Message Flow
Editor (that is, when it is dragged into a message flow). To change the default
icons to your own icons, replace the supplied .gif files in the icons subdirectory of
the plug-in project by your files.

You can add another optional feature, |help| or la_property editor or compiler} or you

can [test your node

Adding a property editor or compiler:

Create a property editor by using the IPropertyEditor interface to control how the
properties of your node are displayed in the workbench. Create a custom compiler
by using the IPropertyCompiler interface; for example, to encrypt a value before
sending it to the server.

Before you start:

You must complete the following tasks:

1. [“Creating a user-defined node project” on page 75|

2. ['Creating the user-defined node plug-in files” on page 76|

3. [“Defining the node properties” on page 77

The IPropertyEditor interface is used as the basis for all the node property editors
in the workbench. You can customize the property editor to contain different kinds
of controls, such as text fields and lists. See the IPropertyEditor and
IPropertyCompiler interfaces in the [Property editor API|

Importing the plug-in API into the workbench:

To create a property editor or compiler, you must first import the plug-in API into
the workbench:

1. Click File » Import » External Plug-ins and Fragments.
Click Next.
Select the com.ibm.etools.mft.api plug-in.

PO

When the plug-in is imported in the workspace, right-click the plug-in, and
click Update Classpath.

Click Finish.
From the Window menu, click Preferences.
Expand Plug-in development and select Target Platform.

© N o O

Click Not in Workspace to select all plug-ins except the
com.ibm.etools.mft.api plug-in that you have just imported into the
workbench.

9. Click OK.
10. Switch to the Java perspective.
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11. Select your user-defined node project in the Package Explorer, and click
Project » Clean Project.

12. Right-click your user-defined node project, and click Update Classpath.
Creating a Java class:

To create a new Java class for your property editor or compiler, complete the
following steps.

1. Switch to the Java perspective.

2. Select your user-defined node project in the Package Explorer, and click Project
» Clean Project

3. Right-click your user-defined node project, and click Update Classpath...

4. In the user-defined node project, select the /src directory, and click File > New
> Class.

5. Type a name for your class in the Name text field.

6. Perform the following steps, according to whether you are creating a property
editor or a property compiler.

 If you are creating a property editor:
a. Delete any text in the Superclass text field, and click Browse....
b. Select the AbstractPropertyEditor class and click OK.
* If you are creating a property compiler:
a. Click Add next to the Interfaces text field.
b. Select the IPropertyCompiler interface and click OK.
7. Click Finish.

Testing your property editor or compiler:

To test your property editor, see [“Testing a user-defined node.”|

To test your property compiler, deploy to a broker the flow that contains your
user-defined node.

A custom property editor can use RAD or Eclipse APIs. When you migrate to a
new version of WebSphere Message Broker, your custom property editor might not
work if the RAD or Eclipse APIs change. Update your property editor code to
comply with the changed APL

Testing a user-defined node
When you have created and installed the required resources, you can test your
user-defined node.

Before you start

Complete the following tasks:

* |“Creating a user-defined extension in C” on page 35| or [“Creating a user-defined|
lextension in Java” on page 58|

+ [“Creating the user interface representation of a user-defined node in thel
workbench” on page 75|

* |“Installing user-defined extension runtime files on a broker” on page 104|

1. Click Run » Run, or click the arrow to the right of the Run icon ﬁ in the
toolbar and click Run. The Run dialog opens.
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Select Eclipse Application in the left pane, and click New above the left pane
(the icon at the left end). The configuration page is displayed for a new
configuration; the default name New_configuration is shown. Click Run to start
up a second toolkit instance.

Open the Message Flow editor. Your new nodes appear in the node palette.

Create a message flow that includes your node. Read [Adding a message flow]|
for guidance on how to complete this task.

Deploy the message flow to a broker. This task is described in
[message flow application}

Send a test message through the flow and look for the results that you expect
(for example, a message put to a target queue). You might have to write an
application to send the test message to the message flow.

Use the diagnostic tools that are provided to determine whether your node
works, or if not, what went wrong;:

a. See[Resolving problems with user-defined extensions| for a description of
some common problems and their solutions.

b. Check the event log. Details are provided in [Event Log editor]

c. Write entries to the event log from your node. See [“Using event logging]|
[from a user-defined extension” on page 113|for more information.

d. Switch on user trace at debug level. See for details of how to
complete this task.

The following debug messages are generated by a user trace to help you to
understand the execution of your user-defined nodes and parsers:

* BIP2233 and BIP2234: a pair of messages traced before and after a
user-defined extension implementation function is invoked. These
messages report the input parameters and the returned value.

In these messages, an "implementation function” can be interpreted as
either a C implementation function or a Java implementation method.

¢ BIP3904: a message traced before invoking the Java evaluate() method of
a user-defined node.

* BIP3905: a message traced before invoking the C cniEvaluate()
implementation function (iFpEvaluate member of CNI_VFT) of a
user-defined node.

* BIP4142: a debug message that is traced when invoking a user-defined
node utility function, where the utility function alters the state of a syntax
element. All utility functions that start with cniSetElement*, where *
represents all nodes with that stem, are included.

* BIP4144 and BIP4145: a pair of messages traced by certain
implementation functions that, when invoked by a user-defined
extension, can modify the internal state of a message broker’s object.
Possible broker objects include syntax element, node, and parser.

In these messages, an "implementation function” can be interpreted as
either a C implementation function or a Java implementation method.

* BIP4146: a debug message that is traced when invoking a user-defined
parser utility function, where the utility function alters the state of a
syntax element. All utility functions that start with cpiSetElement*, where
* represents all nodes with that stem, are included.

* BIP4147: an error message that is traced when a user-defined extension

passes an invalid input object to a user-defined extension utility API
function.



* BIP4148: an error message that is traced when a user-defined extension
damages a broker’s object.
* BIP4149: an error message that is traced when a user-defined extension

passes an invalid input data pointer to a user-defined extension utility
API function.

¢ BIP4150: an error message that is traced when a user-defined extension
passes invalid input data to a user-defined extension utility API function.

* BIP4151: a debug message that is traced when cniGetAttribute2 or
cniGetAttributeName?2 sets the return code to an unexpected value.
Expected values are CCI_SUCCESS, CCI_ATTRIBUTE_UNKNOWN, and
CCI_BUFFER_TOO_SMALL. Any other value is an unexpected value.

¢ BIP4152: a debug message that is traced in the following situations:

1) cniGetAttribute2 or cniGetAttributeName2 sets the return code to
CCI_BUFFER_TOO_SMALL.

2) cniGetAttribute2 or cniGetAttributeName?2 is called again with the
correct size buffer, however the return code is set to
CCI_BUFFER_TOO_SMALL.

e. Add a Trace node to your message flow, and check the output that is
generated.
f. Use the flow debugger to debug the flow that contains your node. Start with
[Testing and debugging message flow applications]

When your node behavior is complete and correct, add the new node into your
normal palette of nodes in the Message Flow editor (see [“Packaging a user-defined|
lnode workbench project” on page 106). Until you do this, the new nodes are
available only in your test workbench session on your local system.

Creating a user-defined parser

Create a user-defined parser to interpret messages with a different format and
structure.

Before you start

Read the following topics:

* [“Why use a user-defined extension?” on page 4|

+ [“User-defined parsers” on page 25|

A loadable implementation library, or a LIL, is the implementation module for a C
parser (or node). A LIL is a Linux or UNIX shared object or Windows dynamic link
library (DLL), that does not have the file extension .dll but .Iil.

The implementation functions that you have to write are listed in
[implementation functions” on page 195 The utility functions that are provided by
WebSihere Message Broker to help you are listed in [‘C parser utility functions” on|
page 196.

WebSphere Message Broker provides the source for a sample user-defined parser
called BipSampPluginParser.c. This example is a simple pseudo-XML parser that
you can use in its current state, or you can modify.

The task of writing a parser varies considerably according to the complexity of the
bit stream to be parsed. Only the basic steps are described here:

1. [“Declaring and defining the parser” on page 86|
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2. [“Creating an instance of the parser” on page 87

3. ['Deleting an instance of the parser” on page 8§|

Declaring and defining the parser

To declare and define a user-defined parser to the broker, you must include an
initialization function, bipGetParserFactory, in your LIL. The following steps
outline how the broker calls your initialization function and how your initialization
function declares and defines the user-defined parser:

The following procedure shows you how to declare and define your parser to the
broker:

1.
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The initialization function, bipGetParserFactory, is called by the broker after the
LIL has been loaded and initialized by the operating system. The broker calls
this function to understand what your LIL is able to do, and how it should be
called. For example:

CciFactory LilFactoryExportPrefix * LilFactoryExportSuffix

bipGetParserFactory()

The bipGetParserFactory function calls the utility function
cpiCreateParserFactory. This function passes back a unique factory name (or
group name) for all the parsers that your LIL supports. Every factory name (or
group name) passed back must be unique throughout all the LILs in the broker.

The LIL calls the utility function cpiDefineParserClass to pass the unique name
of each parser, and a virtual function table of the addresses of the
implementation functions.

For example, the following code declares and defines a single parser called
InputxParser:

{

CciFactory* factoryObject;

int rc = 0;

CciChar factoryName[] = L"MyParserFactory";
CCI_EXCEPTION_ST exception_st;

/* Create the Parser Factory for this parser =/
factoryObject = cpiCreateParserFactory(0, factoryName);
if (factoryObject == CCI_NULL_ADDR) {

/* Any local error handling can go here */

}

else {

/* Define the parsers supported by this factory */
static CNI_VFT vftable = {CNI_VFT_DEFAULT};

/* Setup function table with pointers to parser implementation functions */

vftable.iFpCreateContext = cpiCreateContext;
vftable.iFpParseBufferEncoded = cpiParseBufferEncoded;
vftable.iFpParseFirstChild = cpiParseFirstChild;
vftable.iFpParseLastChild = cpiParselLastChild;
vftable.iFpParsePreviousSibling = cpiParsePreviousSibling;
vftable.iFpParseNextSibling cpiParseNextSibling;

vftable.iFpWriteBufferEncoded
vftable.iFpDeleteContext
vftable.iFpSetETementValue
vftable.iFpETementValue
vftable.iFpNextParserClassName
vftable.iFpSetNextParserClassName
vftable.iFpNextParserEncoding
vftable.iFpNextParserCodedCharSetId

cpilriteBufferEncoded;
cpiDeleteContext;
cpiSetETementValue;
cpiElementValue;
cpiNextParserClassName;
cpiSetNextParserClassName;
cpiNextParserEncoding;
cpiNextParserCodedCharSetId;

cpiDefineParserClass(0, factoryObject, L"InputxParser", &vftable);



}

/* Return address of this factory object to the broker */
return(factoryObject);
}

The initialization function must create a parser factory by invoking

cpiCreateParserFactory. The parser classes supported by the factory are defined
by calling cpiDefineParserClass. The address of the factory object (returned by

cpiCreateParserFactory) must be returned to the broker as the return value
from the initialization function.

For example:
a. Create the parser factory using the cpiCreateParserFactory function:
factoryObject = cpiCreateParserFactory(&rc, constParserFactory);
b. Define the classes of message supported by the factory using the
cpiDefineParserClass function:

if (factoryObject) {
cpiDefineParserClass(&rc, factoryObject, constPXML, &vftable);
1

else {
/* Error: Unable to create parser factory =*/

}
€. Return the address of this factory object to the broker:

return(factoryObject);
}

Creating an instance of the parser

When the broker has received the table of function pointers, it calls the function
cpiCreateContext for each instantiation of the user-defined parser. If you have three
message flows that use your user-defined parser, your cpiCreateContext function is
called for each of them. This function should allocate memory for that instantiation
of the user-defined parser to hold the values for the configured attributes. For
example:

1.

Call the cpiCreateContext function:

CciContext* _createContext(
CciFactory* factoryObject,
CciChar= parserName,
CciNodex* parserObject

)

static char* functionName = (char *)" createContext()";
PARSER_CONTEXT_ST* p;
CciChar buffer[256];

Allocate a pointer to the local context and clear the context area:

p = (PARSER_CONTEXT_ST *)malloc(sizeof(PARSER_CONTEXT_ST));

it (p) {

memset(p, 0, sizeof (PARSER_CONTEXT_ST));
Save the parser object pointer in the context:
p->parserObject = parserObject;
Save the parser name:
CciCharNCpy((CciCharx)&p->parserName, parserName, MAX NODE_NAME_LEN);

Return the parser context:
return (CciContext*) p;
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Deleting an instance of the parser

Parsers are destroyed when a message flow is deleted or redeployed, or when the
execution group process is stopped (using the mgsistop command). When a parser
is destroyed, it must free any used memory and release any held resources using
the cpiDeleteContext function. For example:

void cpiDeleteContext(

CciParser* parser,
CciContext* context

PARSER_CONTEXT_ST* pc
int rc

(PARSER_CONTEXT_ST =*)context ;
0

return;

}

Extending the capability of a C user-defined parser
When you have created a C parser, you can extend its capability.

Before you start

Ensure that you have read and understood the following topic:

+ [“Creating a user-defined parser” on page 85|

You can extend the capability of a C parser in the following ways:

* [“Implementing the parser functionality”|

* |“Implementing input functions”

+ |“Implementing parse functions” on page 89|

+ “Implementing output functions” on page 90|

* |“Implementing a message header parser” on page 90|

Implementing the parser functionality:

A parser needs to implement the following types of implementation function:
1. Input functions
2. Parse functions

3. Output functions
Implementing input functions:

Your parser must implement one, and only one, of the following input functions:

» |“cpiParseBuffer” on page 225|

e [“cpiParseBufferEncoded” on page 226
P pag

* |“cpiParseBufferFormatted” on page 227

The broker invokes the input function when your user-defined parser is required to
parse an input message. The parser must tell the broker how much of the input
bitstream buffer that it claims to own. In the case of a fixed-size header, the parser
claims the size of the header. If the parser is intended to handle the whole
message, it claims the remainder of the buffer.

For example:
1. The broker invokes the cpiParseBufferEncoded input function:
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int cpiParseBufferEncoded(
CciParser* parser,
CciContext* context,
int encoding,
int ccsid

PARSER_CONTEXT ST* pc = (PARSER CONTEXT ST *)context ;
int recs
2. Get a pointer to the message buffer and set the offset using the cpiBufferPointer
utility function:
pc->iBuffer = (void *)cpiBufferPointer(&rc, parser);
pc->iIndex = 0;
3. Save the format of the buffer:
pc->iEncoding = encoding;
pc->iCcsid = ccsid;
4. Save the size of the buffer using the cpiBufferSize utility function:
pc->iSize = cpiBufferSize(&rc, parser);
5. Prime the first byte in the stream using the cpiBufferByte utility function:
pc->iCurrentCharacter = cpiBufferByte(&rc, parser, pc->ilndex);

6. Set the current element to the root element using the cpiRootElement utility
function:

pc->iCurrentElement = cpiRootElement (&rc, parser);
7. Reset the flag to ensure parsing is reset correctly:
pc->ilnTag = 0;
8. Claim ownership of the remainder of the buffer:
return(pc->iSize);

Implementing parse functions:

General parse functions (for example, cpiParseFirstChild) are those invoked by the
broker when the syntax element tree needs to be created in order to evaluate an
ESQL or Java expression. For example, a Filter node uses an ESQL field reference
in an ESQL expression. This field reference must be resolved in order to evaluate
the expression. Your parser’s general parse function is called, perhaps repeatedly,
until the requested element is either created, or is known by the parser not to exist.

For example:

void cpiParseFirstChild(
CciParserx parser,
CciContext* context,
CciElement* element

PARSER_CONTEXT_ST* pc = (PARSER_CONTEXT ST #)context ;
int rc;

if (('cpiElementCompleteNext(&rc, element)) &&
(cpiElementType(&rc, element) == CCI_ELEMENT_TYPE_NAME)) {

while ((!cpiElementCompleteNext(&rc, element)) &8
('cpiFirstChild(&rc, element)) &&
(pc->iCurrentElement))
{
pc->iCurrentElement = parseNextItem(parser, context, pc->iCurrentElement);
1
}
return;

}
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Implementing output functions:

Your parser must implement one, and only one, of the following output functions:

* [“cpiWriteBuffer” on page 247

* |“cpiWriteBufferEncoded” on page 248|

e [“cpiWriteBufferFormatted” on page 249
P pag

The broker invokes the output function when your user-defined parser is required
to serialize a syntax element tree to an output bit stream. For example, a Compute
node might have created a tree in the domain of your user-defined parser. When a
node, such as an MQOutput node, needs to serialize this tree, the parser is
responsible for appending the output bitstream buffer with data that represents the
tree that has been built.

For example:

int cpiWriteBufferEncoded(
CciParser* parser,
CciContext* context,
int encoding,
int ccsid
)
PARSER_CONTEXT_ST* pc = (PARSER_CONTEXT_ST =)context ;

int initialSize = 0;
int rc = 0;

const void* a;

CciByte b;

initialSize = cpiBufferSize(&rc, parser);
a = cpiBufferPointer(&rc, parser);
b = cpiBufferByte(&rc, parser, 0);

cpiAppendToBuffer(&rc, parser, (char x)"Some test data", 14);

return cpiBufferSize(0, parser) - initialSize;

}

Implementing a message header parser:

Typically, the incoming message data is of a single message format, therefore one
parser is responsible for parsing the entire contents of the message. The class name
of the parser that is needed is defined in the Format field in the MQMD or the
MQRFH?2 header of the input message.

However, the message might consist of multiple formats, for example where there
is a header in one format followed by data in another format. In this case, the first
parser has to identify the class name of the parser that is responsible for the next
format in the chain, and so on. In a user-defined parser, the implementation
function cpiNextParserClassName is invoked by the broker when it navigates
down a chain of parser classes for a message that is composed of multiple message
formats.

If your user-defined parser supports parsing a message format that is part of a
multiple message format, the user-defined parser must implement the

cpiNextParserClassName function.

For example:
1. Call the cpiNextParserClassName function:
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void cpiNextParserClassName (
CciParser* parser,
CciContext* context,
CciCharx* buffer,
int size

PARSER_CONTEXT_ST+* pc
int rc

(PARSER_CONTEXT_ST =*)context ;
03

2. Copy the name of the next parser class to the broker:

CciCharNCpy (buffer, pc->iNextParserClassName, size);

return;

}

Compiling a C user-defined extension
Compile user-defined extensions in C for all supported operating systems.

Before you start

If you create your own user-defined nodes, parsers, and user exits in C, compile
them on the operating system on which the target broker is running. Samples are
provided for both nodes and parsers, and are described in [“Sample node files” on|
[page 119|and [‘Sample parser files” on page 121|Use the instructions here to
compile the samples. If you want to create your own extensions, see the following
topics:

+ [“Creating a user-defined extension in C” on page 35|

+ |“Creating a user-defined parser” on page 85|

+ [“Creating a user-defined exit” on page 98

These instructions use the file names of the supplied samples. If you are compiling
your own user-defined extensions, substitute your own file names.

When you compile a user-defined extension that is written in C, you need a
compatible compiler. For details of supported compilers, see [Optional software]
‘

Header files:

The following header files define the C interfaces:
BipCni.h
Message processing nodes
BipCpi.h
Message parsers
BipCci.h
Interfaces common to both nodes and parsers

BipCos.h
Platform-specific definitions

Compiling:

Compile the source for your user-defined extension on each of the supported
operating systems to create the executable file that the broker calls to implement
your user-defined extension. On Linux, UNIX, and z/OS systems, this file is a
loadable implementation library file (LIL); on Windows systems, it is a dynamic
load library (DLL).
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The libraries that you build to contain user-defined nodes or parsers must have the
extension .lil on all operating systems so that the broker can load them. Libraries
that contain user exits must have the extension .lel on all operating systems. The
examples in this topic show libraries with the extension .lil.

Refer to the documentation for the compiler that you are using for full details of
available compile and link options that might be required for your programs.

Navigate to the directory where your user-defined extension source code is located,
and follow the instructions for your operating system:

. [AI¥

+ [HP-UX on PA-RISC]

+ [HP-UX on Itanium|

Compiling on AIX:

When you compile a user-defined extension that is written in C, use a supported
compiler.

The following instructions are for compiling an extension for a default 64-bit
execution group. If the extension will be called from a 32-bit execution group,
make the following substitutions in the compile and link examples:

* Replace xIc_r -qb64 -gwarn64 with xTc_r -q32
* Replace -1 imbdfplg64 with -1 imbdfplg

xTc_r -g64 -qwarn64 \
-1\
-I/install_dir/include/plugin \
-c SwitchNode.c \
-0 SwitchNode.o

xlc_r -g64 -qwarn64 \
-1\
-1/install_dir/include/plugin \
-c BipSampPluginUtil.c \
-0 BipSampPluginUtil.o

xlc_r -q64 -qwarn64 \
-1\
-1/install_dir/include/plugin \
-c Common.c \
-o Common.o

xlc_r -g64 -qwarn64 \
-1.0\
-1/install_dir/include/plugin \
-c NodeFactory.c \
-0 NodeFactory.o

xTc_r -g64 -qwarn64 \
-gmkshrobj \
-bM:SRE \
-bexpall \
-bnoentry \
-0 SwitchNode.1i1 SwitchNode.o \
BipSampPluginUtil.o Common.o NodeFactory.o \
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-L /install dir/1ib \
-1 imbdfplg64

chmod a+r SwitchNode.li1
Compiling on HP-UX on PA-RISC:

When you compile a user-defined extension that is written in C, use a supported
compiler.

The following instructions are for compiling an extension for a default 64-bit
execution group. If the extension will be called from a 32-bit execution group,
make the following substitutions in the compile and link examples:

* Replace +DD64 with +DD32
* Replace -1 imbdfp1g64 with -1 imbdfplg

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT \
-1
-I/install_dir/include \
-1/install _dir/include/plugin \
-c BipSampPluginUtil.c \
-0 output_dir/BipSampPTuginUtil.o \
-Ae

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT \
-1\
-1/install _dir/include \
-I/install_dir/include/plugin \
-c Common.c \
-0 output_dir/Common.o \
-Ae

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT \
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
-c NodeFactory.c \
-0 output_dir/NodeFactory.o \
-Ae

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT \
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
-c SwitchNode.c \
-0 output_dir/SwitchNode.o \
-Ae

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT\
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
-c TransformNode.c \
-0 output_dir/TransformNode.o \
-Ae

1d -b \
-0 output_dir/SwitchNode.1i1 \
output_dir/BipSampPluginUtil.o \
output_dir/Common.o \
output_dir/NodeFactory.o \
output_dir/SwitchNode.o \
output_dir/TransformNode.o \
-L install_dir/1ib \
-L install _dir/xml4c/1ib \
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-L install_dir/merant/1ib \

-L install_dir/jre/1ib/PA_RISC2.0 \

-L install _dir/jre/1ib/PA_RISC2.0/server \
-1 imbdfplg64

chmod a+r output_dir/SwitchNode.111
Compiling on HP-UX on Itanium:

When you compile a user-defined extension that is written in C, use a supported
compiler.

The following instructions are for compiling an extension for a 64-bit execution
group; 32-bit execution groups are not supported.

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT -Ae \
-1\
-I/install_dir/include \
-1/install_dir/include/plugin \
-c BipSampPluginUtil.c \
-0 output_dir/BipSampPluginUtil.o

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT -Ae \
-1\
-I/install_dir/include \
-1/install_dir/include/plugin \
-c Common.c \
-0 output_dir/Common.o

cc +z +e +DD64 -D_HPUX_SOURCE -DTHREADS -D_REENTRANT -Ae \
-1\
-1/install _dir/include \
-1/install_dir/include/plugin \
-c NodeFactory.c \
-0 output_dir/NodeFactory.o

cc +z +e +DD64 -D_HPUX_ SOURCE -DTHREADS -D_REENTRANT -Ae \
-1\
-1/install _dir/include \
-1/install_dir/include/plugin \
-c SwitchNode.c \
-0 output_dir/SwitchNode.o

cc +z +e +DD64 -D_HPUX_ SOURCE -DTHREADS -D_REENTRANT -Ae \
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
-c TransformNode.c \
-0 output_dir/TransformNode.o

1d -b \
-0 output_dir/SwitchNode.1i1 \
output_dir/BipSampPluginUtil.o \
output_dir/Common.o \
output_dir/NodeFactory.o \
output_dir/SwitchNode.o \
output_dir/TransformNode.o \
-L install_dir/1ib \
-L install_dir/xml4c/1ib \
-L install_dir/merant/1ib \
-L install_dir/jre/1ib/IA64N\
-L install _dir/jre/1ib/IA64N/server \
-1 imbdfplg

chmod at+r output_dir/SwitchNode.1i1
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Compiling on Linux:

When you compile a user-defined extension that is written in C, use a supported
compiler.

To determine the 32-bit or 64-bit linkage that is required for an execution group
created in a broker on your specific operating system, see [Support for 32-bit and|
[64-bit platforms|

When you compile programs on Linux on POWER, replace the option -fpic with
-fPIC if you want to use dynamic linking and avoid any limit on the size of the
global offset table.

The following instructions are for compiling an extension for a 64-bit execution
group on Linux on POWER and Linux on System z.

* To compile the extension for a 64-bit execution group on Linux on x86-64,
replace -1imbdfplg with -1imbdfp1g64 in the link example.

* To compile the extension for a 32-bit execution group on Linux on x86, replace
-m64 with -m32 in the compile and link examples.

gcc -c -m64 -ansi -Wall -Wno-format-y2k -fpic \
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
- DLINUX -D_THREADS -D_POSIX PTHREAD SEMANTICS -D_REENTRANT \
TransformNode.c

gcc -c -m64 -ansi -Wall -Wno-format-y2k -fpic \
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
- DLINUX -D_THREADS -D_POSIX PTHREAD_ SEMANTICS -D_REENTRANT \
SwitchNode.c

gcc -c -m64 -ansi -Wall -Wno-format-y2k -fpic \
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
- DLINUX -D_THREADS -D_POSIX_PTHREAD SEMANTICS -D_REENTRANT \
BipSampPluginUtil.c

gcc -c -m64 -ansi -Wall -Wno-format-y2k -fpic \
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
- DLINUX -D_THREADS -D_POSIX_PTHREAD SEMANTICS -D_REENTRANT \
Common.c

gcc -c -m64 -ansi -Wall -Wno-format-y2k -fpic \
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
- DLINUX -D_THREADS -D_POSIX_PTHREAD_ SEMANTICS -D_REENTRANT \
NodeFactory.c

gcc -m64 -o samples.lil \
TransformNode.o \
SwitchNode.o \
BipSampPluginUtil.o \
Common.o NodeFactory.o \
-shared -1c -Tns1 -1d1 \
-L/install_dir/1ib -1imbdfplg
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These commands create the file samples.lil that provides TransformNode and
SwitchNode objects.

Compiling on Solaris:

When you compile a user-defined extension that is written in C, use a supported
compiler.

To determine the 32-bit or 64-bit linkage that is required for an execution group
created in a broker on your Solaris operating system, see [Support for 32-bit and]
[64-bit platforms|

The following instructions are for compiling an extension for a 64-bit execution
group on Solaris on SPARC.

* To compile the extension for a default 64-bit execution group on Solaris on
x86-64, replace -xarch=v9 with -xarch=amd64 in the compile examples.

* To compile the extension for a 32-bit execution group on Solaris on SPARC:
— Replace -xarch=v9 with -xarch=v8plus in the compile examples.
— Replace -1 imddfp1g64 with -1 imddfplg in the link example.

cc -xarch=v9 -mt \

-1\

-I/install _dir/include \
-1/install_dir/include/plugin \
-c SwitchNode.c \

-0 output_dir/SwitchNode.o

cc -xarch=v9 -mt \
-1\
-I/install_dir/include \
-I/install_dir/include/plugin \
-c BipSampPluginUtil.c \
-0 output_dir/BipSampPluginUtil.o

cc -xarch=v9 -mt \
-1.\
-I/install_dir/include \
-I/install_dir/include/plugin \
-c NodeFactory.c \
-0 output_dir/NodeFactory.o

cc -xarch=v9 -mt \
-1.\
-I/install_dir/include \
-I/install_dir/include/plugin \
-c Common.c \
-0 output_dir/Common.o

cc -xarch=v9 -xcode=pic32 -mt -G \

-0 output_dir/SwitchNode.1i1 \
output_dir/SwitchNode.o \
output_dir/BipSampPluginUtil.o \
output_dir/NodeFactory.o \
output_dir/Common.o \

-L /install_dir/1ib \

-1 imbdfplg64

chmod a+r output_dir/SwitchNode.111

Compiling on Windows:
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When you compile a user-defined extension that is written in C, use a supported
compiler.

Ensure that you include a space between SwitchNode.c and BipSampPTuginUtil.c,
and also between -Tink and /DLL.

Enter the command as a single line of input; in the following example the lines
have been split to improve readability.

cl /VERBOSE /LD /MD /Zi /GX /I.
/linstall_dir\include\plugin
SwitchNode.c BipSampPTuginUtil.c Common.c
NodeFactory.c TransformNode.c
-1ink /DLL install_dir\1ib\imbdfplg.T1ib
/OUT :SwitchNode.111

If you have correctly set the LIB environment variable, you do not have to specify
the full paths to the LIB files.

Compiling on z/OS:

When you compile a user-defined extension that is written in C, use a supported
compiler.

Force your link to use prelinker or linker by setting the _CC_STEPS variable to -1:
export _CC_STEPS=-1

Alternatively, add these two lines to your makefile to export it:

_CC_STEPS=-1
.EXPORT : _CC_STEPS

To create optimized builds, use -2 in place of -g in the following commands:

cc -c \

-Wc,DLL -g -WO,Tong,langlv1\(extended\),EXPORTALL,float\(ieee\) \
-We,xpTink \

-WO,LIST\(./SwitchNode.Tst\) \

-1. -I${install_dir}/include \

-1${install_dir}/include/plugin \

-1${install_dir}/sample/include \

-1${install_dir}/sample/plugin \

-0 ./SwitchNode.o ./SwitchNode.c

cc -c \

-Wc,DLL -g -WO,long,Tanglv1\(extended\),EXPORTALL,float\ (ieee\) \
-We,xplink \

-WO,LIST\(./SwitchNode.Tst\) \

-1. -1${install_dir}/include \

-1${install_dir}/include/plugin \

-1${install_dir}/sample/include \

-1${install_dir}/sample/plugin \

-0 ./BipSampPluginUtil.o ./BipSampPluginUtil.c

cc -c \

-Wc,DLL -g -WO,Tlong,Tanglv1\(extended\),EXPORTALL,float\(ieee\) \
-We,xplink \

-WO,LIST\(./SwitchNode.1st\) \

-1. -I1${install_dir}/include \

-1${install_dir}/include/plugin \

-1${install _dir}/sample/include \

-1${install_dir}/sample/plugin \

-0 ./Common.o ./Common.c
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cc -c \

-Wc,DLL -g -WO,Tong,langlv1\(extended\),EXPORTALL, float\(ieee\) \

-We,xplink \

-WO,LIST\(./SwitchNode.Tst\) \
-I. -I${install_dir}/include \

-1${install_dir}/include/plugin \
-1${install_dir}/sample/include \
-1${install _dir}/sample/plugin \

-0 ./NodeFactory.o ./NodeFactory.c

cc \

-W1,DLL -g -W1,p,map -W1,LIST=ALL,MAP,XREF,REUS=RENT \

-WT,xpTink \

-0 ./SwitchNode.1i1 ./SwitchNode.o ./BipSampPluginUtil.o \

./Common.o ./NodeFactory.o \

${install_dir}/1ib/1ibimbdfplg.x

Issue the following command to set the file permissions of the user-defined
extension to group read and to be executable:

chmod a+rx {output_dir}/SwitchNode.111

Creating a user-defined exit

You can develop and deploy a user-defined exit.

Before you start:

* Read [“User exits” on page 29

Follow the steps in the topics below to develop and deploy a user-defined exit.

1. [“Developing a user exit’|

2. ['Deploying a user exit” on page 99|

Developing a user exit

Develop a user exit by declaring it, implementing its behavior, then compiling it.

To develop a user exit, follow these steps.

1. Declare the user exit.

Declare a user exit by using the bipInitializeUserExits function to specify the

following properties:

a. Name (used to register and control the active state of the exit)

b. User context storage

c. A function to be invoked (for one or more Event Types)

2. Implement the user exit behavior.

When the user exit is declared, a set of functions is registered, and these
functions are invoked when specific events occur. The behavior of the user exit
is provided by implementing these functions. The following table lists the
events and their associated functions:

Event

Function

A message is dequeued from the input source

ccilnputMessageCallback

A message is propagated to the node for processing

cciPropagatedMessageCallback

A request message is sent to the output node’s transport,
and transport-specific destination information is written
to "WrittenDestination” in the LocalEnvironment

cciOutputMessageCallback

The node completes processing

cciNodeCompletionCallback
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Event

Function

The transaction ends

cciTransactionEventCallback

3. Your user exit code must implement the cleanup function.

The user exit library must implement the bipTerminateUserExits function. This
function is invoked as the ExecutionGroup’s process is ending, and your user
exit must clear up any resources allocated during the bipInitializeUserExits
function.

4. Compile.

Use your existing process for your environment to compile your user exit. The
supported C compilers are shown in |Optional software support| See
[‘Compiling a C user-defined extension” on page 51| for more details.

5. Link the compiled code to a library with the extension .lel that exports the
bipInitializeUserExits and bipTerminateUserExits functions.

Deploying a user exit
Deploy your user exit to the broker.

Before you start:

* Write and compile the user exit code. See [‘Developing a user exit” on page 98

* Ensure that the exit:
1. Is in a library that has the extension .lel
2. Exports the functions biplnitializeUserExits and bipTerminateUserExits

You can set the state of the user exit dynamically to active, or inactive, on a
per-message flow basis without restarting the broker.

To deploy the user exit:
1. Install the user exit code on a broker.

The library containing the user exit code must be installed on a file system that
can be accessed by the broker. For example, the file must have read and
execute authority for the user ID under which the broker runs. The broker
looks in the following places for libraries containing user exits:

* The broker property UserExitPath defines a list of directories separated by
colons (semi-colons on Windows). Use the —x flag on the mgsicreatebroker or
mgsichangebroker command to set this property for 32-bit execution groups
for each broker.

Alternatively, you can append the directory containing the directory that
holds the extension files to the environment variable
MQSI_USER_EXIT_PATH associated with the environment in which the
broker is running.
If both are set, the environment variable takes precedence. All the directories
in the environment variable are searched in the order in which they appear
in the variable, then all the directories in the broker property are searched in
the order in which they appear in the property.

 For 64-bit extensions, you cannot use the —x parameter to modify the exit
path. Append the directory containing the directory that holds the extension
files to the environment variable MQSI_USER_EXIT_PATH64.

2. Load the user exit library into the broker’s processes.

When the user exit library has been installed on the broker, you must load it in
one of the following ways:
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¢ Stop and restart the broker.
* Run the mgsireload command to restart the execution group processes.
3. Activate the user exit.

User exits can be active or inactive, and are inactive by default. You can change
the state of a user exit dynamically by using the mgsichangeflowuserexits
command on a per-flow basis, without having to restart the broker. You can
also change the default state for a set of user exits to active on a per-broker
basis by using the mgsichangebroker command; in this case, you do not have
to restart the broker.

To set the default user exit state for a broker:
a. Stop the broker.

b. Set the activeUserExits property of the broker by using the
mgsichangebroker command.

c. Start the broker and check the system log to ensure that all execution
groups start without error. If any invalid user exit names are specified (that
is, the user exit is not provided by any library loaded by the execution
group), a BIP2314 message is written to the system log and all flows in the
execution groups fail to start unless you take one of the following actions:

* Provide a library in the user exit path that implements the exit; then run
the mgsireload command, or restart the broker, to load an exit from the
library.

* Run the mgsichangeflowuserexits command to remove the exit from both
the active and inactive lists.

You can also override the default user exit state for a broker. You can use the
mgsichangeflowuserexits command to activate, or deactivate, user exits on a
per-execution group or per-message flow basis, with the order of precedence
being message flow then execution group. When multiple exits are active for a
given flow, the broker starts them in the order that is defined by the
mgsichangeflowuserexits command.

Packaging and distributing user-defined extensions

When you have created and tested a user-defined extension, you can package and
distribute it.

Before you start:

Complete the following tasks:

* [“Implementing user-defined extensions” on page 31|

+ [‘Testing a user-defined node” on page 83|

When you have created and tested your user-defined extension, you can distribute
these resources to other computers in your broker domain:

* Copy the files generated by the compilation step to all the computers on which
you have created brokers that might need these resources. This task is described
in [“Installing user-defined extension runtime files on a broker” on page 104 For
a more automated approach, see the information in [“Installing a user-defined|
fextension to current and past versions of the broker” on page 107 ]

* Package the resources that make up the workbench representation of your
user-defined node to create an Eclipse plug-in. This task is described in
“Creating the user interface representation of a user-defined node in the]
workbench” on page 75 Then install the plug-in on all the computers on which
your workbench users might need to use them, following the instructions in
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“Installing a user-defined extension to current and past versions of the broker”]
on page 107 This step is not required for user-defined parsers.

Packaging a Java user-defined node
How to package a Java user-defined node.

Before you start

You must have a user-defined node written in Java. This node can be one of the
provided sample nodes that are described in [‘Sample node files” on page 119 or a
node that you have created yourself using the instructions in either [“Creating a
message processing or output node in Java” on page 64| or [“Creating an input node
in Java” on page 59

You can package a user-defined node in two ways:
* PAR

A Plug-in Archive (PAR) is the deployment unit for Java user-defined nodes. The
PAR contains the user-defined node classes and, if required as dependencies, can
contain JAR files. A PAR file is a compressed file with a .par file extension. The
directory structure in the .par file has the following format:

— /classes
The user-defined node classes are stored in this location.
- /lib
JAR files that are required by the user-defined node are stored in this

location. This directory is optional because it might not be necessary to
include JAR files.

The following procedure describes how to package an example user-defined
node, parexamplenode. In this example, the PAR is to be contained in
par.example.parexamplenode.class with a JAR file dependency dependency.jar.

1. Create the directory structure; for example:
— /classes/par/example/parexamplenode.class
— /1ib/dep.jar

2. Issue a file compression command to create the PAR; for example:
jar cvf parexample.par classes 1ib

The PAR should be placed in the LIL path that is specified in |”Installin§|
[user-defined extension runtime files on a broker” on page 104

. JAR
User-defined nodes can be packaged using a simple JAR. For example, if your
node is defined in example/jarexamplenode.class, create the JAR by using the
jar cvf jarexample.jar example command.

The preferred way to package a Java user-defined node is to use a PAR file,
because all dependencies can be packaged with the node, and each node is
loaded in a separate classloader. Refer to [“User-defined node classloading” on|

for information on classloading.
The JAR should be placed in the LIL path that is specified in |“Installina
[user-defined extension runtime files on a broker” on page 104

Deployment dependencies:

If a user-defined node requires an external package, the package can be deployed
in one of following ways:

* The external packages can be added to the /1ib directory in the deployed PAR.
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* For external packages that are shared between several node types, the packages
can be added to one of the following locations:

— The<workpath>/shared-classes/ directory

— The CLASSPATH environment variable, where all user-defined nodes that are in
the broker installation can access the packages

User-defined node classloading:

When a Java user-defined node is packaged as a PAR file, the Java user-defined
node is loaded in a separate classloader.

The classloader loads any class that is packaged within the deployed PAR. The
classes that are placed in the JAR override any classes that are in the shared classes
directory or the CLASSPATH environment variable. If the deployed PAR contains
more than one node type, the nodes share the same classloader. Therefore, a set of
user-defined nodes that share static data should be packaged in a single PAR file.

Java user-defined nodes that are packaged as simple JAR files are loaded in the
same classloader. The classes and the location from which they are loaded are
written to user trace, therefore you can use this information to check that the
correct classes are being loaded.

The broker uses the following classloader tree:

Bootstrap
l JVM classloaders
System
Common
Broker Shared
Grouped EGShared
NodeType1 . NodeTypeN

Java user-defined nodes

e Common classloader: This component loads the classes that are shared between
the broker and user code. For example, the classes that are contained in
jplugin2.jar are common to the broker and the user code.

* Broker classloader: This component loads the broker internal classes. These
classes cannot be accessed by user classes.
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Shared classloader : This component loads classes from JAR files that have
been placed in the WorkPath/shared-classes/ directory and the CLASSPATH
environment variable. These classes are available to all Java user-defined nodes
and JavaCompute nodes within the broker.

The shared classloader also loads context classes. It uses the CLASSPATH and
the WorkPath/shared-classes/ to search for classes.

The CLASSPATH environment variable can contain the wildcard character (*) at
the end of a directory path specifier. The wildcard is expanded to include all
files in that directory with the extension .jar] or .JAR.

The broker classloader and the shared classloader are children of the common
classloader. Therefore, the contents of the shared classloader are not visible to
the broker classloader. Do not store the following resources in this directory:

— User-defined nodes

— Classes that have a dependency on other classes that have been deployed
with a user-defined node.

Grouped classloader: This component loads all user-defined nodes that are
packaged as JAR files. If you have packaged user-defined nodes in an earlier
version, they are loaded using this loader. User-defined nodes that are packaged
in JAR files are loaded into one loader, and can therefore share static data.

EGShared classloader: This component loads classes from JAR files that have
been deployed to the broker runtime in a BAR file. This is used to support the
deployment mechanism for the JavaCompute node. Each time a BAR file is
deployed, a new instance of the EGShared classloader is created and the old
instance is discarded. Therefore, the JavaCompute node can reload modified
versions of the same class without the need to restart the broker.

User-defined nodes classloading search paths:

User-defined nodes package in a PAR

The broker uses the following search path to find user-defined node classes:

1.

/classes to locate classes in the deployed PAR.

2. /1ib to locate any JAR files in the deployed PAR.
3.
4. CLASSPATH environment variable.

WorkPath/shared-classes/ to locate any JAR files.

User-defined nodes package in a JAR

The broker uses the following search path to find user-defined node classes:

1.
2.
3.

The deployed JAR file.
WorkPath/shared-classes/ to locate any JAR files
CLASSPATH environment variable.

Endorsed standards for overriding classes

The endorsed standards overriding mechanism allows the following standard
packages to be overridden in the JRE:

javax.rmi.CORBA
org.omg.CORBA
org.omg.CORBA.DynAnyPackage
org.omg.CORBA.ORBPackage
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* org.omg.CORBA.portable

* org.omg.CORBA.TypeCodePackage

e org.omg.CORBA_2_3

* org.omg.CORBA_2_3.portable

* org.omg.CosNaming

* org.omg.CosNaming.NamingContextExtPackage
* org.omg.CosNaming.NamingContextPackage
* org.omg.Dynamic

* org.omg.DynamicAny

* org.omg.DynamicAny.DynAnyFactoryPackage
* org.omg.DynamicAny.DynAnyPackage

e org.omg.JOP

* org.omg.JOP.CodecFactoryPackage

* org.omg.JOP.CodecPackage

* org.omg.Messaging

* org.omg.PortableInterceptor

* org.omg.PortableInterceptor.ORBInitInfoPackage
* org.omg.PortableServer

* org.omg.PortableServer.CurrentPackage

* org.omg.PortableServer. POAManagerPackage
* org.omg.PortableServer.POAPackage

* org.omg.PortableServer.portable

* org.omg.PortableServer.ServantLocatorPackage
* org.omg.SendingContext

e org.omg.stub.java.rmi

* org.w3c.dom

* org.xml.sax

 org.xml.sax.ext

* org.xml.sax.helpers

Refer to the [Endorsed Standards Override Mechanism| for more information.

To override these packages in the broker, place the JAR files for the API standards
in the /1ib directory of the PAR.

JNDI context: When looking up a JNDI context, the context classloader is used. If
the lookup uses classes that are packaged with the user-defined node, the context
classloader must be the same as the classloader that is being used to load the
user-defined node. To ensure that each thread uses the same classloader, the
following code can be included in the user-defined node class:

Thread.currentThread.setContextClassLoader(this.getClass().getClassLoader());

Installing user-defined extension runtime files on a broker
Install the compiled runtime files for your user-defined extension on the broker on
which you want to test its function.

Before you start
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* Create and compile your user-defined extension using the procedure described
in [‘Compiling a Java user-defined node” on page 73| or [‘Compiling a C]
[user-defined extension” on page 51

— The files that have been created for extension created in C depend on the
underlying broker operating system:

WM A dynamic link library (DLL), named with a file type of ".lil".
A shared object, again with a file type of "lil".
A shared object, again with a file type of "lil".

A shared object, with a file type of "lil".

— For Java nodes, a Java Archive file (JAR), with a file type of "jar’ (on all
operating systems).
* If you have created a user-defined node, you must also complete the task
“Creating the user interface representation of a user-defined node in the|
workbench” on page 75

This task instructs you to stop and restart brokers. This action is required in all but
the two circumstances described in step 4 below, although if you do stop and
restart the broker, you can ensure that anyone with an interest in a particular
execution group is made aware that recent changes have been made.

To install runtime files on the broker:

1. Stop the broker on which you want to install your compiled or packaged
user-defined extension file (files with extension .lil, jar, .par, .pdb, or .lel)

2. Create a directory if you haven’t already got one for this purpose. Add the
directory to the LILPATH by using the mgsichangebroker command.

CAUTION:

Do not put the .1lil, .jar, .par, .pdb, or .lel files in the WebSphere Message
Broker installation directory, because they could be overwritten by the
broker.

3. Put your user-defined file in the directory, and make sure that the broker has
access to it. For example, on Linux or UNIX, use the chmod 755* command on
the file.

4. Stop and restart the broker to implement the change and to ensure that the
existence of the new file is detected. A broker restart is not necessary in the
following circumstances:

* If you have created an execution group in the workbench, and nothing is yet
deployed to it, you can add the .1il, .pdb, jar, .par, or .lel file to your chosen
directory.

¢ If something has already been deployed to the execution group that you
want to use, add the .1il, .pdb, jar, .par, or .lel file to your chosen directory,
and issue the mgqsireload command to restart the group. You cannot
overwrite an existing file on the Windows system when the broker is
running, because of the file lock that is put in place by the operating system.

Use these two approaches with care, because any execution group that is
connected to the same broker also detects the new .lil, .pdb, jar, .par, or .lel
files when that execution group restarts, or when something is first deployed to
that execution group.

5. Repeat the above steps for every broker that needs the user-defined extension
file. If all of your brokers are on the same machine type, you can build the
user-defined extension file once and distribute it to each of your systems.
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If you have a cluster, for example, that includes one AIX, one Solaris, and one
Windows broker, you must build the files separately on each machine type.

NI On Windows, the .pdb file provides symbolic information that is
used when displaying stack diagnostic information in the event of access
violations or other software malfunctions.

6. For C user-defined extensions, store the .pdb file in the same directory as the
il file to which it corresponds.

7. Use either the mgsichangebroker command or the mgsicreatebroker command,
as appropriate, to specify to the broker the directory that contains the
user-defined extension file.

When you have installed a user-defined extension, it is referred to by its
schema and name, just like a message flow.

The broker loads the user-defined extension files during initialization. After
loading the files, the broker invokes the registration functions in the user-defined
extension and records what nodes or parsers the user-defined extension supports.

A C user-defined extension implements a node or parser factory that can support
multiple nodes or parser types. For more information refer to [node and parser|
[factory behavior] Java users do not need to write a node factory.

Packaging a user-defined node workbench project
Package a user-defined node workbench project to distribute to other computers
for use throughout your broker domain.

Before you start
1. Create and compile your user-defined node in or in @
2. [Create the representation of your user-defined node in the workbenchl

3. [Test your user-defined node}

Although you have used and tested your user-defined node on your local
computer, you must make its associated files available on other computers when
your user-defined node is ready for use throughout your broker domain. A
user-defined node consists of two sets of files:

» Files that support the node execution in the broker. You created these files in
“Creating a user-defined extension in C” on page 35| or |“Creating a user-defined|
extension in Java” on page 58

» Files that represent the node in the workbench. You created these files in
“Creating the user interface representation of a user-defined node in the
workbench” on page 75/

The workbench representation consists of a set of resources that have been created

as an Eclipse plug-in. To package the plug-in so that it can be distributed to other

computers, generate a JAR file that contains your node’s plug-in project as follows:

1. Switch to the Plug-in Development perspective.

2. Right-click the node project that you want to package for distribution and click
File » Export.

3. From the list displayed, select Plug-in Development > Deployable plug-ins
and fragments.

4. Click Next. Select the check box next to your node project and specify a
location for your JAR file. The file will be placed under the plugin directory
relative to your specified location.
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5. Click Finish.

The JAR file that contains your node plug-in project is generated at the location
you specified. To produce a self-contained package for the node distribution, create
a .zip file and add the generated JAR, and any C source code or compiled files, to
the .zip file using any file compression utility.

To distribute the workbench files, continue with [“Installing a user-defined|
[extension to current and past versions of the broker.”| To distribute the runtime

components, see [“Installing user-defined extension runtime files on a broker” on|
page 104.

For installation on another system, see [“Installing a user-defined extension to
[current and past versions of the broker.”]

To distribute your node commercially, see the [PDE Guide| for information about
issues such as versioning and updating your user-defined node.

Installing a user-defined extension to current and past versions
of the broker

Install user-defined extensions that you have developed yourself, or have acquired
from other software vendors, with the minimum of user intervention.

Before you start

Complete the following tasks:

1. [“Compiling a Java user-defined node” on page 73| or ["Compiling a C|
user-defined extension” on page 51

2. |“Creating the user interface representation of a user-defined node in the|
workbench” on page 75|

3. [‘Testing a user-defined node” on page 83|

4. ["Packaging a user-defined node workbench project” on page 106|

You must install user-defined extensions on all appropriate broker computers, and,
if the extension is a user-defined node, on the workbench computers (user-defined
parsers have no workbench component). Components can be installed separately,
or as part of one process. The components can be on different systems, therefore
check that the installations are completed on all affected systems.

If an extension writes messages to user trace, you must update the environment
variable MQSI_CONSOLE_NLSPATH (Windows systems), or NLSPATH (all other
systems), so that the mgsiformatlog command can find the message catalog.

The Message Broker Toolkit installation:

Before installing a user-defined node, check the version of the Message Broker
Toolkit to which you are installing, because a specific version of the toolkit could
be a prerequisite of the user-defined extension, or it might require specific files to
run.

To determine the version, see [“Detecting installed versions of WebSphere Message]
[Broker” on page 110

1. Copy your files to a directory that the Message Broker Toolkit can access, so
that you can view your user-defined node in the workbench session. Choose
one of the following options:
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* Add a new Eclipse extension location. This option uses standard workbench
tasks, and helps you to maintain your files safely and separately from those
provided with the default installation.

a. Create a directory called eclipse in a suitable location in your file system;
the directory structure that contains the eclipse directory is not
significant.

b. Within the eclipse directory, create an empty file named .eclipseextension,
and directories named features and plugins.

c. In the Message Broker Toolkit, click Help » Software Updates >~ Manage
Configuration; the Product Configuration dialog opens.

d. Click Add an Extension Location. Browse to your new folder and select
it. You are prompted to restart the Message Broker Toolkit.

e. Add your new plug-in JAR file to the plugins directory in the eclipse
directory that you have just created.

* Add your new plug-in JAR file directly into the plugins directory where the
Message Broker Toolkit is installed. For example, on Windows 32-bit
editions, add the file to C:\Program Files\IBM\WMBT610\plugins.

If you choose this option, you might find it more difficult to manage your

plug-ins files safely if you later remove or replace them. Also, your system
administrator might want to control security and access on computers that
are used by more than one user, and might not set permissions for users to
write to the primary installation directories.

* Create Eclipse link files to the directories in which you maintain your plug-in
files.

For details of how to create link files, see the developerWorks® article about
[using Eclipse features| (the section entitled “Using link files to manage an
Eclipse install”). The process is similar to the first option (using Manage
Configuration), and creates similar resources, but you have to write and
maintain the link files in the correct format.

2. Restart your workbench session for the changes to take effect.
Runtime installation:
You might need to detect the version of the runtime components that are installed,

to ensure that the correct LIL file is loaded by the correct level of the broker. See
[‘Detecting installed versions of WebSphere Message Broker” on page 110

To add jar or il files to runtime installations on WebSphere Business Integration
Message Broker Version 5.0 or later, and WebSphere Message Broker Version 6.0
and later, see [“Installing user-defined extension runtime files on a broker” on page

Installing a user-defined extension for single broker:

To make a 32-bit extension accessible from only one broker on the system, modify
the UserLilPath setting for the broker by specifying the -1 parameter on the
mgsicreatebroker or mqgsichangebroker command.

To make a 64-bit extension accessible from only one broker on the system, modify
the UserLilPath setting for the broker by specifying the -r parameter on the
mgsicreatebroker or mgsichangebroker command.

See the jmgsicreatebroker| and [mgsichangebroker] commands for further
information.
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Installing a user-defined extension for multiple brokers:

To affect all brokers on a system, you must modify the system LILPATH. Append
the directory containing the directory that holds the extension files to the
environment variable MQSI_LILPATH (for 32-bit extensions) or MQSI_LILPATH64
(for 64-bit extensions).

You can make this change by creating a custom environment script in the working
directory:

. BIT@N On Linux and UNIX systems, /var/mgsi/common/profiles

« WINTEE On Windows, %ALLUSERSPROFILE%\ Application
Data\IBM\MQSI\common\profiles where %ALLUSERSPROFILE% is the
environment variable that defines the system working directory. The default
directory depends on the operating system:

— On Windows XP and Windows Server 2003: C:\Documents and Settings\ All
Users\ Application Data\IBM\MQSI\common\profiles

— On Windows Vista and Windows Server 2008: C:\ProgramData\IBM\MQSI\
common\profiles

The actual value might be different on your computer.

You can give the environment script any name, but the file extension must be .cmd
on Windows and .sh on all other platforms. The script can perform all the
operations of a shell script, but you should limit the scope to only appending the
following variables:

MQSI_LILPATH
Defines the directories to search for 32-bit plug-ins

MQSI_LILPATH64
Defines the directories to search for 64-bit plug-ins

CLASSPATH
Defines the locations that Java should search for additional classes

MQSI_CONSOLE_NLSPATH
On Windows systems, defines the location of message catalogs (DLL files)

NLSPATH
On Linux and UNIX systems, defines the location of message catalogues (CAT
files)

PATH
Defines the location of executable files. On Windows, this variable also defines
the location of dependent libraries.

LIBPATH / SHLIB_PATH / LD_LIBRARY_PATH
Defines the location of dependent libraries on UNIX and Linux systems.

Example scripts:

BITTEN This example shows the environment profile for MyExtension on
Windows, which is installed in C:\Program Files\MyExtensions on Windows
32-bit editions, or in C:\Program Files(x86)\MyExtensions on Windows 64-bit
editions.

The script is called MyExtension.cmd and is stored in the working directory. The
default location is % ALLUSERSPROFILE%\ Application Data\IBM\MQSI\
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common\profiles where the default setting for the environment
variable%ALLUSERSPROFILE% depends on the operating system:

* On Windows XP and Windows Server 2003: C:\Documents and Settings\ All
Users\.

* On Windows Vista and Windows Server 2008: C:\ProgramData\.
The actual value might be different on your computer.

The Windows script contains the following content:

REM Added by MyExtension install, do not modify
set MQSI_LILPATH=%MQSI LILPATH%;"C:\Program Files\MyExtension\bin"

This example shows the environment profile for MyExtension on Linux,
which is installed in /opt/MyExtension. The script is called MyExtension.sh and is
stored in the working directory /var/mqsi/common/profiles/.

The Linux script contains the following content:

#1/bin/ksh
# Added by MyExtension install, do not modify
export MQSI_LILPATH=/opt/MyExtension/1i1${MQSI LILPATH:+":"${MQSI_LILPATH}}

You can test the following variables in the profile script, for example if you want
to ensure that a user-defined extension runs only on a specific version of the
broker:

MOQSI_FILEPATH
The full path to the installed file for WebSphere Message Broker

MQSI_WORKPATH
The full path to the configuration data for WebSphere Message Broker

MQSI_VERSION
WebSphere Message Broker version, in the form
version.release.modification.fix

MOQSI_VERSION_V
The value of WebSphere Message Broker major version

MQSI_VERSION_R
The value of WebSphere Message Broker release

MQSI_VERSION_M
The value of WebSphere Message Broker modification number

MQSI_VERSION_F
The value of WebSphere Message Broker fix level
Detecting installed versions of WebSphere Message Broker:

A user-defined extension can detect which version of WebSphere Message Broker is
installed.

Use the conditions described here to test for particular version or versions. If
expected conditions are not met, a component might not have installed correctly, or
might have become corrupted. Check the status of the installed component and the
local logs to identify and resolve any errors.

Detecting installed versions on Windows:
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Use the following instructions in your installer scripts on Windows to test for the
following versions. To detect each version, look for the registry key given for each
version. In the examples shown, x can be any integer.

WebSphere Business Integration Message Broker Version 5.0 toolkit
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\
mgsi.studio\DisplayVersion = 5.x.x.x

WebSphere Business Integration Message Broker Version 5.0 runtime
components

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\
mgsi.ib\DisplayVersion = 5.x.X.X

WebSphere Message Broker Version 6.0 toolkit
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\
WMBT60\DisplayVersion = 6.x.X.X

WebSphere Message Broker Version 6.0 runtime components
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\
mgsi60\DisplayVersion = 6.x.X.X

WebSphere Message Broker Version 6.1 toolkit

Check for the presence of the files \IBM\Installation Manager\
installed.xml and \IBM\Installation Manager\installRegistry.xml in the
working directory.

The default working directory is %ALLUSERSPROFILE%\ Application

Data\IBM\MQSI where %ALLUSERSPROFILE% is the environment variable

that defines the system working directory. The default directory depends

on the operating system:

¢ On Windows XP and Windows Server 2003: C:\Documents and
Settings\ All Users\ Application Data\IBM\MQSI

* On Windows Vista and Windows Server 2008: C:\ProgramData\IBM\
MQSI

The actual value might be different on your computer.

WebSphere Message Broker Version 6.1 runtime components
HKEY LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\
mgsi6l\DisplayVersion = 6.X.X.X

Detecting installed versions on Linux and UNIX systems:

Linux and UNIX systems do not have a common packaging method: you must
check which files are present in the file system. Look for the files listed below for
each version of WebSphere Message Broker that you want to detect.

WebSphere Business Integration Message Broker Version 5.0 runtime
components

BTN Check for the presence of /usr/opt/mgqsi/bin/mgsilist. Also
check that /usr/opt/mqsi/bin/mgsiprofile is not present.

On Linux and other UNIX systems, check for the presence of
/opt/mgqsi/bin/mgsilist, and make sure that opt/mqsi/bin/mgsiprofile is
not present.

WebSphere Message Broker Version 6.0 toolkit

To detect Version 6 and later toolkits, look for the existence of
/etc/IBM/WebSphereMessageBrokersToolkit/products/com.ibm.wbmt.
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To determine the version, use the following code example. Shell-script
notation is used in this code: '-e' means if file exists.
if [ -e /etc/IBM/WebSphereMessageBrokersToolkit/products/com.ibm.webt ]
# Event Broker installed
if [ -e “grep location /etc/IBM/WebSphereMessageBrokersToolkit/products/
com.ibm.webt | sed 's/location=//'"/webt prod/version.txt™ ]
# it is FP1 or greater
get version from version.txt
else
#version is 6.0
fi
fi
if [ -e /etc/IBM/WebSphereMessageBrokersToolkit/products/com.ibm.wmbt ]
# Message Broker installed
if [ -e “grep location /etc/IBM/WebSphereMessageBrokersToolkit/products/
com.ibm.wmbt | sed 's/location=//'"/wmbt_prod/version.txt™ ]
#It is FP1 or greater
get version from version.txt
else
#version is 6.0
fi
i

WebSphere Message Broker Version 6.1 toolkit

Check for the presence of the files /var/ibm/InstallationManager/
installed.xml and /var/ibm/InstallationManager/installRegistry.xml.

WebSphere Message Broker Version 6.0 and Version 6.1 runtime components

To detect Version 6.0 and later runtime components, look for the file
/var/mgqsi/install.properties. Each line in this file contains an installation
path and V.R.M.F version information.

Updating a user-defined extension
On all systems, you can change a user-defined extension file by completing the
following steps.

1. Stop the broker using the mgsistop command.
2. Update or overwrite the .lil or jar file.
3. Start the broker using the mqsistart command.

In two situations it is not necessary to stop and start the broker:

* If have created an execution group in the workbench, but have not yet deployed
to it, you can add the .lil, .pdb, and jar files to your chosen directory.

¢ If something has already been deployed to the execution group that you want to
use, add the .lil, .pdb, and jar files to your chosen directory and use the
mgsireload command to restart the group. You cannot overwrite an existing file
on the Windows system when the broker is running because of the file lock that
is put in place by the operating system.

These two approaches should be used with caution, because any execution group
that is connected to the same broker also detects the new .lil, .pdb, and jar files
when that execution group is restarted, or when something is first deployed to it.
If you restart the broker, you ensure that anyone with an interest in a particular
execution group is made aware that recent changes have been made to the broker.

These two situations assume that you have used either the mqgsichangebroker

command or the mgsicreatebroker command to notify the broker of the directory
in which the user-defined extension files have been placed.
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Deleting a user-defined extension from the broker
Remove a user-defined extension file from the broker.

1. Stop the broker by using the mgsistop command.
2. Delete the il or jar file from the appropriate directory.
For C user-defined extensions:

Platform Location
install_dir\bin

Windows

Linux install_dir/lil

UNIX install_dir/1il

z/0S install_dir/lil

For Java user-defined nodes:

Platform Location
install_dir\jplugin
Windows
Linux install_dir /jplugin
install_dir /jplugin
UNIX
install_dir/1il
z/0S

3. Restart the broker by using the mqsistart command.

Using event logging from a user-defined extension
Program user-defined extensions to write entries in the local error log.

In most circumstances, user-defined extensions should use exceptions to report
errors. However, you can choose to provide information about significant events,
error or otherwise, for problem determination and operational purposes. The
details that you supply are included in pre-defined message text that is extracted
from a message source or catalog.

* In C code, use the utility function CciLog or CciLogW to report events. Two of
the arguments that you pass to this function, messageSource and messageNumber,
define the event source (catalog) and the integer representation of a message
within that source, respectively.

You can also write trace information, using CciUserTrace, CciUserTraceW,
CciUserDebugTrace, and CciUserDebugTraceW when tracing and debugging is
active.

* In Java code, use the class MbService, which provides static methods to log
information to the event log. To log messages to the event log, package your
messages into a standard Java resource bundle. You can use one of the three
logging methods, passing in the resource bundle name and the message key. The
message is fully resolved, and is then inserted as a single insert into the
appropriate broker message as shown:

— logInformation( ... ) - BIP4360 Java user-defined node information: user
message

— logWarning( ... ) - BIP4361 Java user-defined node warning: user message
— logError( ... ) - BIP4362 Java user-defined node error: user message
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You can choose to write messages that are defined in the product message catalog
(BIPv610) to which you can add your own text as an argument. If you prefer, you
can create your own message catalog, so that you can create more complex
messages, or share a message catalog with other applications. If you want to create
your own message catalog, see [‘Creating message catalogs.”|

« WM On Windows systems, messages are written to the Windows event log.

. [ UNIX_ | On Linux, UNIX, and z/OS systems, messages
are written to the SYSLOG facility.

The description here covers exceptions that are raised during normal message flow
processing. You must also provide for exceptions that are raised when you deploy
and configure a message flow. Messages that result from these configuration
exceptions are reported back to